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About This Guide

This user guide provides reference information for Vector NTI® Express Software, a
Java-based cross-platform application that can run on computers using the following
operating systems:

e Microsoft® Windows® XP (SP3) and Windows® 7

* MacOS®X

¢ Linux

For installation and licensing information, see the Vector NTI® Express Release Notes
and Installation/Licensing Guide.

This guide uses conventions and terminology that assume a working knowledge of the

your operating system, the Internet, and Internet browsers.

Note on screen This guide includes screen captures for the Microsoft® Windows® version of the
captures software. For Macintosh® and Linux users, the screens will look slightly different but
the commands and functions will be the same.
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Overview

Database Explorer

The Vector NTI® Express local database is a database file and associated folder that by
default are installed in the root directory of your local hard drive (e.g.,

C:\ VntiExpress_Database). Database Explorer is the tool in Vector NTI® Express for
managing all the molecules, oligos, projects, analysis results, and other data in the
local database.

Eight different types of objects are stored and organized in databases and subsets in
the Vector NTI® Express local database:

DNA/RNA molecules—these contain a nucleic acid sequence as well as
annotations, primers, restriction sites, analysis results, and other molecule data.
Upon import from other sources, nucleic acid data are parsed and stored in an
internal format. You can add molecules to the database by importing or creating
basic or constructed molecules.

Protein molecules—these contain an amino acid sequence as well as annotations
and other features. Like DNA molecules, upon import from other sources, protein
molecule data are parsed and stored in an internal format. You can add molecules
to the database by importing or creating basic molecules.

Projects —including Alignment, Contig Assembly, and Cloning projects.

Restriction enzymes (RENs)—imported from the REBASE database. Data for
restriction enzymes are parsed and stored in an internal format. You can add
other RENs from the REBASE file included in the Vector NTI® Express Software.

Oligonucleotides —these can be created by the user or generated by primer design
tools in Vector NTI® Express. Several example oligos are included in the software
for demonstration purposes.

Gel markers—these can be created by the user. Commonly used gel markers are
included with the Vector NTI® Express installation.

BLAST results— these are generated by BLAST searches run Vector NTI® Express,
and can be stored as results files in the database.

Analysis results—such as PCR analysis or PFAM analysis of molecules, can be
stored as results files in the database.

About this chapter

This chapter covers:

“Archives” on page 14
“Open the Database Explorer” on page 14
“Open files” on page 16

“Database Explorer operations” on page 17
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Database Explorer
Archives

Archives

“Create DNA/RNA and protein molecules” on page 17
“Create gel markers, oligos, and enzymes” on page 19
“Import data” on page 21

“Manage data” on page 23

“Edit data” on page 28

“Open other applications” on page 30

“Open other applications” on page 30

“Copy, save, and print molecules” on page 30
“Manage the Projects database” on page 33

“Manage the Results database” on page 34
“Workgroup Shared Database” on page 34

“Set preferences” on page 37

Parent-descendant relationships (to keep track of your constructs), user fields,
comments, and keywords are kept for all molecules in the database.

All database molecules and other objects can be placed into “archives” — data files of
special format — that can be transferred to another computer (Macintosh or Windows)
and read by Vector NTI® Express Software. Through archives, you can share molecules,
constructs, or other objects with your colleagues, or simultaneously use them on
several computers (for instance, at work and at home).

In Vector NTI® Express Software archives:

All DNA/RNA molecule information is written to, and read from, an archive file.
This information includes molecule component fragments (if the molecule is
constructed from other molecules) and parent-descendant connections between
molecules.

Vector NTI® Express Software automatically checks the consistency of molecule
archive information, adding necessary parents (including DNA parents of
translated protein molecules) or disconnecting them if you neglected to transfer
them to the archives.

When the archive is loaded into a new database, Vector NTI® Express Software
checks the information consistency on any of database molecules and recalculates
them if necessary.

Open the Database Explorer

14

The Database Explorer can be opened two ways:

In Windows, click Start » Programs (or All Programs) » Life Technologies »
Vector NTI Express » Vector NTI Express. By default, Vector NTI® Express
opens with the Database Explorer screen.
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Open the Database Explorer

¢ In the main toolbar, click the Database Explorer button:

O

Components of the  The Database Explorer screen consists of the following components:
Database Explorer  Three databases: Database, Projects, and Results.

¢ An Explorer Viewer for navigating among three types of databases. The viewer
contents change when you click the Explorer buttons below the viewer.

e Explorer bars for opening and navigating the Database, Projects, and Results
databases.

* A Records Viewer pane for viewing the data and records associated with the
Database, Projects, and Results.

* A Summary Viewer for viewing a snapshot of a selected record.

Note: You can widen, narrow, lengthen, and shorten the size of viewers by clicking
and dragging the viewer frames.

Main Menu

—~—
Toolbar _
Subset ———F——
Records
I Viewer
Explorer |
Viewer
— | Summary
Explorer Bars { Viewer

Drag frames to resize viewers

Types of databases There are three types of databases in the Database Explorer:

* Database includes data associated with DNA and RNA records; protein records;
and enzymes, oligos, and gel markers.

* Projects include data and results associated with alignment projects, contig
assembly projects, and cloning projects.

* Results include BLAST and analysis results.
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1 Database Explorer
Open files

Subsets A subset is a group of objects organized by a specified criteria, such as common
features. For example, you might have one subset for each of your molecule families,
and one for each taxonomic group. Subsets are shown as folders [ | in the Database,
Projects, and Results panes. You can search for records by name and create and store

data in subsets.

Open files

You can open assembly projects, molecules, and BLAST results. The following file
formats are recognized by Vector NTI Express Software:

File

Format

DNA/RNA
molecules

Protein molecules

All nucleotide files (*.gb, *.gbwithparts, *.fasta, *.fas, *.fa, *.mpfa,
* fna, *.fsa, *.seq, *.embl, *.gcg, *.ma4, *.ddbj)

Genbank (*.gb, *.gbwithparts)

DDBJ (*.ddbj)

Fasta (*.fasta, *.fas, *.mpfa, *.fna, *.fsa, *.seq)

EMBL (*.embl]

GCG (*.gcg)

Vector NTI® Archive (*mad4)

All protein files (*.fasta, *.fas, *.fa, *.mpfa, *.fna, *.fra, *.fsa, *.seq,
*.gp, *.gpwithparts, *.swp, *.pa4, *.trembl]

Fasta (*.fasta, *.fas, *.mpfa, *.fna, *.fsa, *.seq)

GenPept (*.gp, *.gpwithparts)

Swiss-Prot (*.swp)
TrEMBL/EMBL (*.trembl,*.embl)

Vector NTI® Archive (*pa4)

3D molecules

* pdb

Assembly projects

MSA projects

Contig Project (*.cepx, *.cep)

Alignment Project (*.apr, *.aprx)

BLAST results

Vector NTI® Archive (*.bab)

To open a file:

1. Click File » Open.

2. In the drop-down list, select a subset.

16
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3.

Database Explorer operations

mEdit Curate Discover Design Confirm Too

MNew 4 —

T o
Impart 4 DMNA

MSA

Blast results
Protein

3D Molecule

Exit

+-E] Workgroup Shared [

In the Open File window, navigate to the file, select it, then click Open.

Database Explorer operations

In Database Explorer, you can:

Create DNA/RNA and protein molecules (this page), gel markers, oligos, and
enzymes (page 19), and projects (page 33).

Import data (page 21) and export data (page 27) (not available in the
demonstration version).

Manage your data by organizing your data into convenient groups (subsets), and
sorting, duplicating, and deleting data (page 23).

Edit data (page 28).

Search the database for text sequence, motifs, feature types, keywords, and other
information (page 28).

Open other applications (page 30).
Copy a molecule (page 30) save a molecule (page 32), and print molecule data
(page 33).

Create DNA/RNA and protein molecules

There are five different ways to create DNA/RNA and protein molecules:

Import a molecule from DDBJ, EMBL, FASTA, GCG, GenBank, GenPept,
SWISS-PROT, TrEMBL, and Vector NTI® Archive formats, or from an ASCII file
of flexible format. The sequence and feature map are converted from the file, and
the new molecule becomes part of the Vector NTI® Express Software database.

Create molecules from nucleotide or amino acid sequences that you define. You
can manually enter these sequences or you can paste from a clipboard and enter
the sequence as a new molecule.

Translate a coding region of an existing DNA or RNA molecule to create protein
molecules.

Construct new DNA/RNA molecules from user-defined compatible component
fragments from other molecules.

Design DNA/RNA molecules from components in a user-defined fragment list,
using the built-in biological knowledge of Vector NTI® Express Software to design
the recombination process. All new molecules are integrated into the database
and can be used in all future operations and analyses.
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1 Database Explorer
Create DNA/RNA and protein molecules

Create a DNA/RNA  To create a DNA/RNA molecule:
molecule 1. In the main menu, click File » New.
2. In the drop-down list, select DNA to open the New DNA Molecule window.

3. Enter a name, select the form, and enter a description, then click OK.
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Create gel markers, oligos, and enzymes

Create a Protein To create a protein molecule:

molecule 1

2.
3.

. In the main menu, click File » New.

In the drop-down list, select Protein in the New Protein Molecule window.

Enter a name and description, then click OK.

Create gel markers, oligos, and enzymes

Gel marker, oligonucleotide, and enzyme objects can be created “from scratch” using
editors in Vector NTI® Express Software or by importing them from FASTA files, Vector
NTI® Archive files, an oligo list, and a REBASE database.

Create a gel To create a gel marker:

marker 1

2.
3.

. In the main menu, click File » New.

In the drop-down list, select Gel Marker to open the Gel Marker window.

Enter a name. Click the browse button (...) to open the Choose Database Gel
Marker window, then click OK.

4. Select a gel marker type.

5. Click the Gel Marker tab, enter a fragment length, then click OK.
Create an oligo To create an oligo:

1. In the main menu, click File » New.

2. In the drop-down list, select Oligo to open the Oligo window.
3.
4

In the General tab, enter a name, then click the Oligo tab.

. Enter the nucleotide sequence, then select the oligo type.

To replace the oligo with its complementary sequence, check the Reverse
Complementary box.

Enter a description, then click the User Fields tab.

Click a cell in the table, click Change Value to open a data entry window, then
enter a value.

To remove a value, click Remove Value.

After you have finshed entering values, click the Comments tab.
Enter comments about the oligo, then click the Keywords tab.

To add a keyword for the oligo, enter a new word or select an item in the list of
existing keywords.

To move the keyword into the keyword list, click < Add. To remove an item from
the keyword list, select it, then click > Remove.

To save your data, click OK. To close the Oligo window without saving your data,
click Cancel.
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1 Database Explorer
Create gel markers, oligos, and enzymes

Create an enzyme  To create an enzyme:

1. In the main menu, click File » New.

2. In the drop-down list, select Enzyme to open the Enzyme window.

3. In the General tab, enter a name, then click the Enzyme/Methylase tab.
4. Enter the recognition string of the enzyme.
5

. In the Cleavage Point/Methylation Base field, enter the number of the nucleotide
immediately after the direct strand cleavage point. The following example
demonstrates how cleavage points of palindromic sites are defined.

Cleavage Point = 2

AIATATT
112 3 4 5 6

TTATAIA

In the Cleavage Point on Complementary Strand field, enter the number of the
nucleotide immediately after the complementary strand cleavage point. The
following example demonstrates how cleavage points are defined for
non-palindromic sites on both direct and complementary strands.

Cleavage Point on Complementary Strand = 10

=8

A AGTNNNINNN
8 9

1 2 3 4 5 6 7 10

TTCANNNNN(IN

Cleavage Point on Complementary Strand = -4

Cleavage Point

Cleavage Point = -2

NNNNNNNAAGT
7 6 5 4 32 11 2 3 4

NNNNNNNTTCA

6. Select the enzyme type, regular restriction enzyme or methylase, then click the
User Fields tab.

7. Click a cell in the table, click Change Value to open a data entry window, then
enter a value.

To remove a value, click Remove Value.

After you have finshed entering values, click the Comments tab.

8. Enter comments about the enzyme, then click the Keywords tab.
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9. To add a keyword for the enzyme, enter a new word or select an item in the list of
existing keywords.

To move the keyword into the keyword list, click < Add. To remove an item from
the keyword list, select it, then click > Remove.

10. To save your data, click OK. To close the Enzyme window without saving your
data, click Cancel.

Import data

You can import DNA/RNA and protein molecules, enzymes, oligos, and gel markers,
assembly projects, and BLAST results in the Vector NTI Express Software Local
Database.

Import molecules You can import molecules (including their feature tables) from DDBJ, EMBL, FASTA,
GCG, GenBank, GenPept, SWISS-PROT, TrEMBL, and Vector NTI® Advance Archive
files. Two types of DNA/RNA molecules can exist in the Vector NTI® Express Local
Database:

e (Circular DNA Molecules
¢ Linear DNA/RNA Molecules

Molecules are imported in the DNA/RNA Molecules subset and Protein Molecules
subset within the Local Database. The DNA/RNA Molecules and Protein Molecules
subsets contain descriptions of a molecule’s features.

You can also import nucleotide or amino acid sequences from an ASCII file of flexible
format, and Vector NTI® Express Software will automatically create the new database
molecule and assign the sequence to the molecule.

File formats The following file formats can be imported into Vector NTI® Express:
File Format
DNA/RNA All nucleotide files (*.gb, *.gbwithparts, *.fasta, *.fas, *.fa, *.mpfa, *.fna,
molecule * fsa, *.seq, *.embl, *.gcg, *.ma4, *.ddbj)

Genbank (*.gb, *.gbwithparts)

DDBJ (*.ddbj)

Fasta (*.fasta, *.fas, *.fa, *.mpfa, *.fna, *.fsa, *.seq)
EMBL (*.embl)

GCG (*.gcg)

Vector NTI® Archive (*ma4)
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File

Format

Protein molecule

All protein files (*fasta, *fas, *fa, *mpfa, *.fna, *fsa, *seq, *.gp,
* gpwithparts, *.swp, *.pa4, *.trembl)

Fasta (*.fasta, *.fas, *.fa, *.mpfa, *.fna, *.fsa, *.seq)

GenPept (*.gp, *.gpwithparts)

Swiss-Prot (*.swp)

TrEMBL/EMBL (*.trembl,*.embl)
Vector NTI® Archive (*pa4)

Enzyme

REBASE (*.rebase), Vector NTI Archive (*.ga4)

Oligo

Vector NTI Archive (*oa4), Oligo List (*.txt), Fasta (*.fasta, *.fas, *.fa,
* mpfa, *.fna, *.fsa, *.seq)

Gel marker

Assembly
Project

Vector NTI® Archive (*.ga4)

' Contig Project [*.cepx, *.cep)

MSA projects

Alignment Project (*.apr, *.aprx]

BLAST results

Vector NTI® Archive (*.bab)

Import files There are two ways to import files: by dragging and dropping files in Windows
Explorer or by using the main menu in the Vector NTI Express Software.

Drag and drop files into a subset

To drag and drop files into a subset:

Highlight the file names in Windows Explorer. Select the files, then drag and drop
them onto a subset in the Local Database folder in the Explorer Viewer.

Import files via the main menu

To import objects via the main menu:

1. Click File > Import.

2. In the drop-down list, select the type of file you want to import.

3. In the Import into Database window, navigate to the file, select it, then click Open.
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Results databases
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Manage data

This section describes how to:

* Manage Database, Projects, and Results databases (page 23)
* Manage Database, Projects, and Results subsets (page 23)
Manage data in the Database, Projects, and Results databases by creating subsets of

subsets (subfolders of folders), grouping data within subsets, and organizing subsets.
Subsets can be hierarchically organized down to six levels.

You can:
* Create DNA and protein molecules, gel markers, oligos, enzymes, and projects.

* Open an assembly project; DNA, protein, and 3D molecules; and BLAST results.

¢ Import DNA and protein molecules, gel markers, enzymes, oligos, BLAST results,
and assembly projects.

¢ Edit molecules by inserting, deleting, and replacing sequence fragments and
features. You can also modify the display format and general data of molecules.

In the Database Explorer, you can create subsets in a database and search databases.

Create a Local Database subset
To create a subset:

1. In the Explorer Viewer, click Local Database, right-click a subset (for example,
DNA/RNA Molecules), then select Add subset to open the Create Subset window.

2. Enter a subset name (for example, “Hexokinase”), description of the subset (for
example, “A collection of hexokinase genes”), then click OK.

Search a Local Database subset

To search a Local Database subset:
1. In the Explorer Viewer, click Local Database, then expand a database.
2. Right-click a database, then select Search to open the Search window.

3. Enter text. To search for the exact text, check Exact match only. Click OK to begin
the search.

Manage Database, Projects, and Results subsets in the Explorer Viewer. You can:

* Add asubset (page 24)

® Search alocal database or subset (page 24)

¢ [Edit the properties of a local database subset (page 24)
* Rename a local database subset (page 24

¢ C(lear a local database subset (page 24)

¢ Dismiss local database subsets (page 25)

* Delete the contents of a local database subset (page 25)

* View a summary of a local database subset (page 25)
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To manage Local Database subsets:
1. In the Explorer Viewer, click Local Database, then expand a database.

2. Right-click a subset, then select a managerial operation.

Add a subset
To add a subset to a Local Database:
1. In the Explorer Viewer, click Local Database.
2. Right-click a database, then select Add subset to open the Create Subset window.

3. Enter a subset name and description, then click OK.

Search a local database or subset
To search a local database or subset in a local database:
1. In the Explorer Viewer, click Local Database.
2. Right-click a database, then select Search to open the Search window.
3. Enter text. To search for the exact text, check Exact match only. Click OK to begin
the search.
Edit the properties of a local database subset
To edit the properties of a Local Database subset:
1. In the Explorer Viewer, click Local Database, then expand a database.

2. Right-click a database, then select Edit properties to open the Edit Subset
window.

3. Enter a new name for, and/or description of, the subset, then click OK.

Rename a local database subset
To rename a Local Database subset:
1. In the Explorer Viewer, click Local Database, then select a database.

2. In the Records Viewer, right-click an object, then select Rename to open the
Rename window.

3. Enter a new name, then click OK.

Clear a local database subset

Note: Clearing a Local Database subset of its contents does not permanently delete the
contents from a local database.

To clear a subset of its contents:
1. In the Explorer Viewer, click Local Database, then expand a database.
2. Right-click a subset, select Clear subset to open the Subset Management window,

then click OK.
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Dismiss local database subsets
Dismissing a subset deletes the subset from a local database.
To dismiss Local Database subsets:
1. In the Explorer Viewer, click Local Database, then expand a database.
2. Right-click a subset, then select Dismiss subsets to open the Subset Managment
window, then click OK.
Delete the contents of a local database subset

Note: Deleting the contents of a subset permanently deletes them from the Local
Database.

To delete the contents of a Local Database subset:
1. In the Explorer Viewer, click Local Database, then expand a database.
2. Right-click a subset, select Delete Subset Contents to open the Vector NTI®
Express window, then click OK.
View a summary of a local database subset
To view a summary of a Local Database subset:
1. In the Explorer Viewer, click Local Database, then expand a database.

2. Right-click a subset, then select Subset Summary to open the Subset Summary
window.

Manage database objects in the Records Viewer. You can:
* Group database objects (page 25)
* Sort database objects (page 26)
* Add an object to a subset (page 26)
* Rename an object (page 26)
¢ Exclude an object from a subset (page 26)
* Delete an object (page 27)
* Duplicate an object (page 27)
* View object properties (page 27)
e Export data (page 27)
* Show or hide columns (page 28)

To manage database objects:
1. In the Explorer Viewer, click Local Database, then expand a database.
2. In the Records Viewer, right-click a database object, then select a managerial
operation.
Group database objects

You can group database objects in subsets.
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To group database objects:
1. In the Explorer Viewer, click Local Database, then expand a database.

2. In the Records Viewer, select several objects.

Note: To select specific objects, press the Ctrl key and click objects. To select a
block of objects, click the first object in the block, press the Shift key, then click the
last object.

3. Add the objects to a subset:

¢ Right-click the selected objects, then select Add to subset to open the Subset
Management window. Select a subset, then click OK, or

* Drag the selected objects into the subset in the Explorer Viewer.

Note: The objects you grouped were not moved out of the parent subset.

Sort database objects
To sort database objects in ascending or descending order:
1. In the Explorer Viewer, click Local Database, then expand a database.

2. In the Records Viewer, click a column header.

Add an object to a subset
To add an object to a subset:
1. In the Explorer Viewer, click Local Database, then expand a database.

2. In the Records Viewer, right-click an object, then select Add to subset to open the
Subset Management window.

3. Select the subset you want to add the object to, then click OK.

Rename an object
To rename an object:
1. In the Explorer Viewer, click Local Database, then expand a database.

2. In the Records Viewer, right-click an object, then select Rename to open the
Rename window.

3. Enter a new name, then click OK.

Exclude an object from a subset

Note: Excluding an object from a subset does not permanently delete it from the
database.

To exclude an object from a subset:
1. In the Explorer Viewer, click Local Database, then expand a database.

2. In the Records Viewer, right-click an object, select Exclude from subset to open
the Vector NTI® Express window, then click OK.
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Delete an object
To permanently delete an object:
1. In the Explorer Viewer, click Local Database, then expand a database.
2. In the Records Viewer, right-click an object, select Delete from Database, then
click OK.
Duplicate an object
To duplicate an object
1. In the Explorer Viewer, click Local Database, then expand a database.

2. In the Records Viewer, right-click an object or multiple objects, then select
Duplicate.

Duplicates of objects are created in the database and included in the current subset.
The duplicate of an object is named Copy of, for example, Copy of EPAC. Multiple
duplicates are numbered, for example, Copy#2 of EPAC.

Note: Duplicates of objects are not related to the original objects. Therefore, changes
that you make to the original object are not made in duplicates.
View object properties
To view object properties:
1. In the Explorer Viewer, click Local Database, then expand a database.

2. In the Records Viewer, right-click an object, then select Properties to open the
properties window.

Note: If one object is selected, all the named object fields with their values are
displayed. Some object data (like sequence and comments) are not stored in named
fields and are not displayed in the properties window.

Export data

To export DNA/RNA and protein molecules, enzymes, oligos, Contig Assembly
projects, and BLAST results:

1. In the Explorer Viewer, click Local Database, then select a database.

2. In the Records Viewer, open the Export Data window:
* Select an object, then click File » Export, or
¢ Right-click an object, then select Export.

3. Navigate to the export location.

4. (Optional) Rename the file and/or select a new file type, then click OK.
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You can export data in the following file formats:

File Format
DNA/RNA Genbank (*.gb, *.gbwithparts)
molecule DDBJ (*.ddbj)
Fasta (*.fasta, *.fas, *.fa, *.mpfa, *.fna, *.fsa, *.seq)
EMBL (*.embl)
GCG (*.gcg)
ASCII (*.txt)

Protein molecule ' Fasta (*.fasta, *.fas, *.fa, *.mpfa, *.fna, *.fsa, *.seq)

GenPept (*.gp, *.gpwithparts)
SWISS-PROT [*.swp)
TrEMBL (*.trembl)

ASCII [*txt)
Enzyme REBASE (*.rebase)
Oligo CSV (*.csv)

BLAST results Tab-delimited (*.txt)

Contig Assembly ' Contig Project (*.cepx]
Project

Show or hide columns

For all databases in the Local Database, you can show or hide columns in the Records
Viewer.

To show or hide columns:
1. In the Explorer Viewer, click Local Database, then expand a database.

2. In the Records Viewer, right-click anywhere in the records table, then select
Column.

3. In the drop-down list, check or uncheck the columns that you want shown or
hidden.

Edit data

The operations described in this section apply to the Enzymes, Oligos, and Gel
Markers databases in the Local Database. This section describes how to:

¢ Edit enzyme properties (page 28)

e Edit oligo properties (page 29)

e Edit gel marker properties (page 29)

Edit enzyme To edit an enzyme:

properties 1. In the Explorer Viewer, click Local Database, then select Enzymes.
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2. In the Records Viewer, right-click an enzyme, then select Edit.

3. In the enzyme window, click the Enzyme/Methylase tab to edit the following
properties:

Recognition String Enter a nucleotide string that can be recognized as
the enzyme.

Cleavage Point/Methylation Base | Enter the number of the nucleotide immediately
after the direct-strand cleavage point.

Description Enter or edit the enzyme’s description.

4. Click the User Fields tab to edit the values of the following fields:
¢ Commercial Sources ¢ Organism
¢ TFreezer Position e WWW Source

5. Click the Comments tab to enter comments about the enzyme.

6. Click the Keywords tab to add or remove keywords that will improve database
searches.

Edit oligo To edit an oligo:
properties 1. In the Explorer Viewer, click Local Database, then select Oligos.
2. In the Records Viewer, right-click an oligo, then select Edit.

3. In the oligo window, click the Oligo tab to edit the following properties:

Nucelotide Sequence Enter or edit the oligo’s nucleotide
sequence. Valid characters: ATUCG
DNA/RNA Order Select a DNA or RNA sequence, then click

Order to open your browser and order
your primer sequence from Life
Technologies Corporation.

Reverse Complementary Check the box to replace the oligo
sequence with the complementary
sequence.

Description Enter or edit the oligo’s description.

4. Click the User Fields tab to edit the values of the following fields:
¢ Commercial Sources ¢ Organism
¢ TFreezer Position ¢ WWW Source

5. Click the Comments tab to enter comments about the enzyme.

6. Click the Keywords tab to add or remove keywords that will improve database
searches.

Edit gel marker To edit a gel marker:
properties 1. Inthe Explorer Viewer, click Local Database, then select Gel Markers.

2. In the Records Viewer, right-click a gel marker, then select Edit.
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3. In the General tab of the gel marker window, click the ... button to select a name
for the gel marker.

4. Click the Gel Marker tab to edit the following properties:

Fragment Lists by length all the fragments making
up the marker.

Click Add or Delete to add a fragment to
the marker, or remove a fragment from
the marker.

Fragment (length in b.p.) Enter the length of the fragment in base
pair (bp), then click Add.

Description Enter or edit the gel marker’s description.

Open other applications

You can right-click on DNA/RNA and protein molecules in the database and open the
following applications:

* Web Analyses (see page 50)

* Analysis Monitor (see Chapter 10 on page 109)

* BLAST Search (see Chapter 6 on page 81

* BioAnnotator (see Chapter 4 on page 71)

¢ AlignX (see Chapter 8 on page 95)

To open other applications:

1. In the Explorer Viewer, click Local Database, then select DNA/RNA Molecules
or Protein Molecules.

2. In the Records Viewer, right-click a molecule, then select an application.

Copy, save, and print molecules

Copy a molecule by taking a screenshot with the Camera tool. Save the screenshot as
text or as an image in an application such as Microsoft Word or Microsoft Excel. Print
the text or image.

Copy a molecule Use the Molecule Editor to copy molecules. In the Database Explorer, open the
Molecule Editor by opening a molecule:

1. In the Explorer Viewer, click the DNA/RNA Molecules folder or the Protein
Molecules folder in the Local Database folder to display the molecules in the
Records Viewer.

2. In the Records Viewer, double-click a molecule to display a graphical map of a
molecule and its sequence.
The Explorer Viewer is replaced by the Properties Viewer. The Records Viewer is
replaced by the Molecule Editor. The Summary Viewer is replaced by the
Sequence Viewer.
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Note: You can widen, narrow, lengthen, and shorten the size of the viewers and
Molecule Editor by clicking and dragging the viewer frames.

For more information about the Molecule Editor, see Chapter 2 on page 39.

| Molecule
Properties __| Editor
Viewer

Sequence Viewer

Copy molecule properties, feature map, and analysis results
To copy molecule properties, feature map, and analysis results:

1. In the Explorer Viewer, click Local Database, then select DNA/RNA Molecules
or Protein Molecules.

2. In the Records Viewer, double-click a molecule to open it.

3. Right-click anywhere in the Properties, Feature Map, or Analysis Results viewers,
then select Camera to take a screenshot of the data.

The data is copied to the clipboard and can be pasted in other applications.

Copy molecule image
To copy an image of DNA/RNA molecules and protein molecules:

1. In the Explorer Viewer, click Local Database, then select DNA/RNA Molecules
or Protein Molecules.

2. In the Records Viewer, double-click a molecule to open the Molecule Editor.
3. Right-click the graphical depiction, then select Camera.
4. Click anywhere in the graphic to take a screenshot. The image is copied to the
clipboard and can be pasted in other applications.
Copy a sequence

To copy a sequence:
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1. In the Explorer Viewer, click Local Database, then select DNA/RNA Molecules
or Protein Molecules.

2. In the Records Viewer, double-click a molecule to open the Molecule Editor.

3. Select a sequence:
* C(lick and drag across a sequence region in the molecule image, or
* C(lick and drag across the text in the Sequence Viewer.
Right-click, then select Copy
The data is copied to the clipboard and can be pasted in other applications.

Save a molecule Molecules you create can be saved to only to the Local Database. To save database
molecules:
1. Click File » Save in the main menu, or

Click File » Save As to save the molecule with a different name and/or to a
different location:

a. Enter a new name for the molecule.

b. Select the destination folder for the molecule.
Optionally save the object as a file. Select the file type:

— For DNA/RNA molecules: Genbank, Genbank Old Format, EMBL,
Fasta, DDBJ, or ASCII text

— For protein molecules: ASCII text, GenPept, GenPept Old Format,
Swiss-Prot, Fasta, or TTEMBL

2. Click OK.
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Print molecule To print molecule data:
data 1. In the Explorer Viewer, click Local Database, then select DNA/RNA Molecules

or Protein Molecules.
2. In the Records Viewer, double-click a molecule to open it.

3. Right-click in the Properties Viewer, Molecule Editor, or Sequence Viewer, then
select Camera to take a screenshot.

4. Open an application such as Microsoft Word, Excel, Paint, or Notepad and paste
the screenshot.

5. Print the data from the application.

Manage the Projects database

You can perform the following operations to manage the Projects database:
* Create a project (page 33)
¢ Open a project (page 33)
* Manage Projects subsets (page 33)
* Delete Projects subsets (page 34)

Create a project To create a project:
1. In the main menu, click File » New, then select the type of project you want to
create.
¢ Alignment * Gateway Cloning
¢ ContigExpress * Clone2Seq
e TOPO Cloning ® Parts Assembler

2. In the project window, enter a project name and description, then click New.

Open a project To open a project:
1. Click the Projects bar.
2. In the Projects Viewer, expand the Local Database.
3. Select the folder containing the type of project you want to open.
4. In the Records Viewer, double-click a project to open the project application

(for example, Alignment) and view its properties.

Ma nage Projects To manage subsets in the Projects database:
subsets 1. Click the Projects bar.

2. In the Projects Viewer, expand the Local Database, then expand a project.
3. Select the subset you want to manage.
4

. Right-click a subset, then select a managerial operation. For more information, see
“Manage Database, Projects, and Results subsets” on page 23.
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Delete Projects You can delete subsets of Alignment, Contig Assembly, or Cloning projects. You cannot
subsets delete the Alignment, Contig Assembly, and Cloning folders in the Local Database.

To permanently delete the subset of an Alignment, Contig Assembly, or Cloning project
from the database:

1.

2
3.
4

Click the Projects bar.

. In the Projects Viewer, expand the Local Database.

Select the folder containing the type of project you want to delete.

. Right-click, then select Dismiss subsets.

Manage the Results database

You can view BLAST results and analysis results and manage the BLAST Results and
Analysis Results databases.

View results To view BLAST results and analysis results:
1. Click the Results bar.
2. In the Results Viewer, expand the Local Database, then select BLAST Results or

Analysis Results.

In the Records Viewer, double-click a result to open the BLAST Viewer or
Molecule Editor.

Manage Results To manage subsets in the Results databasse:
subsets 1. Click the Results bar.
2. In the Projects Viewer, expand the Local Database.

3.

Right-click a subset, then select a managerial operation. For more information, see
“Manage Database, Projects, and Results subsets” on page 23

Workgroup Shared Database

This section describes how to:

34

Connect to a workgroup shared database (page 35)
Add users to a workgroup shared database (page 36)

A user name should be one word without spaces.Edit users in a workgroup
shared database (page 37)

Delete users from a workgroup shared database (37)
Upload data to a workgroup shared database (page 37)
Download data from a workgroup shared database (page 37)

Disconnect from a workgroup shared database (page 37)
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Workgroup Shared Database

You can create special databases, repositories of DNA/RNA or protein molecules,
enzymes, oligonucleotides, and gel markers and share them among several Vector NTI
Express Software users on a network. Workgroup shared databases are not a
replacement for local databases; each Vector NTI Express Software application still
must have its own local database. The local database is used in all operations, for
example, the construction, design, and creation of viewers. The local database is also
the place for storing private and temporary data. The main purpose of the workgroup
shared database is to store common data.

The only operations you can perform on workgroup shared databases are:

* Copying data to and from the local database. For instance, you can copy some of
your molecules and enzymes from your local database into the workgroup shared
database. In order to use them in the design process, your colleague must first
copy them to his or her local database.

* Performing various database management operations such as creating and
deleting subsets.

* Running database searches.

In addition to biological data, each database contains information about its creator and
registered users. Only the creator and registered users can have access to database
data. The database creator can also change database properties, remove registered
users, and define the password required to become a register user.

Note: Vector NTI® Express workgroup shared databases use portable data format
(PDF) and file naming conventions to ensure that both Macintosh and Windows users
of Vector NTI Express Software can access common databases. Workgroup shared
databases can be located on a wide range of file servers.Vector NTI Express Software
can use not only services native to each system (Microsoft Network or AppleTalk), but
also various Unix (NFS or Samba) and NetWare services.

The workgroup shared database capability is a purchased addition to Vector NTI
Express Software. When you purchase the workgroup shared database capability, you
are issued a Vector NTI Express Software-workgroup shared database license that
enables you to create workgroup shared databases. A workgroup shared database
license is a special type of static license that enables you to create numerous
workgroup shared databases. But the license also limits the number of users for each
database you create. You do not need a workgroup shared database license to access
workgroup shared databases.

Note: Workgroup shared databases can be accessed from Vector NTI Express Software
using a license that is shared through a network server (Dynamic License).

You can connect to a workgroup shared database through only a hostname and
IP address, not via the World Wide Web.

When the network directory for a new workgroup shared database is arranged,
connect to a workgroup shared database. Before you can connect to a workgroup
shared database, the workgroup shared database server must be started.

Start the workgroup shared database server

In C:\ Program Files\ Life Technologies \ Vector NTI Workgroup Shared Database
Admin\h2_setup, double-click startSharedServer and open the cmd.exe window:
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S\WINDOWS\system3 2\cmd.exe

C:“Program Files“Life TechnologiesUector NTI SBhared Database Rdmin\hz_setup)remli
set JAVA_HOME=C:~Javasjdkl.6.8_25 .

IC:“\Program Files“Life Technologies“\Uector NITI Shared Database Admin“h2_setuplget
PATH=C:“Program Files“Applied Biosystems“QuantStudiol2KFlex hindlls ;C:\WIND®WS
heystem32; CaNWINDOWS ; C:AWINDOWE~S ystem3 2 Wbem; ~hin

IC:\Program Files“Life Technologies“Uector NITI Shared Database Admin“~h2_setuprset
CLASSPATH=:; .~\h2-1.3.157_jar

IC:“Program Files“Life Technologies“Uector NTI Shared Datahase Admin-~h2_setupXrjav
la org.h2.tools.Berver —tcp —tcpAllowOthers —tcpPort 8882 -baseDir “C:/UntiExpres
ls_SharedDatahase"

ICP server running at tep://167.116.197.164:8882 C(others can connect?

Note: The cmd.exe window automatically opens after the installation of Shared
Database Admin.

Connect to the workgroup share database server

1.

Open Vector NTI® Express Software, then:
¢ In the main menu, click Tools » Connect to workgroup shared database, or

* Open the Database Explorer. In the Explorer Viewer, click Workgroup
Shared Database.

In the Connect to Workgroup Shared Database window, log on:

Host Name: localhost

User Name: Your user name

Password Your user password

Note: (Host Name field) If the Workgroup Shared Database Admin application
and Vector NTI® Express Software are not installed on the same computer, enter

the IP address of the computer on which the Shared Database Admin application
is installed. The IP address is shown in the cmd.exe window:

TCP server running at tcp:/-s167.116.197_164:8802 {(others can connect? |
Click Connect.

Close the Connect to Workgroup Shared Database window. Your connection will
not be broken.

You must be an administrator to add users to a workgroup shared database.

To add users to a workgroup shared database:

1.

In C:\Program Files\ Life Technologies \ Vector NTI Workgroup Shared Database
Admin\h2_setup, double-click startSharedServer to start the server.

Double-click the Shared Database Administration icon on your desktop to open
the Login window.
Log in:

¢ Database Hostname/IP: localhost

* Administrator username: admin

e Password: admin
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Set preferences

4. Click Login to open the Shared Database Administrator window.

5. Click Add, then enter information in the Add User window.

To edit users in a workgroup shared database:

1. Open the Workgroup Shared Database Admin application and log in as an
administrator.

2. In the Workgroup Shared Database Administrator window, double-click a user to
open the Edit User window.

3. Edit the user information, then click OK to save your edits.

To delete users from a workgroup shared database:

1. Open the Workgroup Shared Database Admin application and log in as an
administrator.

2. In the Workgroup Shared Database Administrator window, select a user, click
Delete, then OK.
To upload data from the Local Database to a workgroup shared database:
1. Connect to a workgroup shared database.
2. In the Explorer Viewer, click Local Database, then select a subset.
3. In the Records Viewer, right-click an object, then select Upload to workgroup
shared database.
To download data from a workgroup shared database to the Local Database:
1. Connect to a workgroup shared database.
2. In the Explorer Viewer, click Workgroup Shared Database, then select a subset.

3. In the Records Viewer, right-click an object, then select Upload to local database.

To disconnect from a workgroup shared database:
1. 1. Click Tools in the main menu, then Connect to workgroup shared database.

2. 2.In the Connect to Workgroup Shared Database window, click Disconnect.

Set preferences

Set display
preferences for
molecules

You can set preferences for displaying molecules and sequences and register your
email address with the National Center for Biotechnology Information (NCBI).

To set display preferences for molecules:

1. In the main menu, click Tools » Preferences to open the Preferences window.
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1 Database Explorer
Set preferences

Set display
preferences for
sequences

Register with the
NCBI
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In the Display Preference view, click the background color and highlight color
buttons to open the Color palette.

Select background and highlight colors, then click OK.

To save your preferences, click Apply, or click Restore Defaults to keep the
original settings.

To set display preferences for sequences:

1.
2.

Expand Display Preference, then click Sequence Preference.

Click Sequence fill color and Sequence line color to open the Color palette and
select colors.

Enter values for the sequence width and sequence line width parameters.
To change the title font, click the Change button, then select and define a font.

To change the title font color, click the button to open the Color palette and select
a color.

Click Apply to save your preferences.

To register your email address with the NCBI:

1.
2.
3.

Click NCBI Configuration.
Enter your email address, then click Register to open your email application.

Click OK to close the Preferences window.
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Molecule Editor

The Molecule Editor in Vector NTI® Express displays a graphical representation of a
DNA or protein molecule, the molecule sequence, information about the molecule, and
the results of any analysis performed on the molecule.

Using the Molecule Editor, you can:

Create or open a

Create a new 1.

molecule

Create and edit a molecule sequence
Annotate the molecule
Analyze the molecule

— For DNA/RNA molecules, you can perform restriction analysis, design
primers from the sequence, find ORFs, translate the sequence into amino
acids, and other functions.

— For protein molecules, you can scan for motifs, perform web searches on the
sequence, perform back translation, and other functions.

— Molecule sequences may also be analyzed using a variety of web tools and
publicly available analysis engines

Display the analysis results

molecule

To create a new molecule, click on File > New and select DNA or Protein as the
molecule type.

Note: For DNA or RNA molecules, specify Linear or Circular.

2.

The blank molecule will be displayed in the Molecule Editor but will not yet be
saved in the database.

Open an existing To open an existing molecule:

molecule o

For molecules in the database, double-click on the molecule name in the Database
Explorer window

For molecules that are not in the database, select File > Open and select a
molecule of the appropriate file type (.gb, .fasta, etc.)

The molecule will be displayed in the Molecule Editor.
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2 Molecule Editor
Molecule Editor window

Molecule Editor window

The Molecule Editor window consists of five main panes as well as various tools and
analysis functions:

» =

Properties O yLRO48W T BLOCKAT-PolTI-mi... ] pDESTR4-R3Wector\l 23 | [ pCR-BIUN\I-TOPO 10 =] rgg

[=- Beneral Description ]l (% Q CE L_flr |3";;_:'5‘ 1
D'NA 'pDESTR! Tl =

. M13 reverse primer = s
Tfrozen Vector) Copy of pDESTR4-R3 il

D|Sp[ay tools —" Length: 4555 bp / Graphics pane

B
Form: Circular &
[ Standard Fields /3“4 .
Accession Number: pDESTRE-R3\ector | aza
Medified Date: 17-Mar-2008 | ; -
References ccdB . x
O Avtnor 5 Analysis tools —— &
Invitrogan '%‘
Invitrogen Carparation z
H 5791 Van Allen Way
PrOpertleS pané —i — Carlsbad, CA92008 US.A. JDESTR4-R3\VECtOr\| =]
TEL: (800) 955-6288
EMAIL: bicinfosales@invitrogen.com 4555bp [E|
- Criginal Author AmplR) | i
Invitrogen y 5
Invitrogen Corporation cmiR)

5791 Van Allen Way
Carlshad, CAS2008U S5 A

TEL: (800} 955-6288 bla promoter
EMAIL: bioi invitrozen com i S ]
() Comments
1 CRGGRRACAG CIATGACCAT GATTACGCCR AGCTATCAAC TTIGTATAGR ARACTTIGAAC GAGAM A
This file is created by Vector NTI GICCITTCIC GATACTGGTA CTAATGCGGT TCGATAGTTG AAACATATCT TTTCAACTTC CICTTI
bizp:/ furue Invitrozen.com/ = 101 GATTTTECAT CRGR CTACATRATR CTET CR CRACATATCC AGTCACTATE GTCEAC—
v CTARRACETA TTTTTTGTCT GATGTATTAT GACATTTTGT GTTGTATAGG TCAGTGATAC CAGCTC
Feature Map < | > 201 GGICGIATCC AGCCTACTCG GCIATTGICGT CARTCCCGTA TTARATCATA ARRAGARRTA AGARAZ
| e GCAGCATACC TCCGATGAGC GATAACAGGA GITACCCCAT AARTTTAGTAT TITTCITIAT TCITTI
Properties 301 ARRACATCTA CCIATTCATA TACGCTAGTG TCATAGICCT GARRATCATC TGCATCARGA ACAATI
TITIGTAGAT GGCATAAGTAT ATGCEATCAC AGTATCAGEGA CITTTAGTAG ACGTAGITCI TGITAZ
Feature Map 401 CGGCTICATC TGGATITIICA GCCICTATAC TTACTARACG TGATAARCTT TCIGTRRITT CTACTC
GCCGRACTAC ACCTAAMACT CCGAGATATC ARTGATITGC ACTATTTCAA AGACATTARR GATGAC
Analysis Results 501 CIGACATITA TATICCCCAG AACATCAGGT TAARTGECGIT TITGATGIGA TTITCGCGET EGGCIGZ
GACTGTARRT ATAAGGGGIC TTGTAGTCCA ATTACCCCAR ARACTACAGT\ ARRAGCGCCR CCEACI
» 601 CACACTGECC ATATCGEIGE TCATCATGCE CCAGCTTICA :lrccccc-am:r \c-c.l,ccsccc-c- cTanacd
. | B >
Analysis Results - \ -

Sequence pane
® The Graphics pane displays a graphical representation of the molecule, including
features.
* The Sequence pane displays the molecule sequence, as well as the result
® The Properties pane displays information about the molecule.
¢ The Feature Map displays a list of the defined features in the molecule.

Feature Map

= Feature Map

Misc. Recombination (2)

Primer (3}

Promoter Prokaryotic (1)

= chs(3)

ccdB [Complementary(508..813))
Cm(R} [Complementary(1158..1818))
[¥] Amp(R} (2791..3651)

...
Properties

‘f |
Feature Map
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molecule.

Analysis Results

Enter or edit a sequence

* The Analysis Results displays analyses that have been performed on the

= [] Restriction Map

asez ¢
[aat1z

[JaccesI (eeTACC) :

[Jaeer ¢

CACCTGC): 0O sites
(BACETC): 1 sites
0 sites

GICGAC): 2 sites

#-[¥] AceIII (CAGCTC): 4 sites

[Qaeiz
H-[¥] RelI
[] Zeoul
[dasez
Oas11z

(CCEC) = 35 sites

({RRCETT): 3 sites
(CTERRAE) : 2 sites
(BRECECT) -

0 sites

(CTTRAEG): 0O sites

Properties

Feature Map

Analysis Results

The Analysis tools toolbar contains analysis functions specific to the Molecule Editor.

The Display tools toolbar contains tools to magnify the molecule, or display a DNA

sequence as linear or circular.

Molecule display
tools

Use the tools at the top of the window to zoom in and out on the molecule, fit the
molecule within the window, or display DNA/RNA molecules as linear or circular.

@ & & [z

Enter or edit a sequence

The molecule sequence is displayed in the Sequence pane, and a graphical
representation of the sequence is displayed in the Graphics pane.

Enter a sequence 1.
typing.

2. The Edit Sequence dialog will open, displaying your typed sequence.

3. Continue typing and click on OK
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To enter a new sequence, click on an insert point in the Sequence pane and begin
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2 Molecule Editor
Molecule features

Select a sequence

Cut or copy a
sequence

Paste a sequence

Replace a
sequence

Delete a sequence

Reverse a
sequence

To select part or all of a sequence:
* Drag your cursor over the desired portion sequence in the Sequence pane or
Graphics pane.

* C(lick on a feature in the Graphics pane or Feature Map that encompasses that
sequence.

* C(lick Ctrl+a or right-click and select Select all to select the entire sequence.

e To cut a sequence, select it in the Sequence or Graphics pane and click Ctrl+x, or
right-click and select Cut, or select the command from the Edit menu. You will be
prompted to remove the sequence.

* To copy a sequence, select it and click Ctrl+c, or right-click in the Sequence or
Graphics pane and select Copy, or select the command from the Edit menu.

1. To paste a sequence from the clipboard, click on a particular insertion point in the
Sequence or Graphics pane and click Ctrl+v or select Edit > Paste.
2. The Edit Sequence dialog will open, displaying your pasted sequence. Click on

OK to complete the action.

To replace part or all of a sequence, select it in the Sequence Pane and type or paste as
described above.

To delete all or part of a sequence, select it in the Sequence or Graphics pane and click
the Delete key or right-click and select Delete.
You can reverse all or part of a sequence:

1. Select all or part of the sequence in the Sequence or Graphics pane.

2. Right-click and select Reverse Selection to Complementary.

Molecule features

Create a molecule
feature

42

Molecule features are regions of a DNA or protein sequence that you define and
annotate. The feature is then displayed in the Graphics pane and listed in the Feature
Map.

Typical DNA molecule features might include coding regions, specific ORFs, primer
binding sites, etc. Protein molecule features might include structural features, binding
sites, functional domains, etc.

To create a molecule feature:

1. Select a portion of the molecule sequence by dragging in the Graphics pane or in
the Sequence pane.

2. Right-click and select Create feature from selection.

3. In the Feature dialog, select a category from the Feature Type list. Various
miscellaneous categories are available under Misc.
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Select a feature

Hide or display a
feature

Edit or delete a
feature

Restriction Analysis

Feature dialogs for DNA (left) and protein (right)

4. Enter a Feature Name and optional Description.

5. The Location range is auto-populated based on your selection. Enter a different
range in the fields if desired.

6. For a DNA feature, select the Complementary checkbox if the feature is located
on the reverse strand.

7. Click on Add or Delete to add or remove Annotation keys. When adding a key, a
blank key is created in the table; type to replace the text.

8. When you are finished, click on OK. The feature will displayed in the Graphics
pane and in the Feature Map.

To select a molecule feature, click on it in the Graphics pane or in the Feature Map.

To hide a feature or group of similar features, deselect the appropriate checkbox in the
Feature Map. To re-display it, re-select the checkbox.

To edit a feature, right-click on it in the Graphics pane and select Edit feature. The
Feature dialog will open.

To deselect a feature, right-click on it in the Graphics pane and select Delete feature.
You will be prompted to confirm the deletion.

Restriction Analysis

You can identify the restriction sites in a DNA/RNA sequence for hundreds of
restriction enzymes.

To begin, with a DNA/RNA molecule open, click on the Restriction Analysis
. ATGE
button on the Analysis toolbar. C,?
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2 Molecule Editor
Restriction Analysis

The Restriction Analysis tool includes commands for selecting and configuring a list of
restriction enzymes, and running the analysis.

Selecting enzymes A default list of restriction enzymes to be used in the analysis will be selected.
for analysis * Click on enzymes in the list to select or deselect them.

e To clear the list, click on Clear Selection.

e To select all the enzymes in the list, click Select All.

Configuring the 1. To configure the enzymes in the Restriction Analysis tool, click on Configure List.
enzyme list 2. Use the commands in the Selected Restriction Enzymes dialog to add or remove

the selected enzymes, then click on Apply.
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Filter the analysis
results

Perform the
analysis

ORF Finder

ORF Finder

To filter the analysis results by the terminus type of the restriction cut site, select or
deselect the checkboxes under Permitted Terminus Types.

Note: 5" and 3’ refer to the overhang of the resulting cut site, e.g., with 5" deselected,
restriction sites with 5" overhangs will be removed from the analysis.

Ignore RENs Having Less Than/More Than ... Sites hides restriction sites that do not
fall within the range of the specified number of cut sites. Such RENs will be listed but
deselected in the Restriction Map in the Analysis Results. They will not be displayed at
all in the Graphics and Sequence panes.

When you have made your selections, click on Run. The sites will be displayed in the
Graphics and Sequence panes and listed in the Analysis Results.

The results of Restriction Analysis are saved with the molecule.

~ e
BssSI (zo10) At
Acl (ze77) 7 ' ;
bla promoter
BssSI (2603) o
Acul (z013) BetAP] (z400) attR3
Aatll (2660) \\\
Drdl (2406)
M13 (-40) forward primer
M13 (-20) forward primer
—_ . - v
< ¥
GACTGTARRT ATRRGEGEEIC TTIGTAGICCR ATTRCCGCRR RRRCTACAGT RRRRGCECCR

Bstxl

801 CRCARCTGECC ATATCGEIGE TCATCATGCE CCRGCTITICR TCCCCGATAT GCRCCRCCEE
GIGIGACCEE TATAGCCACC ACGTAGTACEC GEICGARACGT AGGEECTATA CEIGEIGECC

To identify ORFs in a DNA or RNA sequence, click on the ORF Finder button [y
in the Analysis toolbar of the Molecule Editor. -

The ORF Finder tool contains settings for identifying ORFs within the sequence.
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Molecule Editor
ORF Finder

Define start and
stop codons

ORF Types

Perform the
analysis
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In the Start and Stop Codon fields, enter start and stop codons for the new ORFs.
Click the Default Start & Stop button to set the start and stop codons to the
following conventional values: Start codons—ATG, GTG; Stop codons—TAA,
TGA, TAG.

Check the Include Stop Codon in ORF box if you want the stop codon to be
considered as a part of the ORF. Otherwise, the stop codon is not considered as
part of the ORF and is not included.

Complete: The Complete check box is selected by default and in the Minimum
Size field the minimum size in base pairs is specified as 150. This can be changed
according to your requirement. Check the Nested check box to look for nested
OREFs. These are ORFs that occur within the main ORF.

Incomplete: Check the Incomplete check box and in the Minimum Size field
specify the minimum size in base pairs for the incomplete ORF to be displayed.
Check the Undefined Start/Stop check box to search for ORFs with undefined
starts, stops or both. Check the Nested check box to look for nested ORFs.

Note:

An ORF with an undefined start is one that has a stop codon at the end but no
corresponding start codon in the same frame

An ORF with an undefined stop is one that has a start codon but no stop codon in
the same frame.

Incomplete ORFs are displayed as a dashed arrow in both the Graphics and the
Sequence Pane. Complete ORFs are displayed as solid arrows.

Click on Run to perform the ORF analysis. The ORFs will be marked with directional
arrows in the Graphics and Sequence panes and listed in the Analysis Results.

The results of ORF analysis are saved with the molecule

By default, ORFs are displayed for the direct and complementary strands. If single-
stranded sequence is displayed, only the ORFs for that strand are shown.
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Translation tool

Translation tool

To translate a RNA or RNA sequence into amino acids, click on the Translate
button in the Analysis toolbar of the Molecule Editor. ATG

The Translation tool contains settings for translating the sequence.

1. Select the genetic code for the desired organism to use as the basis for the
translation from the Genetic Code dropdown list. For more information on
genetic codes, visit www.ncbi.nih.gov/Taxonomy/Utils/wprintgc.cgi?mode=c.

2. Select the Translation Source from among the following options:

— Direct Strand - displays a translation of the direct strand sequence in the
current frame

— Complementary Strand — displays a translation of the complementary
strand sequence in the current frame

— 6 Frame Translation — displays up to 6 translations of the sequence
depending on the selections in the Translation Frame checkboxes

— Translate ORFs - if you have used the ORF Finder to identify ORFs in the
sequence, this selection will translate the ORFs

3. If you selected 6 Frame Translation, select number of direct and complementary
Translation Frames used to translate the sequence. Up to three direct strand (+1,
+2, +3) and three complementary strand (-1, -2, -3) translations may be selected.

4. To create a new protein molecule from the translation, select the Translate into
new protein. Otherwise the translation will be displayed within the DNA/RNA
sequence.

5. Click on Run button to perform the translation.
Translation results If you selected Translate into new protein, you will be prompted to name the new

protein and the protein molecule will be created.

Otherwise, translations of the direct strand will appear above the DNA sequence and
translations of the complementary strand will appear below the sequence.
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2 Molecule Editor
Oligo Duplex Analysis

Translated sequence using 6 Frame Translation with +2 Frames selected

42 ARGLYS GLN LEUTERFRO TER LEUARG GLN ALA ILE ASN PHEVALTER LYS SERTER THI

41 GLNGLUTHR ALA METTHR MET ILE THRPRO SERTYRGLN LEU CYSILE GLU LYSLEUASN

1 CRGEARACAC CTATGACCAT GATTACGCCR AGCTATCRAC TITGTIATAGR ARAGTTIGRAC
GICCITIGIC GATACTGEIAZ CTRATGCEET TCGATAGITE ARARCATATCT TITCRACTIG

Oligo Duplex Analysis

Oligo Duplex Analysis enables the analysis of one or more oligos for potential cross-
reactivity and dimerization.

To open the tool, click on the Oligo Duplex Analysis button in the Molecule -
Editor. ]

2z

User Defined Primer

Name | |

i

4+ 11

Sequence | | Raliiy

Description | |

Select Oligos in Database

Zelected Cligos/Primers:

GGGGACAAGTTTGTACAAAAAAGCAGGCTNMN

GGEGGACCACTTTGTACAAGAAAGCTGGGETN

R B B N S g Be ot

Remave All

somigrtr 3|

Analyze ] [ Save Results ]

Analysiz Results: & Total

GEEGACRRCTTITGTACARRRRRCCAGECTNN e
[N
NNICGGACGRRRRRACRATCETTTGRARCACEEE
Stem Length = & —
Dimer dG = -8.0 keal/mol

GEEGACRRCTTITGTACARRRRRCCAGECTNN
(NN (NN
NNTCGGACGRRRRRACRATETTTGRARCACEEE

Stem Length = &
Nimer dF = -4 3 ¥ral/mnl —

Entering or Using the tool, you can analyze oligo sequences that you enter in the fields at the top,
selecting oligos or you can analyze saved oligos in the database.

e Enter an oligo name and sequence under User Defined Primers at top of the
window and click on Add to List to add it to the list of oligo sequences below,
and/or Save to Database to save it as an oligo in the database.

¢ Click on Select Oligos in Database to select one or more saved oligos in the
database to analyze. Use Ctrl+click and Shift+click to select multiple oligos from
the Oligos in Database dialog.
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Analysis
parameters

Run the analysis

Silent Mutation Analysis

The selected oligos will appear in the Selected Oligos/Primers list.

Select from the following additional analysis parameters:

¢ dG Temperature: enter the temperature in degrees Celsius to be used for
calculating free energy values.

¢ Stem Length: enter the minimum acceptable number of base pairs in a hairpin or
dimer stem.

Click on Analyze to run the analysis. Analysis results are displayed at the bottom of
the window.

Click on Save Results to save the analysis as a separate text file.

Analysiz Results: & Total

GEEGACRRCTTITGTACARRRRRCCAGECTNN e
[N
NNICGGACGRRRRRACRATCETTTGRARCACEEE
Stem Length = &
Dimer dG = -§.9 keal/mol

GEECACAACTITCTACARRRRRCCAGECTHN
1 1

NNTCGGACGRRRRLD CATGTTIGRRCRCEEEE
Stem Length = &
Nimer 4AF = -2 1 kral/mnl ¥

Note: In the graphical depiction of duplexes, vertical lines indicate the primary
interaction, based on the stem length set, and plus symbols indicate secondary
interactions. The greater the dG value, the weaker the interaction; secondary
interactions are not considered in the dG calculation.

Silent Mutation Analysis

In the Molecule Editor, you can search for “silent mutations” in a DNA/RNA sequence
or selected region of a sequence that do not affect amino acid translation but result in
the creation or disappearance of one or more restriction sites.

Note: You do not need to perform restriction analysis before running Silent Mutation
Analysis.

1. Select a region of the sequence or make no selection to analyze the entire
sequence.

2. Click on the Silent Mutations Analysis button to open the tool. T

RRA
3. Click on Add Enzyme from Database to select from a list of restriction

enzymes in the database. Use Ctrl+click and Shift+click commands to select
multiple enzymes in the Enzyme in Database dialog.

4. Click on OK to add the selections to the Available Enzymes list.

5. Use the >>, All>>, <<, and <<All buttons to move enzymes from the Available to
the Use list.
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Molecule Editor
Web analyses

Web analyses
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6. Click on Run to initiate the mutagenesis search. Vector NTI® Express analyzes the
sequence or selected region and attempts to generate suitable silent mutations.
The reading frame for amino acids is defined by the start of the selected region so
that the first three nucleotides of the selected region form the first codon.

The folder contains a list of mutation options that result in the appearing and/or
disappearing of at least one restriction site. The options are sorted by the position of
the first altered nucleotide. If you selected the complementary strand option, mutation
coordinates on both complementary and direct strands are listed.

Note: The program is able to find both “single” (just one nucleotide altered) and
“multiple” (several neighbor nucleotides altered) mutations for any elementary event
(appearing and/or disappearing of at least one site) significantly widening the set of
possible solutions compared to just “single”-mutation analysis.

A DNA or protein molecule sequence or part of a sequence can be analyzed using a
variety of online databases, search engines, and analysis tools.

Note: These analyses require an active Internet connection.

1. In the Graphics or Sequence pane, select the region of the sequence to analyze, or
select Ctrl+A to select the entire sequence.

2. Right-click and select Web Analyses > [search type] > [search database].

Note: You can also right-click on a molecule in the Database Explorer to analyze the
entire sequence.

3. The sequence will be automatically transferred to the analysis engine on the web:
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Back Translation

DNA Molecule Web Analyses.

Protein Molecule Web Analyses

Region_2 Protein Regicn_4
1 1 1
Region_1 Source Region_3
{ D cut ctrl+x )
Coy Cirl+C
Py [ e
L| Delete Delete :
Select Al crl+a - NCYT
Web Analyses 3 Homology Modeling using CPHMODELS @CBS
Camera Compare Against 3 Homology Modeling using SWISS-MODEL @ExPASyY

Protein Feature Search  »
Create feature from selection

Regenerator
BLAST Sequence

Back Translation

Back Translation allows you to obtain a DNA sequence from a protein sequence by
reversing the translation process. You can select from a list of translation and codon
usage table options
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2 Molecule Editor
Protein Domain and Motif Finder Analyses

1. With a protein molecule open, click on the Back Translation button in the

Analysis toolbar. "
Choose Table ”w
/@m
O Use Translation Table @ Use Codon Usage Table
Tranzlation Table Mﬁ\
Codon Usage Table
v
Translate into new Nuclectide

Back Translation Result:

M L H ki L L R R K A A~
ATG CTG AAC GTG CTG CTG AGG AGG AAG GCC

F © L ki T K K G M A
TTC TGC CTG GTG ACC AAG AAG GGC ATG GCC

T A T T A A A T H T
ACC GCC ACC ACC GCC GCC GCC ACC CAC ACC

P R L K T F K ki T R
CCC AGG CTG AAG ACC TTC AAG GTG TAC AGC

W H P D B P 5 A K P
v
< >

2. In the Back Translation Tool, select the translation table type: Use Translation

Table or Use Codon Usage Table.

3. Select the specific translation table from the dropdown list.

Note: For more information about translation and codon usage tables, visit
www.ncbi.nih.gov/Taxonomy/Utils/wprintgc.cgi?mode=c.

4. Select the Translate into new nucleotide checkbox to create a DNA/RNA
molecule from the resulting analysis.

5. Click on the Submit button.

If you selected the checkbox in step 3, you will be prompted to enter a name for the
molecule and save it to the database.

The results will be displayed in the Back Translation Result field.

Protein Domain and Motif Finder Analyses

You can analyze a protein sequence in Vector NTI® Express against databases of known
protein domains, families, functional sites, and motif fingerprints.

Protein Domain PROSITE and PRINTS are databases of biologically significant protein patterns and
g y s1g P p
ic— rofiles that can be used to identify the function of uncharacterized proteins.
Analysis—PROSITE P y P
and PRINTS Comparing an unknown polypeptide sequence in Vector NTI® Express to the motifs in

these databases can help determine any known protein families and domains to which

databases the sequence may belong.
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Protein Domain and Motif Finder Analyses

* For more information about the PROSITE database, visit http://
prosite.expasy.org/.

¢ For more information about the PRINTS database, visit www.bioinf.man.ac.uk/
dbbrowser/PRINTS/index.php.

Local versions of the PROSITE and PRINTS motif databases are provided as part of the
Vector NTI® Express installation.

1. To begin the analysis, with a protein molecule open, click on the Protein Domain
button in the Analysis toolbar of the Molecule Editor window.

2. Select the local version of the PROSITE or PRINTS database, installed with Vector
NTI® Express.

ProSite database (Local) |/ﬁq‘)
PRINTS Database (Local)

rrrl Klsh

3. In the Analysis Jobs window, the name of the job will appear listed in the left-
hand pane and the status will be “New submit...”

D Name AnalysisType | Description Status Medified Date
Patmatmotifs JE parmatmotiteanalysis of ADRALA Pstmstmotifs  Scans proteinsequen . ) Completed Mon D 05 08:3¢

Name: | ADCY7 |

w Patmatmotifs Parameters

[] Accession number  [] Description  [[] Full usa

Analysis Jobs

%

|~
|

4. Select the parameters that will be included with the results, then click on Submit.

5. When the analysis is complete, it will be listed in the left-hand pane as
“Complete.”

6. Double-click on the complete job to return to the molecule with the results
displayed in the Sequence pane and the Analysis Results.

Analysis Results O apcy? O =aDRAA 52 =7

= [}] Patmatmotifsinalysis of ADRAIA Q q C{
P! nt: 2

e Ee

[E3

Protein
b

Transmem_1  Source

[J Full USZ : Ne
[JHon Dec 05 08:38:07 BST 2011 ) ]

ADRAI1A J
499aa

v

>

|~

-

< B MUFLSGNASD SSNCTQPEAT VNISKATLLE VILGGLILFG VLGNILVILS VACHRHLHSV THYYTVNLAV ADLI
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Feature Map

Analysis Results

* C(lick on a feature in the Analysis Results pane to show expanded details for that
result.

* C(lick on a checkbox in the Analysis Results pane to show or hide that feature in
the Sequence pane.

* Right-click in the Analysis Results pane and select Save All Analysis Results to
Database to save these to Analysis Results in your local database.
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Motif Finder—
InterProScan

sequence search

54

* Analysis Results saved to the database will listed in the Database Explorer, under
Results in the Analysis Results folder.

E Results Name Analysiz Type Analysiz Object Name
Psc lysis of ADCYT at M... Pscan ADCYT
& Ij Local Databaze PzcanAnalysiz of ADCYT 3t M... Pscan ADCYT
] BLASTResults ) ) )
PatmatmotifsAnalysiz of AD... Patmatmotifs ADRALA
Analysis Results
lj PatmatmotifsAnalysiz of AD... Patmatmotifs ADCYT
£ Remote Database
(L. Database
@ HIEED General Description:
—
E Results

Motif Finder uses a local version of the InterProScan sequence search engine to scan a
protein sequence for protein domains and functional sites. This search tool integrates
analysis engines from multiple protein signature databases. Using this tool, you can
analyze a sequence using all InterPro analysis engines or a subset.

¢ For more information about InterProScan and the databases/analytical tools it
includes, visit www.ebi.ac.uk/Tools/pfa/iprscan/.

A local version of the InterProScan search engine is provided as part of the Vector
NTI® Express installation.

1. To begin the analysis, with a protein molecule open, click on the Motif Finder
button in the Analysis toolbar of the Molecule Editor window.

2. In the Analysis Jobs window, the name of the job will appear listed in the left-
hand pane and the status will be “New submit...”

Ay Jobis Name AnalysisType | Description Status Modified Date
L interProScanAnalysis of ADRALA InterFroscan  EMBLEBI Frotein Funct.. ©  Mew Submit WMon Dec 0 0% 47-28 PST 2
InterProScan Fr ysis of ADCYT P Scan a protein sequen \:) Completed Mon Dec 05 08:58:14 PST2.
g ysis of ADRATA 2 Scana protein sequen... ) Completed Man Dec 05 08:38:15 PST 2
Name ‘ ADRALA ‘ B Pscananalysis of ADCYT Pscan Scans proteinsequenc... ) Completed Mon Dec 05 08:59:28 PST2.
= Selectad Analytical Application
Applications
BlastProDom
FPrintScan

Gene3D
HAMAP
HMMPanther
HMMPfam
HMMPIR
HMMSmar:
HMMTigr
Patternscan
ProfileScan
[] signalprmm
[] superFamily
[#] TmHmMm

Usa Defaults
e

Analysis Jobs

3. Select the analytical application(s) to use from the available list of InterProScan
tools, then click on Submit.

Note: The more applications you select, the longer the analysis will take.

4. When the analysis is complete, it will be listed in the left-hand pane as
“Complete.”
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Protein Domain and Motif Finder Analyses

5. Double-click on the complete job to return to the molecule with the results

displayed in the Sequence pane and the Analysis Results.

* C(lick on a feature in the Analysis Results pane to show expanded details for that

result.

* Click on a checkbox in the Analysis Results pane to show or hide that feature in

the Sequence pane.

¢ Right-click in the Analysis Results pane and select Save All Analysis Results to
Database to save these to Analysis Results in your local database.

Analysis Results saved to the database will listed in the Database Explorer, under
Results in the Analysis Results folder.

E Results

Name

=E] Local Database
] BLASTResults
Ij Analysiz Results
£ Remote Database

E Database

@ Projects

E Results
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Psc lysis of ADCYT at M...
PatmatmotifzsAnalysiz of AD...
PatmatmotifzsAnalysiz of AD...
InterProScanAnalysis of ADR...

Analysiz Type
Pscan

Patmatmaotifs
Patmatmaotifs

InterProScan

Analysiz Object Name
ADCYT

ADRALA

ADCYT

ADRALA

iGeneral Description:
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Primer Design

This chapter describes the functions for designing primers and probes in Vector NTI®
Express, including settings for designing PCR primers, sequencing primers, and
hybridization probes. Vector NTI® Express can design primers for an entire DNA
molecule sequence or part of a sequence selected in the Molecule Editor window. After
selecting the target sequence, the maximum and minimum product length and
parameters are determined, and the software evaluates, rates and sorts several design
options. You can further fine-tune the oligos and annealing parameters if you wish,
save the primers or probes as separate molecules in the database or to the Oligo List,
order custom oligos from Life Technologies, or use the primers in recombinant cloning

strategies.
The following table summarizes the various primer/probe design options in Vector
NTI® Express:
Design Tool Purpose
Find PCR Primers Inside Specify limits for PCR primer search such as length of target
Selection sequence, output options, attach restriction sites, etc.
Amplify Selection Similar to Find PCR Primers except that primer hybridization

domains upstream and downstream from the target sequence
can be specified. Primers will be generated anywhere within
the designated upstream and downstream domains.

Sequencing primers Set parameters for sequencing and primer regions and
primer; analyze primers.

Hybridization Probes Set parameters for target region, output options; analyze
probes.

PCR Using Existing Oligos | Similar to Find PCR Primers, but, for the selected
amplification region, allows you to search for suitable PCR
primers from among those selected from the Vector NTI®
Express oligo list.

Open the primer/probe design tools

The design tools are located on the Molecule Editor toolbar.

1. With a molecule loaded in the Molecule Editor, you can design oligos for the
entire molecule sequence or a selected region:

— To design primers/probes for the entire molecule, make no sequence
selection before you open the design tool.

— To design primers/probes for a specific region of the sequence, select the
region (e.g., by dragging or clicking on a feature in the Graphics or Sequence
pane) and then open the tool.
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Save and load settings

2. Click on Primer Design in the toolbar and select from the dropdown list of design
tools:

Find PCR Primers Inside Selection
Amplify Selection

Sequencing Primers

Hybridization Probes

PCR Using Existing Cligos
Primer3

3. Each primer tool opens in a separate pane in the Molecule Editor window, with
the basic settings accessible in the pane. For advanced settings, click on the
Advanced button in the pane to open a separate dialog box.

Primer Design pane

Advanced settings

Save and load settings

The Save and Load buttons at the bottom of each pane (or at the bottom of each tab in
the Advanced settings dialog) allow you to save your primer/probe design settings to a
file and load the settings file for subsequent analyses. Design settings are saved as
*.per files.

This is useful for saving frequently used settings.

Run the design tool

After you have selected the desired settings (see the following pages for more details
about individual settings), click on Run in the primer design tool, or click on OK in the
Advanced settings dialog of the tool.

Primer/probe The primer or probe designs will be added as features in the molecule, and listed in the
design results Feature Map and displayed in the Graphics pane of the Molecule Editor (see
“Molecule features” on page 42).

Primer and probe designs are sorted in descending order in the Feature Map according
to their rating values calculated based on the importance factors assigned in the
Qualities tab (see page 69). The molecule region of each design is listed in parentheses.
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Run the design tool

The results are also listed under Analysis Results in the Molecule Editor window,
along with specific information about each oligo sequence.

Analysis Results

BN = cuencingorine:s |
=] I:‘Sequencing Primers:10Z8 to 1252
= I:‘Sequencing Domain §1: from 1028 to 1252
=[] ceTTTARACCCECTGATCAG
[Jee: s0.0
I:‘ Length: 20
[1site: 100z
[Qtm: 52,6 ¢
[Jae: -34.7 keal/mel
[Jas: -1553.3 keal/mel
[Jas: -412.1 calimel
[JTime: 1s/01/2012 22:18:21
[=-[E] HybridizaticnProbes
Hybridizatic:n Probes:1028-1252
[JTime: 1s/01/2012 23:38:21

Primer and probe designs are also be listed in the Ordering dialog, under Primers.

Save primer/ probe There are a number of ways to save primer/probe designs:

designs * Tosave them as Analysis Results in the database, right-click on a top branch in the
Molecule Editor Analysis Results pane and select Save All Analysis Results to
Database.

* To save them as oligos in the Oligos Database, right-click on a primer/probe
sequence in the Molecule Editor Analysis Results pane and select Save Primers to
Oligo Database.

¢ To add them to the Oligos List, right-click on a primer/probe sequence in the
Molecule Editor Analysis Results pane and select Add Primers to Oligo List.

Analysis Results

=[] SequencingPrimers
= I:‘ Sequencing Primers:10Z8 to 1252
= I:‘Sequencing Domain §1: from 1028 to 1252

=]

|

Collapse Branch

Add Primers to Oligo List
Save Primers to Oligo Database. ..
Save All Analysis Results to Database. ..

O
O
D Camera
O
O
O

[0 Time: 15|
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Find PCR Primers Inside Selection settings

Find PCR Primers Inside Selection settings

60

Select Find PCR Primers Inside Selection to design primers within a selected region
or the entire molecule for PCR amplification. With the molecule open in the Molecule
Editor, select the region to be sequenced, then select Primer Design > Find PCR
Primers Inside Selection from the Molecule Editor toolbar.:

The following are the unique settings for Find PCR Primers. These are also available
under the Primers tab if you click on the Advanced button:

Find PCR Primers
setting

Description

Region of Analysis

The start and end coordinates of the region to amplify. You can enter
new coordinates, or select a region of the sequence before opening
the tool to pre-populate the region coordinates.

Product Length

Enter the maximum and minimum lengths of the molecule target
region. Note: Unless you specify differently here, the minimum
amplicon length may be less than the target sequence you selected.

Maximum Number
of Primers

Enter the number of sense-antisense primer pairs to be found. The
actual result may contain fewer than this number if there are not
enough possible primers.

Analysis Conditions settings

Click on the Analysis Conditions dropdown to access these settings:

Analysis Conditions
setting

Description

DNA/RNA radio button

Select the type of target nucleotide sequence.

Salt Concentration

Enter the PCR reaction salt concentration in mMol, if known.

Probe Concentration

Enter the value of probe concentration in pMol, if known.

dG Temperature

Enter the temperature in degrees Celsius to be used for
calculating free energy values.
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Amplify Selection settings

Analysis Conditions

setting Description

Tm Enter limits in degrees Celsius for primer melting temperature
(T,,) (temperature at which 50% of primer is a duplex) and the
difference between T,,, for sense and antisense primers.

%GC Enter the limits of G/C percentage in the primer and the difference
between GC percentages for sense and antisense primers.

Length Enter primer length limits. Note: Nucleotide sequences such as
RENSs attached to a primer’s 5" end are included when calculating
primer length.

Note: The calculation for Tm is dependent on primer and salt concentrations; varying
these concentrations can greatly affect the Tm for any given primer. Make sure to
adjust these parameters according to your reaction conditions when performing your
PCR analysis to ensure that you obtain accurate Tm values.

Attach to 5" Terminus settings

Click on the Attach to 5" Terminus dropdown to access these settings

Attach to 5’

Terminus setting LB A

Attachto 5 Terminus | Enter a short (=/<18 bp) nucleotide sequence [if any) to be attached

of Sense Primer to the 5" end of either primer. To choose from recognition sites of
and/or Antisense database RENSs, click the Browse button next to each field.
Primer

Note: This sequence, while considered in primer parameters, does
not affect the calculation of complementarity between primer and
molecule. A sequence can be attached to the primer whether or not
the primers are user-defined or designed by the software.

Advanced settings: Primers tab

Click on the Advanced button below the main settings to open the Advanced settings
dialog. Under the Primers tab, the settings described above are listed, in addition to the

following:
Advanced Primers -
. Description
setting
User-Defined Enter user-defined primer sequences or a primer from the oligo
Primers database. The search engine checks the compatibility of the primers
according to primer parameters.

Additional advanced settings are described in “Shared Advanced settings” on page 66

Amplify Selection settings

Select the Amplify Selection primer design tool to amplify an entire selected region of
a molecule. With the molecule open in the Molecule Editor, select the region to be
sequenced, then select Primer Design > Amplify Selection from the Molecule Editor
toolbar.

Vector NTI® Express Software User Guide 61



62

Primer Design
Amplify Selection settings

These settings are similar to the Find PCR Primers settings except that you can specify
primer hybridization regions upstream and downstream of the target sequence.

Amplify Selection picks primers to amplify the entire selection. If suitable primers
cannot be found inside the selected region, the search will expand within the specified
upstream and downstream flanking regions.

The following are the unique settings for Amplify Selection. These are also available
under the Primers tab if you click on the Advanced button:

Amplify Selection
setting

Description

Amplicon Must
Include Region of
Molecule

Set the 5" and 3’ positions for region of the molecule that must be
included in the final amplified product.

Max bp before
selection

Provides additional upstream region where the Primer may be
made.

Max bp after
selection

Provides additional downstream region where the Primer may be
made.

Analysis Conditions settings

For information about the Analysis Conditions settings, see page 60.

Attach to 5" Terminus settings

For information about the Attach to 5" Terminus settings, see page 61.

Advanced settings: Primers tab

Click on the Advanced button below the main settings to open the Advanced settings
dialog. For information about the Advanced settings on the Primers tab, settings, see

page 61.

Additional Advanced settings

Additional advanced settings are described in “Shared Advanced settings” on page 66
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PCR Using Existing Oligos settings

PCR Using Existing Oligos settings

Select PCR Using Existing Oligos to search for suitable PCR primers from among
those in the Vector NTI® Express Oligo Database. With the molecule open in the
Molecule Editor, select the region to be sequenced, then select Primer Design > PCR
Using Existing Oligos from the Molecule Editor toolbar.

These settings are similar to the Find PCR Primers settings with a few exceptions. The
following are the unique settings for PCR Using Existing Oligos. These are also
available under the Primers tab if you click on the Advanced button:

PCR Using Existing

Oligos setting e Sl

Sense Primers Click the Sense Primers button and select the desired primer(s)
from the Oligo Database.

Antisense Primers Click the Antisense Primers button and select the desired primerf(s)
from the Oligo Database.

Note: Since you can choose the number of 3" and 5" primers, these settings effectively
enable you to analyze one 3’ primer against an array of 5 primers or vice-versa.

Analysis Conditions settings
For information about the Analysis Conditions settings, see page 60.

Attach to 5" Terminus settings
For information about the Attach to 5" Terminus settings, see page 61.

Advanced settings

Click on the Advanced button below the main settings to open the Advanced settings
dialog. Advanced are described in “Shared Advanced settings” on page 66
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Sequencing Primers settings

Sequencing Primers settings

64

Select Sequencing Primers to find primers for sequencing a DNA molecule fragment.
With the molecule open in the Molecule Editor, select the region to be sequenced, then
select Primer Design > Sequencing Primers from the Molecule Editor toolbar.

Primers will be generated anywhere within the designated “Primer Hybridization
Domain” (upstream and downstream).

If the sequencing region is long enough, it is divided by Vector NTI® Express into
smaller sequencing domains, areas in which a single sequencing reaction will take
place. The size of the primer hybridizing domain may then be set, as well as other
primer parameters. Several primer options are evaluated and sorted from best to

worst.

Note: Sequencing primers are designed for a sequence region, not an entire molecule.

The following are the unique settings for the Sequencing Primers tool. These are also
available under the Primers tab if you click on the Advanced button:

Sequencing
Primers setting

Description

Sequencing Region

Region that you want to sequence. Enter the start and end
coordinates of the region to be sequenced.

Sequencing Domain

Enter the number of bases to be sequenced in a single sequencing
reaction.

Primer Hybridization
Domain

Enter the length of region where primers for each sequencing
domain should be sought. Primers are generated within the set
domain.

Maximum Number

Enter the number of primers to be found for each sequencing

of Primers domain. (The actual result may contain fewer primers than this
number if there are not enough possible primers.)

DNA/RNA Select the type of nucleotide sequence.

Complementary Select if you are sequencing the complementary strand.

Strand
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Hybridization Probes

Sequencing L.

Primers setting e Sl

User-Defined First Enter a user-defined nucleotide sequence to be evaluated as a

Primer primer for the FIRST sequencing domain, instead of leaving the
primer search to Vector NTI® Express Software.

Analysis Conditions settings
For information about additional Analysis Conditions settings, see page 60.

Advanced settings

Click on the Advanced button below the main settings to open the Advanced settings
dialog. Advanced settings are described in “Shared Advanced settings” on page 66.

Hybridization Probes

Select the Hybridization Probe settings to find oligonucleotides that will hybridize to
a selected molecule sequence. Vector NTI® Express can generate a set of oligos or use
user-defined or database-stored oligos to test for hybridization efficiency with a target
molecule.

With the molecule open in the Molecule Editor, select the hybridization region, then
select Primer Design > Hybridization Probes from the Molecule Editor toolbar.

The following are the unique Hybridization Probes settings. These are also available
under the Primers tab if you click on the Advanced button:

Hybridization

Probes setting LB A

Search Region Region for which you want to design the probe. Enter the start and
end coordinates.

Maximum Number Enter the number of probes to be found for the region. (The actual

of Output result may contain fewer probes than this number if there are not
enough possible designs.)

DNA/RNA Select the type of nucleotide sequence.
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Hybridization

Probes setting LS

Complementary Select if you are sequencing the complementary strand.

Strand

User-Defined Oligo Enter a user-defined nucleotide sequence to be evaluated as a probe
instead of leaving probe search to the software.

Analysis Conditions settings

For information about additional Analysis Conditions settings, see page 60.

Advanced settings

Click on the Advanced button below the main settings to open the Advanced settings
dialog. Additional advanced settings are described in “Shared Advanced settings” on
page 66.

Shared Advanced settings

Click on the Advanced button below the main settings to open the Advanced settings
dialog. The following Advanced settings are the same for all the primer/probe design
tools.

Amplicon tab

Click the Amplicon tab to customize parameters relating to the resulting PCR product.
%GC content for the product or a portion of the product and allowed bases adjacent to
the primer annealing site can be specified.:

Amplicon setting Description

Amplicon %GC Enter the minimum and maximum for the desired %GC content in
the PCR product.

Next to Primer Choose accepted bases for the four successive bases adjacent to the

Annealing Site primer annealing site. Set minimum and maximum %GC range for
a specified length of the amplicon adjacent to the primer annealing
site.

Structure tab

Click the Structure tab to set acceptable limits for nucleotide repeats, palindromes and
hairpin loops for the primers. You can also check your primers/product for a selected
group of restriction sites from this tab.

Structure setting Description

Nucleotide Repeats Enter the maximum permitted length of nucleotide repeats in
primers.

Palindromes Enter the maximum permitted length of palindromes in primers.
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Structure setting

Description

Hairpin Loops

Stem Length: Enter the minimum number of base pairs in a
hairpin stem. (This value is also used as a minimum stacking
length for primer-primer complementarity and primer-primer 3’
end complementarity.) Permitted with dG: Check the Permitted
box for hairpin loops; enter the minimum permitted value for free
energy of hairpin loops. Primers with hairpin loops which have
free energy values > /= to this number will be accepted.

Check Hairpin Loops,
Palindromes,
Nucleotide Repeats
and Dimers Only Within
3" Region of ...

Check this box and enter the length of a 3’ region if all of a
primer’s features (repeats, palindromes, hairpin loops, dimers)
should be checked only within that 3’ region.(If this box is empty,
the whole primer will be evaluated.)

Check Primers For

Check to find possible cloning sites inside primers and attached

Restriction Sites From | nucleotide sequences (if any). In the drop-down menu, specify the
REN subset. Enzymes will be checked for the presence of their
sites in the primers and attached sequences, and within the PCR

product.

Pairs tab

Click the Pairs tab to specify how closely parameters such as Tm and %GC, etc. must
match between two primers in a generated primer set.

Pairs setting Description

Tm Difference Enter difference in degrees Celsius between T,,, for sense and

antisense primers.

%GC Enter the difference between GC percentages for sense and

antisense primers.

Primer-Primer
Complementarity

Check the Permitted box for primer-primer complementarity;
enter the minimum permitted value for duplex free energy.

Primer-Primer 3" End
Complementarity

Check the Permitted box for primer-primer 3" end
complementarity; enter the minimum permitted value for duplex
free energy.

Similarity tab

Click the Similarity tab to determine the similarity relationship between the primers
and the target sequence.

Similarity setting Description

Best Fit Check this button to specify the search for site(s) with maximum

similarity with no set threshold.

With Similarities > =
Similarity Threshold

Similarity Threshold

Check this button to indicate similarity site search above the
specified similarity threshold.

Enter the percentage of minimally acceptable similarity.

Last ... Nucleotides
Must Have 100%
Similarity

Check and specify the number of nucleotides necessary to have
100% complementarity with the target sequence at the 3" end.
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Similarity setting Description

Specifies acceptable similarity between ambiguous nucleotides (if
any). The Average, Minimum, and Maximum buttons indicate that
the average, minimum, and maximum possible similarity will be
calculated respectively for any nucleotide pair. For instance, if you
are calculating similarity between N and A, then the average
similarity is 25%, the minimum similarity is 0%, and the maximum
similarity is 100%. In case of R and A they are 50%, 0%, and 100%;
in case of R and T—0%, 0%, and 0%.

Similarity Between
Ambiguous
Nucleotides

The similarity table used by Vector NTI® Express is as follows:

N-N N-R N-A R-W R-A R-T
Maximum 100 100 100 100 100 0
Average 25 25 25 25 50 0
Minimum 0 0 0 0 0 0
3" End tab

Click the 3’ End tab to set specifications for the 3" end of the primers generated by
Vector NTI® Express. Parameters such as dG and specific nucleotide content for the 3’
end of both sense and antisense primers can be set here.

3’ End setting Description

dG <= Specify the maximum permitted value of 3" end free energy.

Length for Analysis Enter the length of the primer’s 3’ region that should be analyzed.

Sense Primer 3’
Nucleotides

Check the nucleotide boxes to specify permitted last primer
nucleotides for the sense primer.

Antisense Primer 3’
Nucleotides

Check the nucleotide boxes to specify permitted last primer
nucleotides for the antisense primer.

Uniqueness Tab

Click the Uniqueness tab to select settings to determine the uniqueness of the
generated primers. These parameters can be used to help ensure that generated
primers bind to the desired template area with greater specificity than to the rest of the
PCR product.

Uniqueness tab

setting Description

Uniqueness Checks for | Choose the area of the molecule to check for primer uniqueness.
Either the entire molecule or the Amplicon only can be selected
for the uniqueness check.

Max Allowed Similarity | Check this box and enter the similarity threshold to check primer
uniqueness on the molecule. Primers which have parasitic
hybridization with similarity > /= this threshold will be rejected.
Note: this similarity threshold must be </=the minimum similarity
required for hybridization of user-defined primers (if any).

Max Consecutive Match | Check this box and enter the maximum acceptable match of
for Entire Primer consecutive bases for the entire primer and the Amplicon.
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Uniqueness tab

setting Description

Primer 3" End Check the first box and enter the number of consecutive 3" bases
that must match the amplicon with 100% similarity. Check the
second box and specify the maximum acceptable % match
between the Amplicon and the designated number of bases on the
3" end of the primer.

Qualities tab

Click the Qualities tab to set parameters that govern primer quality by determining
how much weight should be assigned to the parameters on other tabs. These values
affect scoring functions that evaluate the quality rating of the primer sets generated.

The importance factors are integers between 1 and 10 used in calculating the score
evaluating primer/oligo quality. The lower the factor, the less weight given in the
calculation. For example, for minimal importance, enter 1 in the appropriate box. For
maximum importance, enter 10.
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BioAnnotator

BioAnnotator is a sequence analyzer that performs certain types of DNA/RNA
sequence analyses and displays the results as linear graphics.

Launching BioAnnotator

To open BioAnnotator:

¢ Right-click on a DNA/RNA molecule in the Database Explorer and select
Bioannotator, or

¢ With a molecule open in the Molecule Editor, click on the Bioannotator
button on the right-side toolbar. L/_:

The BioAnnotator window contains three panes: a Sequence Info pane, Graph
pane, and Sequence Pane.

Selecting an analysis

In the Sequence Info pane:
1. Select the graph to display from the Select Graph dropdown list.

2. Select any additional settings for the specific graph (see Analysis parameters on
page 72).

3. Click on Refresh Graph to display the graph.
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4 BioAnnotator
Graph and Sequence panes

Graph and Sequence panes

Highlight sequence
region in the graph

Magnify the graph
Determine the

value at a point in
the graph

The graphs in BioAnnotator display physiochemical properties of the DNA molecule.
The Graph pane consists of the graphical analyses region: a vertical (Y) axis, showing
minimal and maximal values of analysis results, and an individual horizontal (X) axis
displaying numerical positions in the sequence, scrollbars, and the legend that
displays the name of each analysis.

At any point along the sequence (X-axis), the value (Y-axis) for the property is derived
not just from the specific base at that point, but from adjacent bases as well. For each
property, the algorithm determines the optimum window of adjacent bases to be
considered when calculating the value for a point. For instructions in modifying the
Window Size parameter, see Window size on page 73.

To highlight a particular data region, drag your cursor in the Graph or Sequence pane
and the corresponding region will be highlighted in both panes.

In Windows, click in the Graph pane and use the mouse wheel to change the
horizontal scale of the graph to zoom in on particular features. A scroll bar will appear
below the graph as you magnify.

To determine the value at a particular point on the graph, hold your cursor over the
bar in the graph at that point. A popup number will be displayed, reflecting the value
at that point.

If you have magnified the graph and highlighted a region in the sequence, you can see
the value calculated for that specific region.

GC Content (%)

Note: The Window Size parameter described below means that there is not necessarily
a 1:1 correlation between a particular base or small group of bases in the sequence and
a value in the graph. Due to physiochemical interactions within a sequence, each
analysis algorithm necessarily calculates graph values from a “window” of
surrounding data points.

Analysis parameters

72

The following parameters and setting are available in the Sequence Info pane.
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Analysis parameters

Window size All the graphs have a Window Size parameter. This is the number of adjacent data
points used in averaging values for each displayed data point, and the optimal value is
analysis dependent. The default window size has been optimized based on the
selected analysis, but this value can be changed. You can experiment with different
window sizes and their effect on the resulting graph by entering a different number in
this field.

After any change, click on Refresh Graph.

Analyses Melting temperature and free energy are calculated using the “nearest neighbors”
descriptions and method. For constants and algorithms used to calculate thermodynamic parameters,
parameters see Appendix B.

The available DNA/RNA analyses and their specific parameters are:
* Free Energy (dG) (kcal/mol)

— This can be recalculated for a different temperature by entering a new value
in the Temperature field ( °C).

* Melting Temperature (GC Content) ( °C)

— This can be recalculated for a different Salt Concentration (mMol) and %
Formamide of the solution by entering new values in the appropriate fields.

* Sequence Complexity
e GC Content (%)
¢ Nucleic Acid Distribution (%)

— Select the bases for which you want to calculate the percent distribution
using the checkboxes under Sequence includes.

* Melting Temperature (Thermodynamic) ( °C)

— This calculation is dependent on the Salt Concentration (mMol) and %
Formamide of the solution, as well as the concentration of any probe in the
solution (Probe Concentration in pMol).

¢ Entropy (dS) (cal/K/mol)
¢ Enthalpy (dS) (kcal/mol)

After any change, click on Refresh Graph.
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Regenerator

The Regenerator application in Vector NTI® Express Software enables you to back-
translate a DNA sequence from a protein sequence, or modify an existing DNA
sequence for a given expression system. You can introduce mutations such as
insertions, deletions, and substitutions, or modifications like restriction or Gateway®
sites, in the back-translated DNA sequence, which can then be optimized for a specific
expression system.

Regenerator Workflow

1. Load a protein or DNA sequence into Regenerator from the Molecule Editor.

2. If desired, introduce insertions, deletions, or substitutions into the sequence.

3. Select the desired expression system.

4. If desired, add attachments relevant to downstream cloning to the back-translated
DNA sequence.

5. Save the newly created DNA sequence as a molecule in the database and/or send
it for synthesis.

Open Regenerator

To launch Regenerator:
1. Load a protein or DNA molecule into the Molecule Editor.
2. Select part of the sequence or make no selection to select the entire sequence.

3. Right-click in the Graphics pane and select Regenerator or click on the
Regenerator button in the Molecule Editor toolbar. =
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Regenerator tool features

The Regenerator tool will open.

Regenerator tool features

The Regenerator tool has two main sequence panes, as well as various controls for
editing the sequence:

* The top pane contains the input amino acid sequence or DNA sequence and is
editable, allowing you to add or delete amino acids or bases directly in the
sequence.

* The middle pane contains the in silico DNA sequence generated from the
mutations selected or entered in the tool.

Create mutations in the input sequence

You can insert, delete, or substitute amino acids (for proteins) or bases (for DNA) in the
input sequence directly.

¢ To insert amino acids or bases, place your cursor upstream of the insertion point
and type in your desired changes.
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Optimize the expression system and genetic code

* To substitute one or more amino acids or bases, highlight the desired part of the
input sequence and type in your desired changes.

¢ To delete part of the input sequence, highlight the sequence and use the Delete or

Backspace key.
Protein to be Exprezsed
1 MVFLSGNASD SSNCTQPPAP VNISERILLG VILGGLILFG VLGENILVILS VACHRHLHSY THYYIVNLAV ADLLLTSTVL
101 TIWARVDVLCC TASIMGLCII SIDRYIGVSY PLRYPTIVIQ REGIMALLCYV WALSLVISIG PLFGWRQPAP EDETICQINE
201 LVMYACRVYV VAERESRGLE SCGLETDESDS EQVILRIHRE NAPRGGSGMIL SRETETHFSV RLLEFSREEE RRETLGIVVE
301 DFEPSETVFE IVEWLGYLNS CINPIIYPCS SQEFEERFQN VLRIQCLRRE QSSEHRLGYT LHPPSQRVEG QHEDMVRIEV
401 FSSMPRESRAR ITVSEDQSSC TTARTESRSV TRLECSGMIL RHCNLRLPGES RDSPASRSQR AGTIGDVEPE RREHQRQLIFV
£ >

To make Mutations:
Substitutions - Highlight the amine acid(s) and type in your changes

Deletions - Highlight the amino acid|z) and use Delete or Backspace key
Mote: Deletions will not marked in the protein sequence

Insertions - Place your cursor upstream of the insertion point and type in your changes Refresh DNA Sequence ] [View Mutant Protein

Click the Clear all Mutations and Attachments to remove mutations and restore the
original sequence.

Clear mutations

The View Mutant Protein/DNA button is enabled once any mutation is introduced
into the input sequence pane. Click this button to view the mutated protein or DNA
sequence in the Molecule Editor.

View the mutated
sequence

The protein is given a name using the following convention VNTI_<Protein
Name>_mutated.

To update the In Silico DNA Sequence pane with any mutations, click on the Refresh
DNA Sequence button.

Refresh the in silico
DNA sequence

In Silico DNA Sequence

Expression system:

Escherichia coli K12 ¥ Genetic Code | UNIVERSAL ¥
1 CACCTGCATG GIGITICIGR GCEECARCEC GAGCGATAGC ARGCRRCTGCR CCCRECCGECC GGECECCEETE  RRCATTRC A
GTEEACETAC CRCRRRGACT CGECCEITECG CTCGCTATCE TCEITGEACGET GGEETICEECEE  CCECEECCRC  TTIGTRRTC
+1 I 5 G G 5 | 5 F G V S G N | 5 v | 5 5V A C H R H S
101 ATICTGEECE GCCIGATICT GITIGECGTIG CIGEGCRRCE TICIGETGRT TCTIGAGCGIG GCGEIGCCRIC GCCRTICTC
TRRGRCCCEC CGEACTRRGR CRRACCGCAC GRCCCEITET ARAGRCCACTR AGRCTCGCAC CECRCGGTRG CGETRGAC
+1 I v N 5 AV A D 5 & 5 T =& T v 5 P F 5 A | F E 5 G
- —+—+ —t—+— +—+—+— —+—+ —t—+— +—+—+— —+—+ +—+—+ ¥
< >

Optimize the expression system and genetic code

* Select the desired Expression system from the dropdown list. The in silico DNA
sequence will automatically update based on an internal codon usage table for the
expression system in Vector NTI® Express.

* Select the desired Genetic code from the dropdown list. The in silico DNA
sequence will automatically update based on the selection.

Add attachments

You can add the following attachments to the 5" and 3’ ends of the in silico DNA
sequence:
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Generate a new sequence and send for synthesis

Note: The 3’ end attachment will always be the Reverse Complement of the sequence
displayed in the attachments dialog box.

Add Attachment to In Silico DNA Sequence

@AddtDE'Terminus OAddtDE'Terminus

Restriction Site Aarl - cacctge hd

Gatewsy Site attB1 - ACAAGTTTGTACAAAAAAGCAGGCTTA ¥

Add Attachment(s) [Mote: Attachments are not optimized for expression)

¢ Select the Restriction Sites checkbox and then select from the dropdown list to
add a restriction site to the selected end(s) of the in silico DNA sequence. The
selected Restriction Site appears in the DNA sequence pane at the 5 and 3’ end,
based on your selection.

* Select the Gateway® Sites checkbox to add attB sites for Gateway® cloning to the
back translated molecule. In the Choose attB Extension dialog box that appears
based on the terminus you have selected (5" or 3’), select a fragment from the list
and click OK. The selected Gateway® site appears in the DNA sequence pane at
the 5’ or 3’ end, based on your selection.

* Select the User Defined checkbox to add special sequences (promoter, tags, etc.)
to the back translated molecule. Enter the sequence in the field; the The sequence
will appear in the DNA sequence pane at the 5’ or 3’ end, based on your selection.

Note: The attachments made to the DNA sequence will not appear in the protein
sequence pane.

Clear attachments Click on Clear All Mutations and Attachments to clear all attachments and restore the
original sequence.

Generate a new sequence and send for synthesis

¢ Click on View In Silico DNA to open the newly created DNA molecule in the
Molecule Editor You can then save the molecule, and copy and submit the
sequence for synthesis as described below.
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Generate a new sequence and send for synthesis

* C(lick on the Go to Gene Synthesis button to go to the Life Technologies
GeneArt® gene synthesis service website. There you can create an account and
submit the in silico DNA sequence for synthesis.
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BLAST search

Open the BLAST
search tool

BLAST search
settings

BLAST and Entrez Searches

Vector NTI® Express Software includes the search engines BLAST and Entrez Query for
querying sequences.

BLAST (Basic Local Alignment Search Tool) is a search engine for exploring available
public sequence databases for DNA or protein sequence similarities to a query
sequence. BLAST programs have been designed for speed, with a minimal sacrifice of
sensitivity to distant sequence relationships. BLAST scores have a well-defined
statistical interpretation, making real matches easy to distinguish from random
background hits. BLAST uses a heuristic algorithm that seeks local as opposed to
global alignments and is therefore able to detect relationships among sequences that
share only isolated regions of similarity.

For detailed information on BLAST search types, settings, parameters, search
databases, etc., visit http://blast.ncbi.nlm.nih.gov/Blast.cgi.

e To BLAST search an entire molecule in the database:

— Select the molecule in Database Explorer, right-click, and select BLAST
Search.

— Open the molecule in the Molecule Editor and click on the BLAST button on

the main toolbar.

* To BLAST search part of a sequence, open the sequence in the Molecule Editor,
select the desired part of the sequence in the Graphics or Sequence pane, and
right-click to select BLAST sequence.

¢ To open a blank BLAST search window and type and paste a sequence directly
into the tool, click on the BLAST button on the main toolbar without selecting a
molecule first.

The BLAST search tool settings are displayed in the right-hand pane of the tool; the
results of a search are displayed in the left-hand pane.

Select the following settings to define your search:

Program

In the Program dropdown menu, specify the type of database search to be performed:

blastn Compares a nucleotide query sequence against a nucleotide sequence
database.
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BLAST search

blastp

Compares an amino acid query sequence against a protein sequence
database.

blastx

Compares a nucleotide query sequence translated into all reading frames
against a protein sequence database.

tblastn

thlastx

Compares a protein query sequence against a nucleotide sequence
database dynamically translated in all six reading frames (both strands).

' Compares the six-frame translations of a nucleotide query sequence

against the six-frame translations of a nucleotide sequence database. 7Ais
program cannot be used with the nr database.

Algorithm

In the Algorithm drop-down menu, specify the type of algorithm search to be
performed. In addition to blastn and blastp, algorithm searches include:

megablast

PHI blast

Concatenates many queries to save time spent scanning the database. It
is optimized for aligning sequences that highly similar and is up to 10
times faster than more common sequence similarity programs. It can be
used to quickly compare two large sets of sequences against each other.
MEGABLAST permits searching with batches of ESTs or with large cDNA
or genomic sequences.

Pattern Hit Initiated BLAST. A program for searching a protein database
using a protein query; it seeks only alignments that preserve a specified
pattern contained within the query.

PSI blast

Position Specific Iterated BLAST. A program for searching protein
databases using protein queries to find other members of the same
protein family.

Database

In the dropdown list, select the GenBank database to query:

Menu item

Description

nr/nt

Peptide Sequence Database: All non-redundant GenBank
sequences and CDS translations.

Nucleotide Sequence Database: All GenBank+EMBL+PDB
sequences (no EST, STS, GSS or phase 0, 1 or 2 HTGS sequences).
No longer non-redundant.

Refseq RNA

Human Genome BLAST databases: human RefSeq mrna with
NM_#### or XM_#### accessions

Refseq Genomic

Human Genome BLAST databases: human genomic contig
sequences with NT_#### accessions

Chromosome

Nucleotide Sequence Database: complete chromosomes

EST

Nucleotide Sequence Database: EST (Expressed Sequence Tags)—
mouse and human.

EST-others

Nucleotide Sequence Database: EST (Expressed Sequence Tags]—
other than mouse and human.

82

Vector NTI® Express Software User Guide



BLAST search n

Menu item Description

GSS Nucleotide Sequence Database: Genome Survey Sequence,
includes single-pass genomic data, exon-trapped sequences, and
Alu PCR sequences.

HTGS Nucleotide Sequence Database: Unfinished High Throughput
Genomic Sequences.

PAT Protein sequences from the Patent division of GenBank.

PDB Peptide Sequence Database: Saccharomyces cerevisiae protein

sequences—genomic CDS translations.

Nucleotide Sequence Database: Saccharomyces cerevisiae
genomic nucleotide sequences.

Alu repeats Peptide Sequence Database: Translations of select Alu repeats
from REPBASE.

Nucleotide Sequence Database: Select Alu repeats from REPBASE.

DBSTS Nucleotide Sequence Database: Database of
GenBank+EMBL+DDBJ sequences from STS Divisions.

ENV-NT

Limit by Entrez Query

This checkbox lets you limit the BLAST search to the results of an Entrez query against
the database chosen. This can be used to limit searches to subsets of the BLAST
databases.

Select the checkbox and in the field below enter terms that would normally be allowed
in an Entrez search session. For example:

protease NOT hivl[Organism] — this form of a search will limit the search to all
proteases, except those in HIV 1.

biomol_mrna[PROP] AND brain — this form of a search can be used to limit searches
to a particular molecule type

Mus musculus[Organism] — this form of a search will limit the search to a specific
organism. Enter the name of the organism in the Entrez Query field with the
[Organism] qualifier.

General Parameters

The parameters here are almost identical to parameters for the various BLAST searches
at the NCBI website. For more information regarding these parameters, visit http://
www.ncbi.nlm.nih.gov/blast/html/blastcgihelp.html.

Max target sequences —The maximum number of aligned sequences to display.

Expect threshold —The statistical significance threshold for reporting matches against
database sequences. The default value of 10 means that in a database of the current
size, 10 matches would be expected merely by chance (stochastic model of Karlin and
Altschul, 1990.) Hits showing a statistical significance greater than the Expect
threshold are not reported. Increasing the E value above 10 produces a larger list with
more low-scoring hits (chance matches). Lower expectation value thresholds are more
stringent, leading to fewer chance matches being reported.
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If your query peptide or nucleotide sequence is short, you might want to increase the
Expect value. Because a short query is more likely to occur by chance in the database,
even a perfect match can have low statistical significance and may not be reported.
Increasing the E value lets you look farther down the hit list and see matches that
would normally be discarded because of low statistical significance.

Word size —Word size is roughly the minimal length of an identical match an
alignment must contain if it is to be found by the algorithm. Mega BLAST is most
efficient with word sizes 16 and larger, although word size as low as 8 can be used. If
the value W of the word size is divisible by 4, it guarantees that all perfect matches of
length W + 3 will be found and extended by Mega BLAST search, however perfect
matches of length as low as W might also be found, although the latter is not
guaranteed. Any value of W not divisible by 4 is equivalent to the nearest value
divisible by 4 (with 4i+2 equivalent to 4i).

Scoring Parameters

* Match/Mismatch Scores—Reward and penalty for matching and mismatching
bases. Many nucleotide searches use a simple scoring system that consists of a
“reward” for a match and a “penalty” for a mismatch. The (absolute) reward/
penalty ratio should be increased as one looks at more divergent sequences. A
ratio of 0.33 (1/-3) is appropriate for sequences that are about 99% conserved; a
ratio of 0.5 (1/-2) is best for sequences that are 95% conserved; a ratio of about one
(1/-1) is best for sequences that are 75% conserved.

* Gap costs—The penalty to open a Gap and penalty to extend a Gap. Increasing
the Gap Costs decreases the number of Gaps introduced in the alignment.

Filters

* Low-complexity —This filter masks off segments of the query sequence that have
low compositional complexity (as determined by the SEG program of Wootton &
Federhen, Computational Chemistry, 1993). Regions with low-complexity
sequence can create problems in sequence similarity searching by producing
artificial hits, sequences that are not truly related. Such hits can produce high
scores because of the presence of low-complexity regions.

¢ Human Repeats—This option masks Human repeats and is especially useful for
human sequences that may contain these repeats.

* Mask for Lookup —This option masks only for purposes of constructing the
lookup table used by BLAST. The BLAST extensions are performed without
masking.

* Mask lower case characters —With this option selected you can cut and paste a
FASTA sequence in upper case characters and denote areas you would like
filtered with lower case. This allows you to customize what is filtered from the
sequence during the comparison to the BLAST databases.

1. To perform the search, click on Submit.

2. The search progress will be displayed left-hand pane of the BLAST search viewer.
When the search is complete, the search will be flagged as Complete.

3. Right-click on the search result and select from the following options:
— Save to Local Database —saves the search in the local database.

— Save as tab delimited file—save as a text file.
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— Edit search—change the search parameters and re-Submit.
— Delete BLAST job—clears the results from the list.

Request D Status Databaze Tool Query Length Hit Count Date/Time

i Bt Menoecosisosoarerasit |

Save to Local Database
Save as tab delimited file
Edit search

Delete BLAST job

4. Double-click on the search result to open the result in the BLAST Result Viewer.

Note: BLAST results that have been saved to the database may be opened in Database
Explorer; click on Results and open the BLAST Results folder.

BLAST Result Double-click on a BLAST search result in Database Explorer or the BLAST tool to open
Viewer the result in the BLAST Result Viewer.
Table pane

Graphics pane

Sequence pane

The Viewer contains three main panes:

* The Table pane displays a textual list of query “hit” molecules for the sequence
¢ The Graphics pane displays the corresponding sequence of each hit in graphical
form

* The Sequence pane displays the Query sequence, “hit” sequence (with Accession
number), and Consensus sequence

Click on a row in the Table pane or a feature in the Graphics pane to display the
corresponding sequence in the Sequence pane.

Table pane columns
¢ E-Value: This value reflects the likelihood that the similarity between the
sequences would occur by chance when searching a database of a particular size.
A zero or extremely low number suggests that the match is so perfect that it is
extremely unlikely that the similarity would occur randomly.

¢ Name: The NCBI sequence identifier of the query hit.

* Accession: The GenBank Accession number of the hit.

* Bit Score: A measure of how close the identity of the match is to the query
sequence.

¢ Identity: The ratio (and percentage) of matching residues in the hit elements. The
numbers n/n refer to the number of identical residues out of the number of
matches in the hit element. This is important to consider when determining the
significance of this statistic. A high identity percentage may mean nothing if a low
number of nucleotides is being compared.
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* Positives: the ratio (and percentage) of similar residues in the hit elements

* Query From/To/Orientation: The start and end position numbers in the query
sequence matching that of the hit element, and the strand that corresponds to the
hit element.

¢ Hit From/To/Orientation: The start and end position numbers in the hit sequence
matching that of the query element, and the strand that corresponds to the query
element.

Download sequence features and save them as molecules

In the Table pane, click on the link in the Name column to download the sequence and
database information for that query molecule from the NCBI database and save it as a
separate molecule in Vector NTI® Express Software. The database information for the
sequence will be populated in the Properties of the created molecule.

Note: You will be prompted to submit your email address when connecting to the
NCBI database.

You can use the NCBI Entrez cross-database search engine directly from Vector NTI®
Express Software. For more information about this search engine, visit
www.ncbi.nlm.nih.gov/sites/gquery.

Note: An Internet connection is required to perform this search.

To perform an Entrez search, click on the Public Database Search button on the main

toolbar.

The Entrez search tool will open.

&, Entrez Query RequestID Status Database searchTerm Date[Time

Database |protein v

searchTerm | orolactin

Pagesizz= |10

~ Search Builder

AND w| | AllFiglds v

Entrez Query

poap)

BLAST

The Entrez search tool includes the following panes:

* Query pane—Contains settings for formulating a query.
* Query List pane— Lists the status of each query request.
* Results pane—Displays the results of a query.
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The Entrez search engine allows you to search across a wide variety of NCBI
databases.

1.

To begin, select the desired NCBI database from the Database dropdown list:

PubMed: A database of biomedical literature citations and abstracts from
MEDLINE, life science journals, and online books

Gene: Wide-ranging database containing nomenclature, Reference
Sequences (RefSeqs), maps, pathways, variations, phenotypes, and links to
genome-, phenotype-, and locus-specific resources worldwide.

OMIM: Database of human genes and genetic phenotypes.

Protein: Database of translations from annotated coding regions in GenBanlk,
RefSeq and TPA, as well as records from SwissProt, PIR, PRF, and PDB.

Structure: Database of three-dimensional genetic and protein structures.

Popset: Database of DNA sequences that have been collected to analyze the
evolutionary relatedness of a population.

Nucleotide: Database of genome, gene and transcript sequences from
several sources, including GenBank, RefSeq, TPA and PDB.

SNP: Database of single nucleotide polymorphisms (SNPs).

Search terms will vary by database. You can enter known search terms directly in
the Search Term field, or you can use the Search Builder function to construct
your search from known database elements and Boolean operators. For a
description of search terms and operators, visit www.ncbi.nlm.nih.gov/books/
NBK3837/.

Select the desired Page size.

When you have made your selections, click on Submit.

The search progress will be displayed Query List pane. When the search is
complete, the search will be flagged as Complete and the search results will be
displayed in the Results pane.

Entrez search results are displayed in tabular form in the Results pane.

& Entrez Query

Database

SearchTerm

Fagesiz= | 20

= Search Builder

AND || | All Fields

protein

RequestiD Status Databzze SearchTerm Datz/Time Server

EUTILS-111205152 prolactin[Protein Name] MonDec05 15:2156P5T2011 | |

v

prolactinProtein Name!

< >

Results: 1-200f 410 Page

Taxid Gi Length ~
9940 387876 240

257570 532239 210

8128 s31226 212

8128 s31228 200

167318 327343757

167318 32734377
9606 531103 220
/ / 5325 551230 229
prolactin [Capra hircus] 1934/03/28 2008/0/24 5925 ss1226 229

Caption Title
AAA21578 prolactin [Ovis aries]
AAsdBELL prolzctin [ncarhynchus mykiss gairdneri

aass3281 prolsctin [Graochromis niloticus]

aas3282 prolsctin [Graochromis niloticus]
2011/04/01

S

2011/02/01

8

prolactin [Czpra hircus]

Entrez Query

1932/09/28 2005/04/18 9940 551265 229
1993/06/28 2005/04/18 27773 312638 210

prolactin [Ovis a

prolactin [Cores

2| s

prolactin [Taenia hydatigens 2002/04/23 2005/04/15 25431 20330092 222
prolactin [Nycticebus pygmasus] 2004/07/26 2006/11/1¢ 101278 50657062 220 8

.
~
v

The table of results includes columns appropriate for the database you are querying.

Click on the link in the Results pane to open the online database record for each result.

Note: Entrez queries are not saved in the Vector NTI® Express Software database.
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Entrez Search

Editing and * To delete an Entrez query, right-click on it in the Query List pane and select

deleting queries Delete search job.
¢ To edit a query, right-click on it in the Query List pane and select Edit search.
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GenomeBench can be used to download, view, analyze, annotate, and save local copies
of reference genomic DNA sequences from several principal Distributed Annotation
System (DAS) servers.

GenomeBench was designed to support the following workflows:

* Retrieval of genomic data from public DAS servers.

* Annotating and creating a local copy of a genomic region.
In support of these workflows, it accepts megabase-sized genomic sequences and all
attendant track annotations. All annotated features are linked to their corresponding
region of the genomic sequence backbone; additional information for any sequence-
based annotation (for example, mRNAs, ESTs, and STSs), including other defined
features from the GenBank record, is easily downloadable. Annotated sequences can

be aligned with the genomic backbone simply by dragging and dropping into an
alignment window.

Proprietary DNA sequences stored in the Vector NTI® Express local database can also
be positioned along genomic backbones using Spidey or Sim4 alignment algorithms to
determine the intron-exon structure of genes of interest. Genomic sequences in
GenomeBench can be exported to Vector NTI® Express for further sequence analysis,
such as PCR primer design or the creation of spliced transcripts.

GenomeBench also provides the capability to query public databases and perform
sequence and feature searches.

Download data from public DAS servers

Vector NTI® Express has preconfigured DAS servers
To launch GenomeBench and download data:
1. Click on the GenomeBench button on the main toolbar.
2. When you first open the application, an empty project will be displayed.

3. In the GenomeBench toolbar (on the right side of the window), click on
the Load from DAS Server button to download genomic data from one
of the pre-configured public DAS servers:

— Genome Reference Consortium: human (GRCh)

— National Center for Biotechnology Information mouse genome assembly
(NCBIM)

— Rat Genome Sequencing Consortium (RGSC)
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Download data from public DAS servers

N o g &

— NCBI's 32K BAC array, BAC end-sequence pairs, and Fosmid clone end-
sequence pairs

In the DAS Server dialog, select the server from the DAS Authority list.
Select the genomic source from the Sources list.
Select the desired chromosomes from the Chromosomes list, then click on OK.

In the Load Fragment dialog, specify the base range of the sequence to download
using the Start and Length fields

Select the feature information to download from the Feature Type list, which
displays a selected list of features available in the DAS databases.

Load Fragment Pz|

Positions

Start: 15000
Length: 25000

Feature Type

Name Category b
wgEncodeHaibMethylRrbsT47dE...  transcription
wgEncodeOpenChroemChipMcf7C... transcription
weEncodeHaibTfbsEcciEralphaa...  transcription
sgpGene transcription
wgEncodeGencodeManualvid transcription
lincRMAsTranscripts transcription
xenokst transcription
nestedRepeats transcription W
Add ] [ Remave ]
[ OK ] [ Cancel ]

— Use Ctrl+click and Shift+click to make multiple selections.

— Click on Remove to remove selected features from the download.
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— Click on Add to open the Feature Types Filter and select from all available
feature types to add them to the Feature Type list.

9. Click on the OK in the Load Fragment dialog to begin the download.

Note: It can take some time for all the features to load, but you can start working on
features that have loaded before the remaining features are loaded.

10. The download time can vary considerably depending on the server connection
and data volume.

11. When the download is finished, the GenomeBench Project viewer will display the

project.
Data Loadmg You can monitor the download progress by clicking on the Download
Monitor Progress button on the GenomeBench toolbar. .* B
Data Loading Monitor g|
Main Sequence
Request Status Time b
xenoMrna features " Inloading ©00:03:41
intronEst features *o InQueue  00:03:41
refGene features *o InQueue  00:03:41
wgEncodeGencodeManualvdfeat.. 7 InQueue 00:03:41
lincRNAsCTTestes_R features *° InQueus 00:03:41
mgcFullMrna features *° InQueus 00:03:41
vegaPseudoGene features *° InQueus 00:03:41
wgEncodeGencode2wayConsPseu... & InQueue 00:03:41
wgEncodeGencode2wayConsPseu... & InQueue 00:03:41
wgEncodeGencodefutoVd features &7 InQueue 00:03:41
burgeRnaseqGemMapperalignTes... ¥ InQueue 00:03:41
sestanBrainAtlas features *o InQueue  00:03:41
cedsGene features *o InQueue  00:03:41
wgEncodeOpenChromChipMef7Cm... &7 InQueue 00:03:41
nscanGene features *o InQueue  00:03:41
nestedRepeats features *° InQueue  00:03:41 b
< ¥

In the Data Loading Monitor, features are listed as “Loading” or “In Queue.” To
delete an “In Queue” feature in the list, select it and click on Abort.

Local GenomeBench Projects

GenomeBench Projects that have been downloaded can be saved in the local Vector
NTI® Express database for future access:

¢ To save a project to the local database (i.e., after downloading the data from the
DAS server), select File > Save As and specify a name for the project in the dialog
box.

* To open a saved project, open GenomeBench and click on the Load from
Local Database button. Then select the project name from the Existing
Genome Projects dialog.
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GenomeBench Project Viewer

GenomeBench Project Viewer

The GenomeBench Project Viewer contains the following panes: Map Overview,
Feature Map, Genome Features, and Genome Sequence View.

Map Overview

Feature Map

Genome Features/
Sequence View

Map Overview The Map Overview pane presents a graphical depiction of the entire chromosome and
has the following features:

* A ruler marks the length of the chromosome.
* The rod-shaped band depicts the sequence/chromosome.
* Narrowed areas on the rod indicate centromeric regions.

* Cytoband patterns are indicated by the vertical dark lines that run the length of
the rod. Pause the cursor over a particular cytoband to display a tool tip with
information about the cytoband.

EEM B4M T2M BOM B2

[ birzfpizileslezs] [ I X_E
© 'EEI«'L\? 1300k 1350k 1400k
—|—|c\¢ubanu p14.2:58600000-63700000—

Centromeric regions and cytoband patterns are shown only for those DAS servers that
provide the information in the correct format.

Feature Map The Feature Map Pane shows a graphical depiction of the features for the currently
loaded fragment.

Like the Overview Pane, the Feature Map Pane has a ruler at the top to help you
visualize the orientation of features along the length of the fragment.
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Genome Features
and Genome
Sequence

Editing features

Feature types or tracks display along the left side of the Feature Map Pane. Different
features are depicted with various graphical representations and are labeled with the
feature name. Shown features are listed along with relevant feature information in the
Genome Features pane.

The associated GenBank accession number is derived from the Target Accession
number of the feature.

Magnifying tools

Use the magnifying tools to the right of the Feature Map to magnify features in the
pane horizontally.

@
&

The Genome Features pane lists the features in the map by name, and indicates their
type, location, orientation, and feature category.

[ Genome Features | ] Genome Seguence View

Name Type Start Length Orientation Category
DCB54810.chr3.9... xenocEst 1000300 40 UNKNOWN transcription
E£159107.chr3.9... xencMrna 974496 20 UNKNOWN transcription
FC129225.chr3.8... xenoEst 1000165 31 UNKNOWN transcription
CB308280.chr3.9... xenocEst 999965 a8 UNKNOWN transcription
GE874806.chr3.9... xenocEst 999701 261 UNKNOWN transcription 1

The Genome Sequence pane displays the entire downloaded sequence

Editing features

In the Feature Map and Genome Features list, the right-click menu allows you to
create, edit, or delete features.

Right-click on a feature in the map or list and select:

¢ Edit the selected feature: Edit basic settings and information for the feature,
including feature name, type, orientation, and position in the segment or multiple
segments.

* Create New Feature: Create a new feature, using the same settings and fields as in
the Edit Feature dialog.
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¢ Delete the selected feature: Deletes the selected feature.
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Align Multiple Sequences

The simultaneous alignment of multiple nucleotide or amino acid sequences is an
essential tool in molecular biology. Alignment enables you to design PCR primers for
amplifying a region of aligned DNA/RNA molecules. Multiple alignments are used to
find diagnostic patterns, characterize protein families, as well as detect or demonstrate
a similarity between new sequences and existing families of sequences. They are also
useful in predicting secondary and tertiary structures of new sequences, suggesting
oligonucleotide primers for PCR and serving as an essential prelude to molecular
evolutionary analysis.

AlignX is the multiple sequence alignment tool of Vector NTI® Express Software. In
addition to aligning sequences, it can be used to create and manage sequence
alignment projects. It uses a modified Clustal W algorithm and incorporates the
following features:

* Profile alignment

* Guide tree construction, displayed in graphical representation

¢ Use of residue substitution matrices

® Secondary structure consideration

* Multicolored alignment presentation

* Automatic consensus calculation

e Full alignment editing capabilities

¢ Dot Plot comparison of any two sequences

Open AlignX

There are several ways to open the AlignX tool:

¢ C(Click on the AlignX button on the main toolbar.

O

¢ In Database Explorer, right-click on a molecule or Ctrl+click on multiple
molecules and select Alignment to load those molecules into the tool.

* Load an existing AlignX project as described in “Manage AlignX projects” on
page 96.

AlignX window The AlignX window consists of the following panes:

* Project Properties pane: Contains the Project Description and the Fragments list.
As molecules are added to an AlignX project, they are listed in the Fragments list.
¢ Alignment Settings pane: Contains the settings used to perform the alignment.

¢ Graphs pane: Displays a graphical representation of the aligned molecules,
showing both similarity and sequence complexity.
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Manage AlignX projects

¢ Alignment pane: Displays the aligned sequences, with aligned regions
highlighted

¢ Guide Tree pane: A graphical representation of the degree of similarity among
sequences (for three more sequences).

Project description

Guide tree

Graphics pane
Fragments list

Alignment pane

Alignment settings

Manage AlignX projects

The tools for saving, editing, and loading projects are located in the Project Description
region of the Project Properties pane:

Project Properties

=] General Information
Name : pcDNA3.1AlignProject
Description :
Creation Date : 2011-12-11
Created By :
Last Medification Date : 2011-12-11
Last Modified By :

[ Load Project ] [ Edit Project ] [ Save Project ]

[Sa\re CDnsensus] [ Export Project ] [ Open DND ]
Save and rename a * To save a new AlignX project, click on Save Project in the pane. In the dialog,
project enter a name and any description for the project.

¢ To save changes to an existing project, click on the Save Project button.

¢ To change a project name or description, click on Edit Project.

Open a project * Toload an existing project in the database, in Database Explorer, go to the
Projects list, double-click on the Projects folder, select the Alignment Projects
folder from the Local Database, and double-click on the AlignX project in the list

to open it.
@ Projects Name Description Author Medified

- pcDNA3. 1AlignProject 2011-12-1107:09:14
=0 Local Database pcDNAG. 2AlignProject 2011-12-1011:38:55

Ii] Alignment Projects
Ii] Contig Azsembly Projects
Ii] Cloning Projects

+ Ii] Remaote Databaze
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Select fragments to align E

* Toload an existing project that has been saved as a .apr, .aprx, or .aln file, click on
the Load Projects button in the Project Properties pane and select the project from

the Open dialog.

Close a project To close a project, click on the Close Project button. If there are unsaved changes, you
will be prompted to save the project before closing.

Export a project To export an AlignX project as a .aprx file, click on the Export Project button and enter
a project name in the Export MSA Project dialog.

Save consensus After you perform an alignment, you can save the consensus sequence as a separate
sequence molecule in the database. Click on Save Consensus and specify a sequence file name.
Open .dnd file To open a external .dnd file generated from a Clustal W analysis, click on Open DND.

Select fragments to align

The tools for selecting the fragments to align are located in the Fragments List region

of the Project Properties pane:

Fragments

Sequence Name

Length

ipcDNA3. 1/ His A

pcDNAZ.1/Hygrol+)

[] pebMaz.1fHisC

5514
5601
5513

[ Add From File

Add From Database

[ Delete

J
J

View Dotplot
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Select fragments to align

Add fragments

Remove fragments

Select fragments
to align

98

To add fragments:

e C(Click Add from File to select .gb, .gp, or fasta sequence files.

* C(lick Add from Database to select DNA or protein molecules from the local
database.

Note: Press the Ctrl or Shift keys to select multiple files/molecules.

To remove a fragment from the AlignX project, select the checkbox next to the
fragment name in the Fragment List and click on the Delete button. This will remove
the fragment from the project, not delete it from the database.

To select fragments for alignment, select the checkboxes next to the fragment names in
the Fragments List.
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Alignment settings

Program

Molecule type

Pairwise alignment

Click on the Alignment Settings button below the Project Properties pane to view the
settings for performing an alignment.

Alignment Settings

Program |ClustalW2(Local]

Molecule Type

DNa v
Pairwize Alignment Options
Alignment Type
() Slow () Fast
DNAWeight Matrix | IUB | Protein Weight Matrix
Gap Open 10 v Gap Bxtension 01 |w
Multiple Sequence Opticns
DNAWeight Matrix | IUB “ | Protein Weight Matrix
Gap Open 10 v Gap Bxtensicn 0.20 |

Gap Distance 5w No End Gaps no W
Iteration nane | Num of lteration 1 hd

Clustering NJ -

Project Properties

Alignment Settings

Clustal W (local)

The local Clustal W algorithm calculates a crude similarity between all pairs of
sequences, called a “Parities alignment.” These scores are then used to calculate a
“guide tree” or dendrogram, which determines the order in which the sequences are
aligned. The sequences are then aligned in larger and larger groups until the entire
sequences are incorporated in the final alignment.

Using the additional settings, you can designate the scoring matrix used by the
algorithm rather than the algorithm making the choice as is done in a traditional
Clustal W alignment.

Clustal W (EBI)
This selection uses the Clustal W algorithm developed by the European

Bioinformatics Institute (EBI).

Select DNA or Protein from this dropdown list.

These settings control pairwise distances based on the Clustal W algorithm selected.

The Alignment Type options control the speed/sensitivity of the initial alignments:
¢ Fast (approximate) method

* Slow (more accurate) method uses two gap penalties (for opening or extending
gaps) and a full amino acid weight matrix. By default, this slower method is used.
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Alignment settings

There are two groups of parameters, depending upon which method above is chosen:

Slow options

Description

DNA Weight Matrix

IUB (default) or Clustal W

Gap Open penalty

The penalty for the first residue in a gap

Gap Extension penalty

The penalty for additional residues in a gap

Fast options

Description

KTUP (Word size)

Change the K-tuple value to limit the word-length the
search should use. A word-length of 2 is sensitive
enough for most protein database searches. The
general rule is that the larger the word length, the less
sensitive, but faster the search will be.

Window Length

The number of diagonals around each of the best
diagonals used

Score Type
TOPDIAG

Percent or absolute

Number of the k-tuple matches on each diagonal used
in the alignment

PAIRGAP

Penalty for the existence of a gap

Multiple sequence

These parameters control the final multiple alignment.

tion
options Option Description

DNA/Protein Weight Matrix All algorithms designed to evaluate pairwise sequence
alignment are based on systems which rank aligned
residues. Nucleotides or amino acids that are identical
or similar in alignment score higher than those less
similar. Matrices generated with these assigned scores
are used to detect similarities between differing
sequences. The most common of many different scoring
systems are based on substitutions of amino acids in
related proteins.

Gap Open The penalty for the first residue in a gap

Gap Extension The penalty for additional residues in a gap

Gap Distance Tries to decrease the distances between gaps

No End Gaps " Does not penalize for gaps introduced at the end of a
sequence

[teration None (default), tree, or alignment

Num of lteration 1(default] to 10

Clustering ' Method used to create the Guide Tree: Neighbor Joining
(NJ) or Unweighted Pair Group Method with Arithmetic
Mean (UPGMA] (see description under Guide Tree pane
below)
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Guide Tree pane E

When you have selected the alignment settings, click on Submit.

Guide Tree pane

Graphs pane

Sequence
similarity graph

Sequence
complexity graph

The Guide Tree, which resembles a Phylogenetic tree, is displayed when three or more
sequences are aligned. The Guide Tree can be built using two different methods:

* The Neighbor Joining method (NJ) of Saitou and Nei works on a matrix of
distances between all pairs of sequence to be analyzed. These distances are related
to the degree of divergence between the sequences.

¢ The Unweighted Pair Group Method with Arithmetic Mean (UPGMA) is a simple
agglomerative or hierarchical clustering method in which, at each step, the
nearest two clusters are combined into a higher-level cluster.

The Guide Tree is calculated after the sequences are aligned. AlignX displays the
calculated distance values in parenthesis following the molecule name in the Guide
Tree pane.

PDONR221-P5P2(-2. 1E-4)
PDONR221_VERD(0.00158)
PDONR221-P3P2(-1.1E-4)
PDONR221-P5P4{-6. 1E-4)
PDONR221-P4RP3R(0.04619)

The Graphs pane provides a graphical representation of sequence similarity and
complexity among the aligned sequences.

The graphs in this pane interact with the sequences as listed in the Alignment pane.

Note: All graphs display the values averaged in a window of a specific length (defined
by “window” parameter) that slides along the alignment.

To generate the Similarity graph (upper graph), specific values (in a 0-1 range) are
assigned to each residue at a given alignment position in each aligned sequence,
depending on whether the residue is identical, similar, or weakly similar to the
corresponding residue of the consensus sequence. The values (1 (identical), 0.5
(similar), and 0.2 (weakly similar) for each residue at a given position are totaled; the
sum is divided by the number of the sequences in the alignment, “normalizing” the
resulting value.

The Complexity graph (lower graph) is calculated as a sum of all pairwise residue
substitution scores at a given alignment position divided by the number of pairs in the
alignment. The scores are taken from the residue substitution matrix used for
alignment calculation.
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Alignment pane

Magnify the graphs

Select a region

In Windows, click in the Graphs pane and use the mouse wheel to change the
horizontal scale of the graph to zoom in on particular features. A scroll bar will appear
below the graph as you magnify.

On the horizontal scale, either numerical positions in the sequence or residues can be
shown, depending on the degree of zooming in the graphics pane.

Drag your cursor over a region of a graph to highlight that same region in the
Alignment pane.

Alignment pane

Select a region

Dot Plot

102

The Alignment pane displays aligned sequences and the resulting consensus sequence.
The top row in the pane consists of the alignment consensus. Consensus residues are
those that appear most commonly at a particular site.

Note: You can save the consensus sequence as a separate sequence molecule; click on
Save Consensus in the Project Properties pane.

Drag your cursor over a sequence region in the Alignment pane to highlight that same
region in the Graphs pane.

Note: The View Dot Plot button is only available when two fragments are selected in
the Fragments List.

The Dot Plot is a method for comparing two sequences to find all possible matches of
residues. This method can also be used to find direct or inverted repeats in protein and
DNA sequences. It can predict regions in RNA that are self-complementary and
therefore might form a double-stranded region or secondary structure.

In the Dot Plot method of sequence comparison, one sequence (A) is listed on the X-
axis of the graph and the other sequence (B) is listed on the Y-axis. Starting with the
first positions in A and B, the program slides the window of n characters along the
sequences, performing a comparison of adjacent positions in the windows. If the
similarity of residues in each position is above a certain cutoff, a dot is placed in the
matrix in the position defined by the starting positions of the window for both
sequences. A diagonal line segment indicates that the two sequences match
consistently over an extended region.

A larger window size is generally used for DNA sequences than protein sequences
since the number of random matches is much greater for DNA.
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Display the Dot Plot  With two fragments selected in the Fragments list, click on View Dot Plot to open the
Dot Plot Viewer and view a similarity plot of the selected molecules.
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3D Molecule Viewer

The 3D Molecule Viewer is a tool for visualizing protein structures in three
dimensions. It can open Protein Data Bank (PDB) files with the file extension *.pdb.

The 3D Molecule Viewer uses JMol, an open-source Java viewer for chemical
structures in 3D that has been integrated into Vector NTI® Express. For more
information about JMol, visit www.jmol.org.

Download 3D Structure Files

You can search for PDB files (with the *.pdb file extension) in public databases using
the Entrez query tool in Vector NTI® Express. Click on the Public Database Search
button on the main toolbar, and for the database type, enter “structure.”

Save downloaded *.pdb files in an appropriate file location and access them using the
tool as described below.

Open a molecule in 3D Molecule Viewer

1. To open a PDB molecule in the 3D Molecule Viewer, click on the 3-D Molecule
Viewer tool on the main toolbar, or select it from the Discover menu.

O

2. In the Open dialog, select a *.pdb file to open it.
To open a different molecule, select File > Open > 3D Molecule.

Note: The PDB file you open will remain open in Vector NTI® Express until you close
the window, and you can navigate back to it by clicking the 3-D Molecule Viewer
button.
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3D Molecule Viewer
Elements of the 3D Molecule Viewer window

Elements of the 3D Molecule Viewer window

The 3D Molecule Viewer window consists of three panes:

Molecule Display
pane

Outline pane

Properties pane ——

* Graphics pane—displays the three-dimensional structure of the molecule.
¢ Properties pane—lists any properties associated with the molecule
® Outline pane—lists the amino acids in the sequence
The right-click menu in the Molecule Display pane contains information about the

molecule and tools for manipulating the graphic representation of the structure,
exporting molecule data in various formats, and optimizing the display.

Magnify and rotate the molecule

In the Molecule Display pane:

* To zoom in or out, rotate the wheel on your mouse or select Zoom from the right-
click menu.
¢ To rotate the molecule in three-dimensional space, drag your cursor in the pane.

¢ To reposition the molecule within the pane without rotation, hold the Ctrl + Alt
keys and drag your cursor in the pane.

¢ To begin spinning the molecule in three-dimensional space, select Spin > On from
the right-click menu, and adjust the settings on the Spin menu. Select Spin > Off
to stop spinning.
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Highlight an amino acid or a chain

¢ C(Click within the structure in the Molecule Display window to highlight a
particular amino acid. Click on it again to un-highlight it.

¢ (Click on an amino acid in the Outline pane to highlight it in the Molecule Display
pane.

* C(lick on a chain in the Outline pane to highlight that entire amino acid chain in
the structure.

Additional menu operations

The right-click menu in the Molecule Display window contains all the J]Mol commands
for viewing and manipulating the structure. For additional information about these
commands, visit www.jmol.org.
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3D Molecule Viewer
Additional menu operations
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Sim4

Launch Sim4
analysis tool

Sim4 and Spidey Analysis

Sim4 and Spidey are tools for aligning expressed nucleic acid sequences (e.g., mRNA)
with genomic sequences in online databases. Vector NTI® Express includes these tools
for analyzing molecules stored in the database.

Sim4 is a similarity-based tool for aligning an expressed nucleic acid sequences (EST,
cDNA, mRNA) with a genomic sequence. For more information about Sim4, see http:/
[www.hgmp.mrc.ac.uk/.

Sim4 employs the following multi-stage BLAST-based technique:

¢ Sim4 detects all possible exact matches of W-mers between the two sequences and
extends them to maximal scoring gap-free segments (exon-cores).

* Exon-cores are extended into the adjacent, as-yet-unmatched fragments using
greedy alignment algorithms. Heuristics are used to favor configurations that
conform to the splice-site recognition signals. If necessary, the process is repeated
with less stringent parameters on the unmatched fragments.

Sim4 functions similarly to BLAST, but performs a more thorough mRNA alignment
search.

To open the Sim4 Analysis tool:

¢ In Database Explorer, right-click on a molecule or use Ctrl+click or Shift+click to
select multiple molecules and right click. In the right-click menu, select Analysis
Monitor > Sim4 Analysis.

* With a molecule open in Molecule Editor, click on the Sim4 Analysis button in
the Molecule Editor toolbar.

The Analysis Monitor will open, with the Sim4 Analysis settings selected and the
selected molecule(s) listed.
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Simé4 and Spidey Analysis
Sim4

The analysis window has an Analysis Jobs pane containing the analysis settings, and
an Analysis List pane listing the molecules loaded in the tool.

Analysis Jobs Name AnalysisType | Description Status Modified Date
L sim2anzlysiz of BRAF Sima. Aligning = transcribed and spliced DNAzeq...  *
Sim4 L simaAnzlysisofCOKZ  Sim4 Aligning 3 transcribed and spliced DNAseq... % New Submit Sun Dec 11 11:17:18 PST 20.

P8 simaanalysis of CREBL Aligning a transcribed and spliced DNAseq_. | MewSubmit | Sun Dec 1111:00:04 PST 20
Name | cREBL
from to

strand(s) () Direct (0 Complementary (%) Both

 Simd Parameters

New Submit Sun Dec 11 11:17:17 PST 20..

Word siza(1..15] 12
Limit of Score Drop-off 12
Search for Small Brans @nNe Oes
Diagonal Distance 10
[¥] Allow ambiguity characters
[]weight factor for linking HSPs:
 HSPscore threshold
[DFirststage

[]second staze

Analysis Jobs

Analysis Jobs Molecule and strand to analyze

settings In the Analysis Jobs pane:

¢ Select the molecule from the Name dropdown list.

* Specify the Strand to analyze. The Both option searches both strands and reports
the best result.

Sim4 parameters

* Word Size — The number of DNA bases in a size unit. The larger the word size,
the faster and less sensitive Sim4 becomes.

Limit of Score Drop-off — The trigger for stopping ungapped extension.

e Search for Small Exons - If Yes is selected, an additional search for small exons is
performed.

¢ Diagonal Distance — The upper boundary of diagonal distance within
consecutive HSPs in an exon.

¢ Allow Ambiguity Characters — If checked, allows the following ambiguity
characters: ABCDGHKMNRSTVWXY. If unchecked, only the following
characters are allowed: ACGTNX.

* Weight Factor for Linking HSPs — The multiplication factor used when
calculating the score of a chain of HSPs.

* Defaults - Resets Sim4 parameters to the original default values.

HSP Score Threshold

* TFirst Stage — The threshold for HSPs for the first stage of comparison. If no value
is specified, the default value is used.

¢ Second Stage — The threshold for HSPs when aligning the extended-and-
unmatched portions. If no value is specified, the default value is used.

Submit the job When you have made your selections, click on Submit.
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Spidey

Launch Spidey
analysis tool

Spidey

When analysis is complete, a Completed checkbox will appear next to the job name in
the Analysis Monitor.

The Analysis Monitor contains a list of all the analyses performed by Vector NTI®
Express, including Sim4 analyses. Click on Analysis Monitor on the main toolbar to

open it.

To view the analysis for a particular molecule, you can:

* Open the molecule in the Molecule Editor, and click on Analysis Results.

¢ Open the Analysis Monitor and double-click on the particular analysis.

Spidey is an mRNA-to-genomic alignment program. It takes as input a single genomic
sequence and a set of mRNA accessions or FASTA sequences. All processing is done
one mRNA sequence at a time. The first step for each mRNA sequence is a high-
stringency BLAST against the genomic sequence. The BLAST alignments are sorted by
score and then assigned into windows by a recursive function. For more information

about Spidey, see www.ncbi.nlm.nih.gov/spidey/.

After the genomic windows are constructed, the initial BLAST alignments are freed
and another BLAST search is performed, this time with the entire mRNA against the
genomic region defined by the window, and at a lower stringency than the initial
search. Spidey then uses a greedy algorithm to generate a high-scoring, non-
overlapping subset of the alignments from the second BLAST search. This consistent
set is analyzed carefully to make sure that the entire mRNA sequence is covered by the
alignments.

Once the mRNA is completely covered by the set of alignments, the boundaries of the
alignments are adjusted so that the alignments abut each other precisely and so that
they are adjacent to good splice donor and acceptor sites. To position the exon
boundaries, the adjacent exon alignment overlap region plus a few base pairs on each
side is examined for splice donor sites, using functions that have different splice
matrices depending on the organism chosen. The top few splice donor sites (by score)
are then evaluated as to how much they affect the original alignment boundaries. The
site that affects the boundaries the least is chosen, and is evaluated as to the presence of
an acceptor site. The alignments are truncated or extended as necessary so that they
terminate at the splice donor site and so that they do not overlap.

For details on Spidey analysis, see http://www.ncbi.nlm.nih.gov/IEB/Research/Ostell/
Spidey/index.html.

To open the Spidey Analysis tool:

¢ In Database Explorer, right-click on a molecule or use Ctrl+click or Shift+click to
select multiple molecules and right click. In the right-click menu, select Analysis
Monitor > Spidey Analysis.

¢ With a molecule open in Molecule Editor, click on the Spidey Analysis button in
the Molecule Editor toolbar.
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Simé4 and Spidey Analysis
Spidey

The Spidey Analysis tool will open with the selected molecule(s) listed.

The analysis window has an Analysis Jobs pane containing the analysis settings, and
an Analysis List pane listing the molecules loaded in the tool.

Analysis Jobs Molecule and organism to analyze

settings In the Analysis Jobs pane:

* Select the molecule from the Name dropdown list.
* Specify the Organism to analyze for your genomic sequence.

Spidey Parameters * Minimum mRNA Genomic Identity — Percent identity cutoff for gene models.

¢ Minimum Length of mRNA Covered - mRNA length coverage cutoff in percent
for gene models.

¢ Limit Number of Gene Models to — Sets the maximum number of gene models
Spidey analysis returns.

e E-value

— 15t Pass — The E-value cutoff for the initial high-stringency alignment. The
higher the value, the less stringent and faster the run.

— 2nd Pags — The E-value cutoff for the low-stringency BLAST search within a
genomic window, based on the high-stringency result.

- 3rd Pass — The E-value cutoff for a very low-stringency BLAST search to find
hits for mRNA gaps.

* Divergent Sequences — If checked, search parameters are adjusted to tolerate
mismatches and gaps for inter-species alignment.

* Use Large Intron Sizes — If checked, much larger maximal intron sizes are
allowed. Checking this option increases computation time significantly.

* Defaults — Sets Spidey parameters to original default values.

Submit the job When you have made your selections, click on Submit.

When analysis is complete, a Completed checkbox will appear next to the job name in
the Analysis List.
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View analysis The Analysis Monitor contains a list of all the analyses performed by Vector NTI®
results Express, including Spidey analyses. Click on Analysis Monitor on the main toolbar to
open it.

O

To view the analysis for a particular molecule, you can:

* Open the molecule in the Molecule Editor, and click on Analysis Results.

* Open the Analysis Monitor and double-click on the particular analysis.
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Clone25eq

Clone2Seq simplifies the two fragment restriction and ligation cloning process. Using
Clone2Seq, you will be able to clone a single DNA or RNA insert into a vector without
having to go through multiple steps of the molecule construction wizard.

Launch Clone2Seq  To launch Clone2Seq:
7
¢ C(lick on the Clone2Seq button O on the main toolbar.

* Select File > New > Clone2Seq Project from the main menu.

Clone2Seq window  The Clone2Seq window consists of two molecule panes, and a left pane containing the
Fragment List and Molecule Properties lists.

The left-most molecule pane contains the DNA/RNA molecule that is first fragment in
the clone, and the right-hand pane contains the second fragment.

For each molecule, the restriction sites (selected by Restriction Analysis in the
Molecule Editor) will be displayed in the molecule pane, and sequence ends of linear
molecules will be shown in the View Sequence field below the pane.

Figure 1 Clone2Seq Window

Select molecules 1. Click on Open Molecule below the left-hand pane to select the first molecule.
2. Repeat this operation in the right-hand pane to select the second molecule.

Note: Click on Clear Fragment to remove a molecule from the pane.
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Molecule
requirements

Display restriction
sites in molecules

Generate molecule
fragments
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Note: The molecule in the left-hand pane will always be the first fragment of the clone
and the molecule in the right-hand pane will always be the second fragment of the
clone. This is done to maintain the directionality of the resulting construct.

Note the following molecule requirements for Clone2Seq assembly:

* Two linear molecules with blunt ends may be cloned as is.

* Two linear molecules with overhangs must have matching overhangs. This can be
accomplished via restriction digestion, as described in Generating molecule
fragments below, or by modifying the fragment ends, as described in Modifying
fragment ends.

¢ Circular molecules must be linearized on a cut site, as described in Generating
Molecule Fragments below.

Click on Left Molecule Properties or Right Molecule Properties (below the Fragment
List) to display or hide selected restriction sites in the molecules. The selected
restriction sites will be displayed in the molecule panes.

Left Molecule Properties

Enzymes name number Restriction String

:

+ Afel 1

+ Aarl 1

+ Acil 10

+ Accl 1

< >

Fragment List

Left Molecule Properties

Right Molecule Properties

Note: The only restriction sites listed will be those identified by Restriction Analysis in
the Molecule Editor. If the desired restriction sites are not listed, open the molecules in
the Molecule Editor, perform Restriction Analysis with the desired restriction
enzymes, and then re-load the molecules in Clone2Seq. See Chapter 2, “Molecule
Editor” on page 39 for more information on Restriction Analysis.

To generate a molecule fragment from a linear or circular molecule in Clone2Seq:

1. Click on a restriction site in the desired molecule to generate a single cut site, or
shift-click on two restriction sites to select the region between them (the region
will appear selected in the window, as shown below).

Vector NTI® Express Software User Guide



Edit the Fragment
List

ADRALA 2
Aeil (‘484) ADR.:\].A
ACEHTI (465} ADRAIA Gene
Acil |(3.'6? Aeil (826)41:1:1’ (10;4) Acil (IJ;,'JQ)
Acil (3_-0) Aeil [’804] Aeil {Jo;,o) Acil (1473)
Acil (28:) Actl (71 6 7) ADRAlASDurce ADRIA:IlA Alul (‘.1859)
Act (158)  Alul (466) am(5833|ADRA1A Act (1137) ADRALA AlT (3812)
Al (126) Act (562)] | Aart (bou) alul (820) pomiata||  ar(ose)|  acadd  at (zot)
s - 1 il |
[
[
>
4
ADRA1TA v
4 *

Note: When selecting restriction enzymes that generate overhangs, be sure to select
enzymes in both molecules that will generate complementary overhangs.
Alternatively, you can modify the fragment ends as described below.

2. Click on Cut & Add to Fragment below the molecule pane.
3. The fragment will be added to the Fragment List.

Note: Fragments in the list are named for the molecule, as well as the region that was

cut. For example, ADRA1A_1_608 is a fragment of the ADRA1A molecule taken from
the 1-608 bp region.

4. To select the fragment for cloning, right-click on the fragment in the list and select
Select as left molecule or Select as right molecule.

ADRA1A_363)
ADRALA_EOZ| Set as right molecule
ADRA1A_S21) Delete Fragment
pcDNA3.1/HI|  Save Fragment to Database

Set as left molecule

5. The fragment will be added to the appropriate pane, and the cut ends will be
displayed below that pane.

View Sequence :

Aarl ADRA1A_E02_824 Alul
N gag ¢ S

5'- NNNN 223 bps AG -3

3 e 5

6. Repeat this procedure for the second molecule.

Right-click on a fragment in the Fragment List and select Delete Fragment to delete it,
or Save Fragment to Database to save it as a molecule in the database.
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1.

To modify the ends of a molecule or fragment, click on Modify Ends, then select
the desired modification using the dropdown list.

Modify Ends X
Acil ADRALA_363_1477 Acil
— gag ¥ —
5'- ucin 1115 bps e -3
3'- GCG clclo -5'

Specify modification

None

Klenow fill-in
5'-3' exon oK ] [ Cancel
3'-5' exon
Partial fill-in

The modification will be previewed in the dialog. Click on OK to make the
modification.

. When you have made your selections, click on the Assemble button. Note that

this button will not be available unless both molecules are linear.

In the Construct dialog, enter a name for the assembly and select the desired

molecule type and start position and whether the resulting assembly is circular or
linear.
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3. Click on Construct. The assembled molecule will be displayed in a preview
window.

Note: You can use the tools in the window to magnify the molecule or display it as
linear or circular.

4. Click on Save to save the molecule to the database.

Multiple fragment To clone multiple fragments using Clone2Seq, first create a clone from two fragments
cloning as described above, then generate a clone from the cloned molecule and the next
fragment. Repeat as necessary.
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For more
information

Gateway® Cloning
Workflow

Gateway® Cloning

Gateway® Cloning Technology is a rapid and highly efficient method for the cloning
and subcloning of DNA segments. This system is based on the well-characterized
bacteriophage lambda-based site-specific recombination system (attL x attR <> attB x
attP).

Gateway® Cloning is a 2-step process. In the first step a sequence of interest containing
attB sites is recombined with a donor vector containing attP sites into an entry clone,
creating atfL sites in the process. The second step recombines the attL-containing entry
clone with a destination vector containing a#{R sites, generating an expression clone
that can be propagated and expressed in a range of host cells for a given experiment.

For detailed information on Gateway® Cloning, see the Gateway® Technology User Guide
or the Gateway® Technology with Clonase"" II User Guide, available for download from
www.lifetechnologies.com/manuals.

Workflow diagram

BP Reaction
attB attB attP attP attL attL attR attR
gene
(e 1 + 60 Clonaser
attB-flanked donor —_— entry
PCR product or vector clone
expression clone
LR Reaction
attL attL attR attR attB attB attP attP
+ LR Clonase™

[

expression By-product

clone

destination
vector

Entry
clone

Step 1. Create an entry clone

The standard method for creating an entry clone in the Vector NTI® Express Gateway®
Cloning Tool involves amplifying a sequence or molecule of interest with attB-
containing primers designed by the software, then performing BP recombination with
a donor (pDONR) vector to generate an entry clone.

PCR product (flanked by attB sites) + pDONR vector (with attP) <> Entry Clone
(with attL)

You can also create an entry clone by the following methods:

* Select an existing attB-containing DNA molecule- From within the Gateway®
Cloning Tool, you can select an already existing at{B-containing DNA molecule in
the database, such as a Gateway® Expression Clone or a pCMVSPORTS6 library,
for recombination with a donor vector, to create the entry clone
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12 Gateway® Cloning
Gateway® Cloning Tool

Construct an entry clone by alternative molecule construction methods- You
can construct your own entry clone using other Vector NTI® Express molecule
construction methods, ensuring that the clone contains the required attL1 and
attL2 sites (labeled as features as described in “Add Entry Clones to Use in LR
Reaction”), then save the molecule in the database and select it directly in the
Gateway® Cloning tool.

Step 2. Create an expression clone

Using the Gateway® Cloning Tool, entry clones created from any of the above methods
are recombined with destination (pDEST) vectors in an LR recombination reaction to
generate expression clones, which can drive expression of the sequence of interest
when transformed into host cells.

Gateway® Cloning Tool

Open the Gateway®
Cloning Tool

Gateway® Project
pane

122

The Gateway® Cloning Tool contains settings and functions for assembling a
Gateway® construct using the workflow described above, and for creating and
managing Gateway® Cloning projects.

There are several ways to open the tool:

Click on the Gateway Cloning button on the main toolbar.
Select File > New > Gateway Cloning Project from the main menu. -

With a molecule open in Molecule Editor, right-click in the Graphics or
Sequence pane and select Launch Gateway.

Load an existing Gateway® Cloning project as described in “Create, save, and
load projects” on page 124.

The tool window is composed of the following panes:

This pane displays the name of the current project, and includes controls for editing,
saving, and closing projects. It also lists any generated molecules for the current
project.
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Gateway® Cloning Tool

Click on the Gateway Project button to display this pane.

@ Gateway Project

=] General Info
Mew Gatewsay Cloning Project

PCR Analysis : The PCR Product of GNG5_attB3_attB4

< | [

W

@ Task

Task List pane This pane displays the list of tasks in the selected project. Click on the Task button to
display this list.

As you navigate through the Gateway® Cloning workflow, the Task List displays the
current task, and allows you to move between tasks by clicking on a different task.
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Create, save, and load projects

Current Task pane This pane displays the commands and settings for the currently selected task in the
project. As you navigate through the Task List workflow, the functions in this pane

will change.

Fragments to Amplify

Name Accession From To SenszeSite Antizense Site Description

pCRB/GW-TOPO pCRB/GW-TOPO 211 270

GNGS GNGS 1 €38 Homo sapiens guanine nucleotide bin...
Add ] [ Remove

PCR Amplification Settings

Analysis Conditions

Tm([E] WEC Length

= | 40.0 = | 350 >= | 109 @ DNA O RNA
==| 5.0 <= | 80.0 == | 114

Add GGGG-attBx 5' extensions

of Sense Primer: of Antizense Primer:
sttB3[ACAACTTTGTATAATAAAGTTGLT) | | sttBA[ACAACTITGTATAGAAAAGTTGEGTG) w

Add to oligo list

[[] Add genersted primers to oligo list

Advanced ] [ Amplify

Create, save, and load projects

The tools for saving, editing, and closing projects are located in the Gateway® Project
pane:

@ Gateway Project

=] General Info
CDK2 Gateway Cloning project

 To save a new Gateway® Cloning project, click on Edit Project in the Gateway®
Project pane. In the dialog, enter a name and any description for the project.

¢ To save changes to a project, click on the Save Project button.

¢ To close a project, click on the Close Project button. If there are unsaved changes,
you will be prompted to save the project before closing.
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Gateway® Cloning workflow

* Toload an existing project, in Database Explorer, go to the Projects list, double-
click on the Projects folder, select the Cloning Projects subfolder from the Local
Database, and double-click on the Gateway® Cloning project in the list to open it.

EE‘J T Name Description Author Modified Claning Technology

CDK2 Gateway Cloning project 20111208 12:15:40 Gateway_attB1_attB2
=l Local Database
[ Alignment Projects

]

(L] patabase
B proects
(&) Results

Gateway® Cloning workflow

Amplify fragments
to Use in a BP
reaction

The Task List displays the default Gateway® Cloning workflow:

* Amplify Fragments to Use in BP Reaction
¢ Recombine Entry Clones by BP

* Preview Entry Clones

¢ Add Entry Clones to Use in LR Reaction
* Create Expression Clones by LR

* Preview Expression Clones

This section describes each task in the workflow.

The Amplify Fragments to Use in a BP Reaction task is the default task displayed
when you first open the Gateway® Cloning Tool.

The first step in this task to select the fragment(s) you want to amplify by PCR for use
in a BP cloning reaction. These fragments will be listed in the Fragments to Amplify
list.

Fragments to Amplify

Name Accession From To Sensze Site Antizense Site Description

GNGS GNGS 1 698
YCRO1OC YCRO1OC 1 852

Hema sapiens guanine nuclectide bin..

S.cerevisiae chromosome |l complete...

Add ] [ Remove

Load molecules or fragments in the Fragments to Amplify list

¢ With a molecule open in Molecule Editor, right-click in the Graphics or Sequence
pane and select Launch Gateway to load the entire sequence in the list.

* With a molecule open in Molecule Editor, select a portion of the sequence in the
Graphics or Sequence pane, right-click, and select Launch Gateway to load only
that part of the sequence in the list.
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* With the Gateway® Cloning window open, make sure the Amplify Fragments to
Use in BP Reaction task is selected and click on the Add button under Fragments
to Amplify to select a complete molecule from the database.

To change the regions to amplify in the selected molecules, type a new range in the
From and To fields in the Fragments to Amplify subpane.

Amplification settings

With the fragment(s) loaded, select the desired amplification settings under PCR
Amplification Settings. The standard options are described below.

Standard Settings

Tm(C)

Enter limits in degrees Celsius for primer
melting temperature (T,;,) (temperature at
which 50% of primer is a duplex) and the
difference between T, for sense and
antisense primers.

%GC

Enter limits in degrees Celsius for primer
melting temperature (T,,) (temperature at
which 50% of primer is a duplex) and the
difference between T, for sense and
antisense primers.

Primer Length

Defaults to 20-25, recommended for
Gateway® Primers

DNA/RNA button

Select the type of nucleotide sequence.

Add GGGG-attBx 5" Extensions

The default a#fB extensions are for single
fragment cloning: g¢fB1 for the sense primer
and affB2 for the antisense primer. Select
from the dropdown list to replace the
defaults with other atfB sequences for
creating Entry Clones for MultiSite Gateway®
Cloning projects.

Add generated primers to oligo list

Select this checkbox to add the primers you
generate to the oligo list

Note: For additional amplification settings, click on Advanced. The advanced
amplification settings are identical for all PCR primers, and are described in Chapter 3,

Primer Design.
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Gateway® Cloning workflow

Amplify

When you have made your selections, click on the Amplify button. The next task pane
will be displayed, and the generated PCR product(s) will appear listed in the BP
Inserts subpane, and also listed in the Gateway® Project pane.

@ Gateway Project

=] General Info

CDK2 Gateway Cloning project

BB The PCR Product of ADRALA_1_2306_sttB1_attB2 [y

= FindPCRPrimers
—J- Product of Length 2367

=- Sense Primer
Start:1
GC:42.86
Length: 48
Sequence: GEGGACAAGTTTGTACA:
Tm:63.24C
dG:-89.31 keal/mel
dH:-387.2 keal/meal
dS:-993.5 cal/maol

- Antizense Primer

+)- Primer Pair Data b

Recombine Entry In the Recombine Entry Clones by BP task pane, you can modify the list of fragments

Clones by BP with atfB sites and select a donor (pDONR) vector or vectors with which to create
entry clones.

BP Inserts

The fragments you amplified with attB sites are listed in the BP Inserts list at the top of
the pane.

¢ To add a previously amplified fragment with a#tB sites, or a fragment designed
with attB sites by another means (e.g., restriction-ligation), click on the Add
button and select the molecule from the database.

e Toremove a molecule from list, select it and click on Remove.
e To clear the entire list, click on Clear All.
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Gateway® Cloning workflow

pDONR Vector

The pDONR vector is a type of Gateway® Cloning vector that contains atfP sites,
which are recombined with the fragments containing at¢B sites to create entry clones.

attB attB attP attP attL attL attR attR
+ -CCdB BP Clonase™ Il -m + m -cch El
attB-flanked PCR donor —_— entry by-product

product or attB

n vector
expression clone

clone

A variety of pDONR vectors are sold by Life Technologies, and i silico sequences for
these are installed as part of the default Vector NTI® Express installation.

IMPORTANT! To be recognized as a pDONR vector in Vector NTI® Express, a molecule
must contain the correct attP1 and attP2 sequences, and these sites must be labeled as
features in the molecule with the feature names attP1 and attP2. See Chapter 2,
“Molecule Editor” on page 39 for information on identifying and naming features.

To select a pDONR vector:

¢ C(lick on the Add button and select the pPDONR vector from the database.
¢ To remove a vector from list, select it and click on Remove.
e To clear the entire list, click on Clear All.

Create the Entry Clone

When you have made your selections, click on Create Entry Clone. The Preview Entry
Clones task pane will open.
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Reaction

Gateway® Cloning workflow

The Preview Entry Clones task pane lists all the entry clones created from the attB-
containing fragment(s) and the donor vector(s) you selected, and includes a preview
window for viewing an entry clone.

Entry clones contain attL1 and attL2 sites, and are used to generate expression clones
via an LR reaction.

In the Entry Clones list:

¢ Select a clone and click on Save to Database to save it as a DNA molecule in the
database.

¢ Double-click on a clone to display it in the Preview window.

In the Preview window:

* Using the magnifying tools to zoom in and out of the molecule.

X EE

¢ Display the molecule as linear or circular by clicking on the appropriate button.

ﬂ]]f[[rr j_';:'g

After creating entry clones, click on Add Entry Clones to Use in LR Reaction in the
Task List to proceed to the next task in the workflow.

Any entry clones that you generated from the previous tasks in the workflow will be
listed in this window.

* To select new or additional entry clones in the database, click on the Add button
and select from the dialog box.
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Create Expression
Clones by LR

130

IMPORTANT! To be recognized as an entry clone in Vector NTI® Express, a molecule
must contain the correct attL.1 and attL.2 sequences, and these sites must be labeled as
features in the molecule with the feature names attL1 and attL2. See Chapter 2,
“Molecule Editor” on page 39 for information on identifying and naming features.

¢ To remove an entry clone from the list, select it and click on the Remove button.

In the Create Expression Clones by LR task pane, you can modify the list of entry
clones and select a destination (pDEST) vector or vectors with which to create
expression clones.

Entry Clones

Any entry clones that you generated from the previous tasks in the workflow will be
listed in the Entry Clones list.

* To select new or additional entry clones in the database, click on the Add button
and select from the dialog box.

¢ To remove an entry clone from the list, select it and click on the Remove button.

e To clear the list, click on Clear All.

pDEST Vector

The pDEST vector is a type of Gateway® Cloning vector that contains at(R sites, which
are recombined with the fragments containing attL sites to create expression clones.

attL attL attR attR aitB attB attP aitP

entry destination expression by-product
clone vector clone

LR Clonase™ Il
_—

A variety of pDEST vectors are sold by Life Technologies, and in silico sequences for
these are installed as part of the default Vector NTI® Express installation.

IMPORTANT! To be recognized as a pDEST vector in Vector NTI® Express, a molecule
must contain the correct aftR1 and atfR2 sequences, and these sites must be labeled as
features in the molecule with the feature names attR1 and attR2. See Chapter 2,
“Molecule Editor” on page 39 for information on identifying and naming features.
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Gateway® Cloning workflow

To select a pDEST vector:
¢ C(Click on the Add button and select the pPDONR vector from the database.

e To remove a vector from list, select it and click on Remove.
e To clear the entire list, click on Clear All.

Create the Expression Clone

When you have made your selections, click on Create Expression Clone. The Preview
Expression Clones task pane will open.

The Preview Expression Clones task pane lists all the expression clones created from
the entry clones and the destination vector(s) you selected, and includes a preview
window for viewing an expression clone.

In the Expression Clones list:

e Select a clone and click on Save to Database to save it as a DNA molecule in the
database.

* Double-click on a clone to display it in the Preview window.

In the Preview window:

¢ Using the magnifying tools to zoom in and out of the molecule.

X EE

¢ Display the molecule as linear or circular by clicking on the appropriate button.

ﬂﬂr[[rf i;i
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TOPO® Cloning in
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Express

TOPO® Cloning

TOPO® Technology is a fast, efficient way to clone. The key to TOPO® Cloning is the
enzyme DNA topoisomerase I, whose biological role is to cleave and rejoin DNA
during replication. To harness this activity, vectors are linearized and each end is
conjugated with topoisomerase on the 3' phosphate. This enables fast ligation of DNA
sequences with compatible ends. After 5 minutes at room temperature, the enzyme is
released, the ligation is complete and the recombinant molecule is ready for
transformation into E. coli.

Many Life Technologies expression vectors are adapted for one-step TOPO® Cloning
of PCR products in both directional and non-directional formats. Other vectors contain
att recombination sequences exterior to the TOPO® cloning sites so that cloned inserts
are ready for entry into the TOPO® system.

TOPO® vectors can be grouped into three categories, based on the nature of their ends:

® Zero-Blunt vectors have two blunt ends and can accept blunt-ended DNA
fragments, including amplicons produced by a proofreading polymerase. Inserts
are cloned in both orientations.

e T-A vectors have two ends with 3’-T overhangs. They can accept products of PCR
amplification with a Tag polymerase, whose terminal transferase activity adds 3'-
A overhangs to the amplicon. Inserts are cloned in both orientations.

* In directional vectors one terminal is blunt ended and the other has a 5-GGTG
overhang on the bottom strand. PCR products are generated with a 5-CACC
extension on one end and this strand when unwound is preferentially annealed to
the vector overhang. More than 90% of the clones are in the correct orientation
and the time spent in screening colonies is thereby reduced.

The presence of topoisomerase enzyme also helps protect vector ends from
degradation, particularly from contaminating nucleases that may be present in ligase
preparations. Moreover, the avoidance of restriction site cutback for cloning PCR
products means that internal cleavage sites are not a problem.

Any linear, double-stranded DNA sequence of interest may be cloned into a TOPO®
vector using Vector NTI® Express. In addition, linear sequences with 3’-A overhangs,
the products of PCR amplification with a Tag DNA polymerase, may be cloned into
TOPO®-TA vectors. Such Tag-generated molecules can be generated in silico using the
TOPO® Cloning tool.

TOPO® Cloning Tool

Open the TOPQ®
Cloning Tool

The TOPO® Cloning Tool contains settings and functions for assembling a TOPO®
construct using the workflow described above, and for creating and managing TOPO®
Cloning projects.

There are several ways to open the tool:
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¢ C(Click on the TOPO Cloning button on the main toolbar. 7
¢ Select File > New > TOPO Cloning Project from the main menu. \.D

¢ With a molecule open in Molecule Editor, right-click in the Graphics or Sequence
pane and select Launch TOPO Cloning.

* Load an existing TOPO® Cloning project as described in “Create, save, and load
projects” on page 136.

The tool window is composed of the following panes:

TOPO® Project The TOPO® Project pane displays the name of the current project, and includes
pane controls for editing, saving, and closing projects. It also lists any generated molecules
for the current project.

Click on the TOPO Project button to display this pane.

) TOPO Project

=] General Info
TOPOCloningADRALA

{= The PCR Product of ADRALA_587_1414_T-A
=) FindPCRPrimers
=) Product of Length 830
Sense Primer

Antizenze Primer
Frimer Pair Data
Time: 10/12/2011 20:42:18

{C_] ToPO Project

@ Task
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TOPO® Cloning Tool

Task List pane The Task List pane displays the list of tasks in the selected project. Click on the Task
button to display this list.

As you navigate through the TOPO® Cloning workflow, the Task List displays the
current task, and allows you to move between tasks by clicking on a different task.

Current Task pane  This pane displays the commands and settings for the currently selected task in the
P p play & y
project. As you navigate through the Task List workflow, the functions in this pane
will change.

Fragments
Name Accassion From To Length Form Description
ADRALA ADRALA 1 2306 2306 Linear Homo sapiens adrenergic, slpha-14, T
CREB1 NM_004379 1 2964 2964 Linear Homea sapiens cAMP responsive elem..

PCR Amplification Setting

Analysis Conditions

Tmic] G0 Length
»= | 400 = | 35.0 = 12 @ona Orna
<= | 5.0 = | g0.0 <= |25
Cloning termini
) Blunt ®Ta () pirectional

Add to Oligo List
[[] Add generated primers to oligo list

Advanced

Amplify
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Create, save, and load projects

Create, save, and load projects

The tools for saving, editing, and closing projects are located in the TOPO® Project
pane:

) TOPO Project

=] General Info
TOPOCloningADRALA

* To save a new TOPO® Cloning project, click on Edit Project in the TOPO® Project
pane. In the dialog, enter a name and any description for the project.

¢ To save changes to a project, click on the Save Project button.

¢ To close a project, click on the Close Project button. If there are unsaved changes,
you will be prompted to save the project before closing.

¢ To load an existing project, in Database Explorer, go to the Projects list, open the
Cloning Projects folder in the Local Database, and double-click on the TOPO®
Cloning project in the list to open it.

@ Projects Name Descript... Author Modified Cloning Technology
i ADRA1A_TOPO_Project 2011-12-1009:59:33 TOPOCIoning_T-4
=1 Locsl Database CDK2 Gateway Cloning project 2011-12-1005:48:46 Gateway_attB1_attB2

Ii] Alignment Projects
Ii] Contig Azsembly Projects
Ii] Cloning Projects

+ Ii] Remaote Databaze

MNew Parts Assembler Project 2011-12-1101:37:1% BioBrick

[f] Database
Ea Projects
E Results

General Description

TOPO® Cloning workflow

The Task List displays the default TOPO® Cloning workflow:

» Amplify Fragments to Use in TOPO® Reaction
* Create TOPO® Clones
* Preview Clones

This section describes each task in the workflow.
Amplify fragments  The Amplify Fragments to Use in TOPO Reaction task is the default task displayed

to Use in TOPO® when you first open the TOPO® Cloning Tool.
reaction
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The first step in this task to select the fragment(s) you want to amplify by PCR for use
in a TOPO® cloning reaction. These fragments will be listed in the Fragments list.

Fragments
Name Accession
ADRALA ADRALA
BRAF NM_004333

From To Length Form

Description
2306 2306 Linear Home sapiens adrenergic, alpha-14-, ...

2510 2510 Linear Homo sapiens v-raf murine sarcoma vi...

Load molecules or fragments in the Fragments list

¢ With a molecule open in Molecule Editor, right-click in the Graphics or Sequence
pane and select Launch TOPO Cloning to load the entire sequence in the list.

e With a molecule open in Molecule Editor, select a portion of the sequence in the
Graphics or Sequence pane, right-click, and select Launch TOPO Cloning to load
only that part of the sequence in the list.

* With the TOPO® Cloning window open, make sure the Amplify Fragments to
Use in TOPO Reaction task is selected and click on the Add button under
Fragments to select a complete molecule from the database.

To change the regions to amplify in the selected molecules, type a new range in the
From and To fields in the Fragments to Amplify subpane.

PCR Amplification Settings

With the fragment(s) loaded, select the desired amplification settings under PCR
Amplification Settings. The standard options are described below.

Standard settings

Tm(C]) Enter limits in degrees Celsius for primer melting
temperature (T,,,) (temperature at which 50% of primer is
a duplex) and the difference between Ty, for sense and
antisense primers.

%GC Enter limits in degrees Celsius for primer melting

temperature (T,,,) (temperature at which 50% of primer is
a duplex) and the difference between T, for sense and
antisense primers.

Primer Length

Defaults to 20-25, recommended for TOPO® Primers

DNA/RNA button

Select the type of nucleotide sequence.

Add generated primers to oligo
list

Select this checkbox to add the primers you generate to
the oligo list

Cloning termini

In the options under Cloning termini:

¢ Choose Blunt to generate an amplicon with 2 blunt ends. These will be the exact
boundaries of the selection. These amplicons are best used with Zero-Blunt

TOPO® vectors.
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* Choose T-A to generate an amplicon as would be produced by amplification with
a Tag polymerase. The primers in such a case will anneal to the exact boundaries
of the selection. However, terminal transferase activity in the enzyme will add 3'-
A overhangs to each end of the amplicon.

* Choose directional for cloning in TOPO® directional vectors, e.g. pENTR-D/
TOPO®. The amplicon will be generated using primers, one of which includes a
5-CACC extension.

Advanced

For additional amplification settings, click on Advanced. The advanced amplification
settings are identical for all PCR primers, and are described in Chapter 3, Primer
Design.

Amplify

When you have made your selections, click on the Amplify button. The next task pane
will be displayed, and the generated PCR product(s) will appear listed in the Inserts
subpane, and also listed in the TOPO® Project pane.

) TOPO Project

=] General Info
ADRA1A_TOPO_Project

[=B The PCR Product of ADRA1A_500_2306_T-A
=) FindPCRPrimers
=) Product of Length 1809
=) Senze Primer
Start:1
GC:38.89
Length: 18
Sequence: TAACATTTCCAAGGCCAT
Tm:45.17C
dG:-29.41 keal/mael
dH:-141.0 keal/mael
d5:-368.3 cal/mal
=) Antizenze Primer
Start: 1792
GC:50.0
Length: 18
Sequence: TAACCAATGGCTATGGEGEC
Tm:42.34C
dG:-31.12 keal/mael
dH:-145.2 keal/mal
ds:-377.0 cal/mol
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Create TOPO® In the Create TOPO® Clones task pane, you can modify the list of fragments and
Clones select a vector or vectors with which to create TOPO® clones.

Inserts:

Name Accession Type Division Length Form Description
The PCR Productof AD... The PCR ProductofA..  T-A PRI 1809 Linear Home sapiens adrenergic, alpha-14-, r...
The PCR Productof BR... The PCR ProductofB... T-A PRI 2512 Linezr Homo sapiens v-raf murine sarcoma vi...

Vectors:

Name Accession Type Division Length Form Description

Add Clzarall

Inserts

The fragments you amplified are listed in the Inserts list at the top of the pane.

e To add a previously amplified fragment or a fragment designed with the
necessary overhangs by another means, click on the Add button and select the
molecule from the database.

e To remove a molecule from list, select it and click on Remove.

¢ To clear the entire list, click on Clear All.

Vectors

To select a vector:

¢ (lick on the Add button and select the vector from the database.
e To remove a vector from list, select it and click on Remove.
e To clear the entire list, click on Clear All.

Create the TOPO® Clone

When you have made your selections, click on Create TOPO® Clone. The Preview
Clones task pane will open.
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Introduction

GeneArt®
Seamless Cloning
Overview

GeneArt® High
Order Assembly
Overview

GeneArt® Cloning

Using Vector NTI® Express, you can create GeneArt® assemblies from DNA molecules
in the database. Simply select the fragments to be assembled and the software will:

* Analyze the sequences for homologies between the fragments
* Design PCR primers to create the necessary end homologies
* Design stitching oligos for use in GeneArt® High Order assemblies

¢ Display the assembled molecule with the specified primers and/or stitching oligos
in a single molecule file

For more information about GeneArt® technology, visit our web site at
www.lifetechnologies.com and search for “GeneArt.” Detailed technical information
for each type of GeneArt® assembly method is available in the following user guides:
GeneArt® Seamless Cloning and Assembly Kit User Guide and GeneArt® High Order Genetic
Assembly System User Guide. These are available for download from
www.lifetechnologies.com/manuals and are supplied with each kit.

GeneArt® Seamless Cloning Technology is a highly efficient, vector-independent
system for the simultaneous and seamless assembly of up to four DNA fragments plus
a vector totaling up to 13 kb in length (including the vector). The system allows the
cloning of the DNA fragments into virtually any linearized E. coli vector, does not
require pre-existing recombination sites or any extra DNA sequences, and eliminates
the need for extensive enzymatic treatments of the DNA such as restriction and
ligation. A single proprietary enzyme mixture recognizes and precisely assembles the
DNA fragments sharing a 15-base pair (bp) end homology that you can create by PCR
amplification.

The GeneArt® High-Order Genetic Assembly System is a highly efficient, vector-
independent system for the simultaneous assembly of up to 10 DNA fragments plus a
vector totaling up to 110 kb in length (including the vector). The system relies on
yeast’s ability to take up and recombine DNA fragments with high efficiency. This
process, termed transformation-associated recombination, greatly reduces in vitro
handling of DNA and eliminates the need for enzymatic treatments of DNA such as
restriction and ligation while allowing precise fusions of DNA sequences.
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How GeneArt® Assembly Works

How GeneArte Assembly Works

In GeneArt® Assembly, multiple DNA fragments plus a vector can be joined using
overlapping sequence homology between fragment ends to splice the fragments
together. If homology does not already exist between fragment ends, Vector NTI®
Express will automatically design PCR primers that you can use to add homology to
the fragments via PCR amplification. Alternatively, for High Order Assembly, up to
three sets of “stitching” oligos may be designed to create splices across fragments
without homology.

When the fragments and vector are assembled in Vector NTI® Express, the software
performs a homology check based on the rules for the GeneArt® Assembly method
you are using. The homology of the sequence ends will be analyzed, and in High
Order Assembly the internal sequences of the fragments will also be analyzed to
ensure that any internal homologies will not interfere with fragment splicing. Then
any required PCR primers—and/or, in the case of High Order Assembly, stitching
oligos—will be designed.

The rules for homology are described in detail in the GeneArt® Seamless Cloning and
Assembly Kit User Guide and GeneArt® High Order Genetic Assembly System User Guide.

Seamless Cloning: Workflow diagram and an example of PCR primers designed to generate a
15-bp fragment end homology:

| se——
s — . .
Linear vector Recombine DNA fragments _ Assembled
N circular construct
DNA fragments and linear vector

15-bp homology

[ 1
5°-GTG AAT TCG!GGC TCG TTA GGA CTA...-3" Forward Primer
N for Fragment 2
9-nt E 6-nt
Reverse Primer H

for Fragment1 3" —...ATA CCC CAC TTA AGCiCCG AGC-5"
'

Sequences specific Sequences specific
to Fragment 1 to Fragment 2

High Order Assembly: Workflow diagram and an example of PCR primers designed to generate a
30-bp fragment end homology:

x | x
IXI

-—
— X

Ix

Stitching

DNA fragments N
oligos

—_— —_—

Linear vector
Transformation-associated recombination

30-nt homology

Assembled construct

! ] ! Forward Primer
57-TCG AGC GCA TTT CGCiCGT AAA GCG AGT TTA TTA GGA CTA...-3" ¢o Fragment 2
'
15-nt ' 15-nt
Reverse Primer H

: :
for Fragment1  3"----GTG AAT TCG AGC TCG CGT AAA GCGIGCA TTT CGC TCA AAT-5°
]

Sequences specific : Sequences specific
to Fragment 1 i to Fragment 2
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Open the GeneArt® Assembly Tool

Open the GeneArte Assembly Tool

You can open the GeneArt® Assembly Wizard from the Molecule Editor with a
molecule loaded or from the main toolbar with no molecule selected.

Note: All molecules used in GeneArt® assembly must be linear.

From the molecule 1. With a linear DNA molecule loaded in the Molecule Editor, select the part of the
editor sequence you want to clone or make no selection to clone the whole molecule.

Note: The selected molecule or sequence must be >100 bp.

¢ Right-click and select Load in GeneArt or click on the GeneArt Cloning button

on the main toolbar.

2. Select the strand you want to analyze (Direct or Complementary).

3. The GeneArt Assembly Wizard will open with the molecule or sequence loaded.

From the main 1. With no molecule selected, click on the GeneArt Cloning button on the main
toolbar with no toolbar, or select Design > GeneArt Cloning.
molecule selected 2. The GeneArt Assembly Wizard will open with no sequence loaded.

GeneArt® Assembly Wizard with molecule selected
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GeneArt® Assembly Wizard

GeneArte Assembly Wizard

Assembly settings

Add and organize
fragments

144

The GeneArt® Assembly Wizard window lists the molecules and fragments to be
assembled and includes settings for assembly.
The tool includes different options for Seamless Cloning or High Order Assembly.
1. Select the appropriate Assembly option from the dropdown list.
2. Select the Molecule Form you want for the final assembly: Circular or Linear.

The Assembly Wizard has tools for adding and removing fragments and designating
their order of assembly.

Fragment requirements

A fragment for GeneArt® Assembly can be any molecule in the database that is >100
base pairs in length.

Add fragments

To add a fragment, click on the Add Fragment button and select a molecule from the
database.

Open Molecule g|
Database DMA/RMAS
Name Identifier Length Form #
ADCYT 4557254 E156 lingai
ADCY7 E136 lineai
Adenc2 35937 lineai
ADRALA 15451758 2306 lingai
ADRALA 2306 lingai
BaculoDirect Linear DNA 139370 lineai
BaculoDirect Linear DN.... 5770 lineai
BaculoDirect Linear DN.... 139370 circul
BaculoDirect\Linear\DNA 138370 linga
BaculoDirect\Linear\DN... 138370 circul %
£ >
[ OK ] [ Cancel

The molecule will appear added to the list in the tool.

Fragments

Vector Source DNA Order | 5Start Position | Fragment Length Orientation Amplify
¥ ADRALA v 1 2308 Forward N
N CDK2 1 1 2226 Forward N

Select the vector

One fragment in each GeneArt® assembly must designated as the vector. The vector
forms the base fragment onto which other fragments are added. The vector is always
the first fragment listed in the Wizard, and is flagged with a “V” in the Order column.
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Design PCR
primers to create
end homology

GeneArt® Assembly Wizard

To change the fragment designated as the vector, click inside the Vector column and
that fragment will be moved to the top of the list.

grtor Source DNA Order | 5Start Position | Fragment Length Orientation Amplify
Vector icon ADRALA v 1 2308 Forward N

Re-order fragments

The fragments will be assembled in the order in which they’re listed in the GeneArt®
tool, starting with the vector. The order of the fragments is reflected in the Order
column, which designates the vector with a “V” and numbers the rest of the fragments
in order.

To re-order the numbered fragments, select a fragment in the list and then click on the
Up or Down button to change its position. Note that you cannot move a fragment into
the Vector position using the buttons—select the vector as described above.

Fragments

Vector Source DNA Order | 5Start Position | Fragment Length Orientation Amplify
¥ ADRALA v 1 2308 Forward N
N BRAF 1 1 2510 Forward N

N CDK2 2 1 2226 Forward N

[ Add Fragment ] [ Remove Fra;ment] Total Length: 7042bps up[:

Figure 2 Clicking on the Up button to move a selected fragment up in the list.

Fragment orientation

The orientation of each fragment in the final assembly is indicated in the Orientation
column (Forward or Reverse). You can change the orientation by clicking in this
column.

Remove a fragment

To remove a fragment, click on it in the list to select it and then click on Remove
Fragment.

Vector NTI® Express Software can automatically design PCR primers for adding
homology to the ends of a fragment for GeneArt® assembly. In the PCR reaction, each
primer will add bases to the amplified fragment to create the necessary homology with
the adjacent fragment.

Note: If the fragments already have the required end homology, primer design is
unnecessary.
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Design stitching
oligos (High Order
Assembly only)

Note:

Create the
assembled
molecule
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GeneArt® Assembly Wizard

This primer design option is available for both Seamless Cloning and High Order
Assembly, though the length of the PCR primers varies between assembly methods,
based on their different end homology requirements. The primer design rules are
described in detail in the GeneArt® user guides. The PCR primer designs will be saved
with the final assembled molecule.

To design PCR primers to create the necessary homology for a fragment:
1. Click in the Amplify column for that fragment.

2. The N will change to a Y for that fragment.

ant Length COrientation Amplify

Foreard N

Reverse E A

For High Order Assembly, in addition to primer design to create end homology, up to
three sets of stitching oligos may be designed to create splices across fragments
without homology. These oligo linkers create a “bridge” across adjacent fragments to
promote recombinational joining in yeast.

A limit of three sets of stitching oligos may be used in a single High Order Assembly,
and if stitching oligos are used, a total of five fragments plus vector may be included in
the assembly. (This differs from a High Order Assembly without stitching oligos,
which can include up to 10 fragments plus vector.)

The stitching oligo rules are described in detail in the GeneArt® High Order Genetic
Assembly System User Guide. The oligo designs will be saved with the final assembled
molecule.

To select stitching oligos for a particular fragment:
1. With High Order Assembly selected, click in the Stitch column for that fragment.

2. The N will change to a Y for that fragment.

rientation Amplify = Stitch
rward N N

rward E ¥ N
S TN
rward N ¥

rward E ¥ N

1. When you have selected your desired settings in the GeneArt® Assembly Wizard,
click on the Next button.

2. Specify a name for the molecule in the database, as well as names for any PCR
primers and/or stitching oligos.
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3. The final assembly will be displayed in the Molecule Editor.

* The source fragments will be listed in the Feature Map under Misc Feature.

¢ C(lick on a PCR Primer or Stitch Oligo in the Graphics pane to highlight that
feature in the sequence.

¢ The PCR primers and stitching oligos are listed in the Analysis Results pane, and
will be added to the Ordering list.

Vector NTI® Express Software User Guide 147



14 GeneArt® Cloning
GeneArt® Assembly Wizard

148 Vector NTI® Express Software User Guide



Additional
Information about
Parts and
Standards

Parts Assembler

Using Vector NTI® Express Software, you can assemble standard DNA parts that
encode basic biological functions from molecules using defined assembly standards.
The standard DNA sequences defined in Vector NTI® Express have been developed via
an open technical standards-setting process led by the BioBricks Foundation.

At its most basic level, a part is any DNA sequence with a defined biological function
(e.g., a promoter region, a sequence encoding a protein, etc.). To join two parts
together, upstream and downstream sequences containing sites for specific restriction
enzymes are added to each part. This allows for the creation of larger parts by chaining
together smaller ones in any desired order. In the process of chaining parts together,
the restriction sites are removed, allowing the further use of those restriction enzymes
without breaking the new, larger assembly apart. To facilitate this assembly process,
each part itself may not contain any of these restriction sites.

Vector NTI® Express Parts Assembler is compatible with BioBrick" part standards. For
general information about the BioBricks Foundation, visit www.biobricks.org. For
information about parts and assembly standards, including instructions and tutorials,
visit http://openwetware.org/wiki/The_BioBricks_Foundation:Standards/Technical/
Resources.

The DNA sequences of thousands of public domain standard biological parts are
available through the Registry of Standard Biological Parts at http://partsregistry.org.

For a detailed description of the assembly standards, visit http://openwetware.org/
wiki/The_BioBricks_Foundation:Standards/Technical/Formats.

Note: BioBrick is a trademark of the BioBricks Foundation, Inc. The BioBrick
trademark is used herein merely for the purpose of fair use. The BioBricks Foundation,
Inc. is not affiliated with Life Technologies Corporation. The BioBricks Foundation, Inc
has not authorized, sponsored or otherwise endorsed this product or our use of the
BioBrick trademark herein. Information about BioBrick™ and the BioBricks
Foundation, Inc. can be found at www.biobricks.org.

Using the Parts Assembler

Selecting Parts

To open the Parts Assembler:

¢ (lick on the Parts Assembler button on the main toolbar. -
* Select File > New > Parts Assembler Project from the main menu. (=?

The Parts Assembler window is divided into two panes—one for each part you want to
combine.
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Using the Parts Assembler

Restrictions on
Parts

Assembly Settings

150

1. To select the first part that you want to assemble, click on the Open Molecule
button beneath the left pane, and select the molecule from the database. The
molecule must be compatible with a defined assembly standard, as described in
the following section.

2. Select the second molecule in the right pane.

Parts Assembler Workflow
2 Generalinfo BBa_A340620 BBa_B0010
Mew Parts Assembler Project 999hp 80bp
4 Fragment List
< b3l B3 b
Moleculel Molecule2
[EthmJE[t] [55“ PrDJE[t] [ Clase
Open Molecule Open Molecule
fl The compliant assembly standards)for this part The compliant assembly standard|s} for this part:
Farts Assembler Worl Assembly Standard 10; Assembly Standard 12; Assembly Standard 10; Assembly Standard 12;
» [ Assemble ] [ Exit

When you select a molecule, its sequence will be displayed in the pane and the
assembly standards that are compatible with that sequence will be listed at the bottom
of the pane. If the molecule does not conform to any of the standards, you will receive
a warning message.

Any molecule in the database can be selected as a part, as long it conforms one of the
assembly standards shown in the following table. To conform to an assembly standard,
the molecule must not contain the restriction enzyme digestion sites listed in the table
for that standard. Some standards also include additional rules. For more information
about assembly standards, visit http://openwetware.org/wiki/
The_BioBricks_Foundation:Standards/Technical/Formats.

Assembly Standard Parts must not contain the following restriction sites

10 EcoR |, Not |, Xbal, Spel, Pstl, Nhel, Pvull, Xho |, Avrll, Sap |

12 EcoR |, Spel, Nhel, Not |, Pstl

20 " EcoR |, Xbal, Spel, Sbf]

21 EcoR |, Bglll, BamH |, Xho |

23 EcoR |, Not |, Xba, Spel, Pst| (in addition, sequences must be
in frame without start or stop codons, and may not begin with
“TC”)

25 EcoR |, Not |, Xba |, NgoMI (aka NgoMIV), Agel, Spe |, Pst |

Note: If you are planning to create and share parts with other individuals and groups
using these standards, we recommend designing them so that they contain none of the
restriction sites listed for any of the assembly standards, to ensure maximum
portability.

When you have selected two molecules, click on the Assemble button at the bottom of
the window.
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Completing and
previewing the
assembly

Using the Parts Assembler

The Construct and Assemble dialog will open with options for assembly.

Enter a name for your new construct in the Name field.

Device Type

A “device” in is any construction that performs a particular biological function. The
Device Type section of the dialog allows you to characterize the type of device you are
constructing. This information will be included in the General Description information
of the assembled molecule.

The dropdown list includes standard types of devices. Alternatively, you can select
Unassigned from the list, or enter your own device description by selecting the Other
checkbox and typing in the field.

Chassis

Parts are typically integrated into the genome of a particular organism—ak.a. a
“chassis” —for propagation and functionality. You can specify the genome of the
organism that you will be using by selecting the appropriate checkbox or entering text
in the Other field. This selected chassis will be listed in the General Description
information of the assembled molecule.

Assembly Direction and Standard

Select the direction of each molecule to use for the final assembly, and select the
assembly standard to use from the dropdown list.

Note: If there is no shared assembly standard that will work with both molecules, this
dropdown list will be blank and no assembly will be possible.

When you click on OK in the Construct and Assemble dialog, the assembled molecule
will open in a Preview window.

You can use the tools in the window to magnify the assembly, or view it as a linear or
circular molecule.
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Viewing the assembly in Molecule Editor

Click on Save in the Preview window to save the assembly as a molecule in the
database.

Viewing the assembly in Molecule Editor

To view the assembled molecule in the Molecule Editor, open the Database Explorer
and open the molecule.

e 0 cres1 mjferel O eraF [ PartsAssembler1 72 =g %_g
= General Description C& Q C'S 1
DNA Partsassamblarl
orissamhe ) ) SCAR(83 Assembly Standard 10] -
DeviceType:Frotain Generator; Chassis:EscherichiaCali i
Length: 1087 bp. -
Form: Linear e
= Standard Fisids
T
Accession Number: PartsAssembler] PartsAssemblerl an
Refarances 1087bp B
(=} Comments. ot
insert: BBa_4340820 :E(
vector: BBa_BOC10
=

Properties
GC
TITACCTCCE

Feature Map

TTTTETTACE
TGECTTCECR
ACCGAAGCCT

Analysis Results

The assembled molecule consists of the two original sequences joined together with a
standard bridging sequence or “scar” created by the overlap of the restriction digested
ends. The scar sequence is determined by the restriction enzymes used in the assembly
standard, as described on the web pages mentioned earlier.

¢ The original parts are listed in the Components list in the Properties pane.

® The scar is listed in the Feature Map, and displayed as feature in the Graphics
pane.

* The General Description includes the information you entered about the
assembled part, including device type and chassis.
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Contig Assembly using
ContigExpress

ContigExpress is a program for assembling and editing sequencing fragments, either
in the form of text sequences or chromatograms from automated sequencers, into
longer contiguous sequences or “contigs.”

ContigExpress uses CAP3 to drive the assembly process. This widely-used sequence
assembly program can use quality value scores (QVs) in ends trimming, contig
construction and consensus calculation. It also produces excellent results when QVs
are unavailable. It is capable of using forward-reverse constraints to evaluate contigs, a
feature that helps in accurate placement of repetitive sequence fragments. It can also
identify and discard chimeric sequencing reads that frequently result from lane
tracking errors. One of the major strengths of CAP3 is its consensus generation
algorithm based on weighted sum of QVs.

ContigExpress analysis can be saved as a ContigExpress Project, which contains the
fragments, their assemblies, and assembly options. In ContigExpress, fragments can be
edited directly, with the chromatograms in full view. Changes are tracked and a
history is maintained. The contigs generated can be saved to theVector NTI® Express
database.

About this chapter

This chapter has the following sections:

Open ContigEXPress . ...ovvi it iiiii ittt ittt iiiieiineeennens 153
Manage ContigExpress projects .........covviiiiiiiiiiiiiiiiinnnn. 155
Add fragmentstoassemble.......... ..ot i 156
Fragment trimming ...........coiiiiiiiiiiiiiiiii ittt iiiieinnees 156
Assembly settings ...ttt e 160
Perform theassembly............coiiiiiiiiiiiiiiiiiii i 164
Save, delete, and rename contigs . .........ccciiiiii it i 165
View theassembly...... ..ottt 166
Translate the consensus sequence ...........coiiiiiiiiiiiiiinnnnns 168
Edit the contigsequence...........ooiiiiiiiiiiiiiiiiiiiiinennnnn. 169

Open ContigExpress

To open the ContigExpress tool:

* (Click on the ContigExpress button on the main toolbar.
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Open ContigExpress

ContigExpress
window

Contig Project pane

154

Manage project buttons —

Task List

* Load an existing ContigExpress project as described in “Manage ContigExpress

projects” on page 155.

The ContigExpress window consists of the following panes:

¢ Contig Project pane: In this pane, you open, save, and close projects; navigate
tasks; and add, organize, and assemble your sequencing fragments. This pane
includes the following features:

— Project management buttons
— Task List
— Contig/Fragment Tree

— Contig and fragment management buttons

* Fragment Sequence Viewer: Displays the sequence of the selected fragment and
any trimmed bases, as well as a chromatogram of the fragment

* Trimming/assembly settings (see pages 156-164): Settings for trimming and

assembling fragments

¢ Contig Viewer (shown on page 166): Displays the contig assembly in graphical
form, with the overlapping assembled fragment sequences and chromatograms
The Contig Viewer includes the following subpanes:

— Graph Pane

— Alignment Pane

Fragment Sequence Viewer

~{_] Contig Project

= GenerslInfo
DamoProject

[ New Project ] [ Edit Project ] [ Save Project ]

[ LDadFrDjE((] [E\(pnn:ijE((] [cmsgpmjm]

P view Fragments

B Trimenas

P 2ssemble contig
B view Contig

B Trim vector contaminations

Name Len

=] Fragments ni
[¥] ONE1CF 758
ONE13R 765
[¥] ONEISF 756

Contig/Fragment Tree —  H05s =

Manage fragments/
contigs buttons

ONE17R 759

ONE2R 747

ONE3R 755

ONE3R 756

ONEBR 770
£

Original Len.

758
755
218
784
767
758

5'trimme.

%

lcoooooowoo

' trimme.

&

e ooenpe oo

-

(C_] Contig Project

‘Add From File Add From Database
f e

[ =Assembly i3 =0

1 CAATT NTCGA TGATG GTTGA GATGT CTATA AGACA CACAT GAAGA GCCRA
51 AACAC TGETE CTCCA TTGTC TATTA TGAGC TCAAC AACCG TGTTG GAGAA
101 GCTIT CCATG CCTCC TCCAC ARGTG TGITG GTGGA IGECT TCACC TGAIC
151 CTTCA ARCAR CAGGA ACAGA TTTTE CCTTG GGCCT TCTGT CCAAT GTGAR
201 CCGAA ACTCG ACCAT TGAGA ACACC AGECG GCATA TTGGA AAAGG TGTGC
251 ATTTA TACTA TGITG GGGGT GARGT CTATG CCGRR IGCIT ARGTG ACAGC
301 AGCAT TTTTG TTCAC AGCCG GAATT GTAAC TTICA CCACG GTTIC CATCC
351 TACAA CTCTG TGTAR AATCC CCAGC GEATG CAGCC TARAC ATTTT TAACAR
401 RACCAR GRATT TGCTC AGCTT TIGGC CCAGT CTGTA RACCA TGGECT TIGRR
451 ACTCT CTATC AACTC ACAAA GATGT GCACT ATTCG CATGA CTTTT GICAR
501 GGGAT GGGET GCAGA ATETC ATCGC CAGGA TGTCA CARGC ACCCC CTGCT
551 GEATT GAGAT TCACC TGCAC GECCC CCTTC AATGE CTGCA TAARG TACTR
601 ACTCA GATGE GCTCA CCCCA TRATC CCATC TCCIC GETCT CITAR TGGAT
651 TAGGA TETTC CTECC TCTGE ATTCA TTGGA GCCAT GCATE TACTT GRAGE
701 AGTCA GACAC TTACT GGCAL ATGGE ACATT GGTAG TTTTT TTTTT TTARR
751 GICTT
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Manage ContigExpress projects

Manage ContigExpress projects

Save and rename a
project

Open a project

Close a project

Export a project

Navigate the Task
List

The tools for saving, editing, and loading projects are located in the Contig Project
pane:

=_] Contig Project

=] General Info
Mew ContigExpress Project_2012-1-12-8-18-56

[ MNew Project ] [ Edit Project ] [ Save Project ]

[ Load Project ] [EIPDI’tPI’DjEI:t] [ Close Project ]

>
’ Trim ends

’ Trim vector contaminations
’ Azzemble contig
’ View Contig

¢ To save a new project, click on New Project in the pane. In the dialog, enter a
name and any description for the project.

¢ To save changes to an existing project, click on the Save Project button.

¢ To change a project name or description, click on Edit Project.

* Toload an existing project in the database, in Database Explorer, go to the
Projects list, double-click on the Projects folder, select the Contig Assembly
Projects folder from the Local Database, and double-click on the ContigExpress
project in the list to open it.

* Toload an existing project that has been saved as a .cepx or .cep file, click on the
Load Projects button in the Project Properties pane and select the project from the
Open dialog.

To close a project, click on the Close Project button. If there are unsaved changes, you
will be prompted to save the project before closing.

To export a project as a .cepx file, click on the Export Project button and enter a project
name in the Export ContigExpress Project dialog.

Click on a step in the Task List to display the settings for that step.
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Add fragments to assemble

Add fragments to assemble

The tools for adding the sequence fragments to assemble are located below the Contig/
Fragment Tree.

Name Len... Original Len... S'trimme...

=) [[] Fragments
[] onelor 758 758 o
[] oMEL1R 755 755 o
[] oME13R 213 819 o
[] oMe1sF 784 784 o
[] oMe1sF 767 767 o
[] oMe17R 753 759 o
[Jonezr 747 747 1}
[Jonesr 755 755 1}
[Jonesr 756 756 1}
[ onesr 770 770 1}
[Jonesr 782 764 1}
[Jonesr 758 758 1}
[] ™wo11r 765 785 o
< ¥
[A:I:I From File] [A:I:I From Database] [Delete]
[ Azzemble ] [ Save Contig ]

As you add fragments, they are displayed in tree format with selection boxes that
allow to select individual fragments for subsequent trimming and assembly.

Add fragments To add individual fragments:

* C(lick Add from File to select a supported file type:

- GenBank (*.gb)

— FASTA (*.txt)

— ABI (*.abi)

— ABI1 (*.abl)

— Staden SCF (*.scf)

— Legacy ContigExpress project file, containing multiple fragments (*.cep)
e (lick Add from Database to select DNA molecules from the local database.

Note: Press the Ctrl or Shift keys to select multiple files/molecules.

Remove fragments  To remove fragments from the assembly project, select the checkboxes next to the
fragment names in the tree and click on the Delete button. This removes fragments
from the project only, and does not delete them from the database.

Rename fragments To rename a fragment, right-click on the fragment name in the list and select Edit.
Enter a new name for the fragment in the dialog box.

Fragment trimming

Fragment trimming is an operation performed on fragments to optimize sequencing
results and contig assembly. Trimming is performed on fragment ends to remove
unresolved or poor quality nucleotides based on chromatogram results. It is also used
to remove residue vector sequences from the fragments.
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Select fragments * To select or deselect fragments for trimming, click the checkbox next to each
to trim fragment name in the Contig/Fragment Tree.
¢ To select or deselect all the fragments in the list, click the top-level Fragments
checkbox.
Trim ends Click on Trim ends in the Task list of the Contig Project pane to select the settings that

determine how fragment ends are trimmed.

IR jcosnaunest Send |3 end | Post Trim
-] General Info DRemu\reDID:ksmuﬂ-s:ale peaks*=than | 3 | consecutive bases
DemoProject
Scanning entire fragment, trim util 5'end [ | 25 | bazes)contains < | 3 | ambiguities
[ scanning entire fragment, trim util 5'end | | 25 | bases)contains< | 3 | baseswithQV < | 10
[ Mew Project ] [ Edit Project ] [ Save Project ]
- - [ trimatiesst | 50 | bases
[ Load Project ] [EIPDI’[FI’I}]E[':] [cmse Fn}]e[t]
P view Fragments
o e

' Trim vector contaminations
’ Azzemble contig
’ View Contig

5 end settings

Remove blocks of off-scale peaks >=than ___ consecutive bases removes the
defined number of consecutive bases that are below acceptable criteria.
Scanning entire fragment, trim until 5" end ( bases) contains < ___
ambiguities trims poorly resolved bases.

Scanning entire fragment, trim until 5" end ( bases) contains < ___ bases
with QV < trims bases based on the defined chromatogram quality.

Trim at least __ bases is an arbitrary setting that may be based upon the fact that
your primers have “tails.”

3’ end settings

From max peak, trim from first block of ___ consecutive bases <___ % of max
value to the end removes bases in the defined region of the sequence whose
peaks do not meet the % value you define.

Scan entire fragment, trim until remaining 3’ end ( bases) contains <
ambiguities trims poorly resolved bases.

Scan entire fragment, trim until 3’ end ( bases) contains < ___ bases with
QV< trims bases based on the defined chromatogram quality.

Trim at least __ bases is an arbitrary setting that may be based upon the fact that
your primers have “tails.”

Post trim settings

Maximum remaining length bases sets the maximum length of the
fragment that must be left after trimming

Remove leading and trailing ambiguities removes poorly resolved nucleotides
that may be left after trimming

Remove poly A/T (more than consecutive) removes these nucleotides that
may be present if the sequence was flipped, producing a poly-T 5" end.
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Fragment trimming

Preview the trimmed ends

1. With the fragments to be trimmed selected in the Contig/Fragment Tree, click on
Calculate to preview the trimming results.

2. Click on a fragment name in the Contig/Fragment Tree to display the fragment in
the Fragment pane with the trimmed regions highlighted.

Trim locations are displayed as red nucleotides in the Fragment pane.

[ =aAssembly &2

L N A A A A A R VR

HAZCHWH WHMHMNH WHHMHMH HHMHNH HHMNH HHHRHN HHRRH HHRHZ GHHEHNH HHHHEH

51 WI TCARCR TICIN CGCHNG ATGET TGAGR TGIGT ATARGC AGACR GITAG
HHHH

101 GIGAC ACTAT AGRAT ACRAG CITGC TIGIT CITIT TGCAG RARGCT CRGRR

151 TARRAC GCICR ACTIT GGCAG ATCCE CGECC GCARAGR TCTGR ATICC GGEAGR

201 TIIGT CCHWNG CRGAT GCIGC TGECC TICIG GGRAT CCIGE ACTGT GATIR

251 CIGCE CIGER GRGCT GITAT CIGIA ACTGE ARGAC TCICC ATTAR CCIGC

Trim vector If you are sequencing inserts in cloning vectors, vector contamination trimming allows
contaminations you to trim the vector residues that have been amplified as part the sequencing
process, leaving only the sequence of interest in the resulting contig assembly.

Click on Trim vector contaminations in the Task list of the Contig Project pane to
select the settings that determine how vector residues are trimmed, and the vector file
containing the sequence to be trimmed.

[fj Contig Project ] =Assembly 3
Commeon Settings
=] General Info

DemoProject Penalty -5 | ExpectValue | 700

GapOpen | 3 | Gap Extend 3

Vector List

[ MNew Project ] [ Edit Project ] [ Save Project ]
[ Import... ] [ Databaze... ] [ Remove
[ Load Project ] [EIPDI’tPI’DjEI:t] [Cluse Prujel:t]
’ View Fragments
. Vector Name Length | Description
’ Trim ends

’ Trim vecter contaminations pcDNA2.1_backbone 1732 pcDNA2.1_backbone

’ Azzemble contig
’ View Contig

Note: When vector trimming is performed, the vector sequence and its reverse
complement is automatically used, so that forward and reverse sequencing reads can be
trimmed using one setup.

Vector trimming settings

The Common Settings in this pane are as follows:

* Minimum vector overlap is the minimum number of bases in the fragment that
overlap with those on the clone. This setting must be 5 or greater.

* Minimum vector overlap with ambiguities includes poorly resolved residues
* Vector match threshold is the % required to match

¢ Remove additional ... from 5’/3’ end... refers to the additional bases to be
removed
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Select the vector sequence

To add a vector sequence to the list of sequences to the Vector List:
¢ Click on Import to import a vector sequence from a .fasta or .gb file, or
* Click on Database to select a file in the database.
¢ (Click on Remove to remove a file from the list.

Note: The vector sequence may be an existing sequence file, or you may want to create
a sequence file containing the specific residues to be trimmed.

Preview the trimmed vector contaminations

1. Select the fragments to be trimmed in the Contig/Fragment Tree. Make sure the
vector(s) you selected were used to amplify the selected fragments.

2. Click on Trim to preview the trimming results for the selected fragments.

3. Click on a fragment name in the Contig/Fragment Tree to display the fragment in
the Fragment pane with the trimmed regions highlighted.

Trim locations are displayed as red nucleotides in the Fragment pane.

[ =aAssembly &2

L N A A A A A R VR

HAZCHWH WHMHMNH WHHMHMH HHMHNH HHMNH HHHRHN HHRRH HHRHZ GHHEHNH HHHHEH

51 WI TCARCR TICIN CGCHNG ATGET TGAGR TGIGT ATARGC AGACR GITAG
HHHH

101 GIGAC ACTAT AGRAT ACRAG CITGC TIGIT CITIT TGCAG RARGCT CRGRR
151 TARRAC GCICR ACTIT GGCAG ATCCE CGECC GCARAGR TCTGR ATICC GGEAGR
201 TIIGT CCHWNG CRGAT GCIGC TGECC TICIG GGRAT CCIGE ACTGT GATIR
251 CIGCE CIGER GRGCT GITAT CIGIA ACTGE ARGAC TCICC ATTAR CCIGC

Additional notes on vector trimming

Trimming contamination from TOPO® cloning projects

e TOPO® vectors are represented in the Vector database as they are supplied and
used, i.e., as linear molecules. In this form, it is impossible to define a polylinker
crossing both cloning termini. We recommend temporarily converting the vector to
circular (DNA/RNA menu > Edit > DNA/RNA Molecule tab) in order to define a
suitable polylinker.

* Many TOPO® vectors are highly symmetric about the 2 cloning termini. Use of
the default trimming parameters may trim the entire read. We recommend values
of >=15 for the overlap size and >= 85 for the match threshold.

Trimming an intronic sequence from sequencing reads of amplified exons

You can use vector trimming operations to remove intronic sequences from amplified
exons. In these workflows, the sequencing reads are often primed from sites in the
intron regions. To do this, it is necessary is to create a polylinker that joins together
direct strand sequence from before and after the exon under investigation.

1. Using Vector NTI® Express Software, open a file containing the annotated exon
bounded by intron sequence.
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Assembly settings

2. Make a continuous selection from 50 bases before to 50 bases after the exon, i.e.
the exon as well as 5" and 3’ intron sequence.

3. Use the selection to create a new linear molecule. Name it to indicate that it is an
exon polylinker.

4. Open the exon polylinker file, select the exon and delete it. Then save the file
containing the two concatenated intron sequences.

5. Select the file in the Trim vector contaminations task and proceed with trimming.

Assembly settings

Click on the Assemble contig in the workflow the view the assembly settings.
E] Contig Project Assembly | Clipping || Overlap | Contig | Lite Settings
e —— Use Quality Values(QVs) where available
DemoProject Dete:tChimeri: Reads
Use Forward-Reverse Constraints

F/ R Constraints

[ MNew Project ] [ Edit Project ] [ Save Project ] Forward Reverse Delimiter | .

s r

[ Load Project ] [EIPDI’tPI’DjEI:t] [Cluse Prujel:t] X ¥ ey

Max. Dist. | 6000

’ View Fragments
’ Trim ends
’ Trim vector contaminations Default

’ Azzemble contig
’ View Contig

Assembly tab

There are three main check boxes to control some important aspects of the sequence
assembly process, as shown in the table below:

Assembly Options

Use Quality Values When available, base quality values (QVs) are used to trim
poor-quality ends, compute overlaps between reads, construct
multiple sequence alignments, and generate a consensus
sequence. Use of such scores is optional; when they are
unavailable, assembly will still proceed. Default ON.

Detect Chimeric Reads Chimeric reads consist of pieces from different parts of the
sequence region, usually generated as artifacts. They are
identified based on overlap conflicts and are excluded from the
construction of contigs. The mechanism of detecting chimeric
reads can be enabled or disabled with “Detect Chimeric
Reads” check box. Default: ON
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Assembly Options

Use Forward-Reverse When reads from both ends of subclones are available,
Constraints constraints are satisfied if they lie on opposite strands of a
double-stranded DNA molecule and within a specified
minimum and maximum range. This corrects assembly errors
due to misplacement of reads containing repeat sequences
and minimizes occurrence of singletons. A few unmet
constraints are allowed. However, if a sufficient number of
constraints are not satisfied by a join AND they all suggest an
alternative one supported by the overlap information, the
alternative join will be made. For most small- and moderate-
sized projects, it is not necessary to use this feature, unless in
a situation involving large region of repeats. Default: OFF.

The Assembly Tab contains some detailed settings related to the use of forward-
reverse constraints. All these settings are disabled when Use Forward-Reverse
Constraints is unchecked, and are enabled and editable when checked.

Forward and reverse reads must be named identically up to the delimiter (default =
dot), and must contain paired suffixes thereafter (e.g., .s & .r or .x & .y). Suffixes may
be added and deleted. Only the letter immediately following the delimiter is
recognized as the suffix. Other letters following it, if any, do not contribute to the
identity as forward versus reverse end sequence; however, they do distinguish one
forward/reverse pair from another, thus making two sequence pairs with the matching
reverse/forward end sequence. Minimum and maximum distances may also be edited.

Note: Take care when defining file names at the sequencer, especially when a project is
loaded in batches over several days. Entries with misplaced suffixes (e.g.
<filename>F.<projectName>, instead of <filename>.F<projectName>) will be
overlooked by the constraints feature, although they may be included in an assembly.

e Min. Dist. - Minimum Distance between the forward and reverse reads. Default:
0.

e Max. Dist. - Maximum Distance between the forward and reverse reads. Default:
6000.

* Delimiter — the letter separating main part and suffix part in read names. In cases
that there are multiple occurrences of the designated delimiter, the rightmost
delimiter is selected.

The values of minimum and maximum distance are uniformly applied to all sequence
pairs.
Clipping Tab

Sequence clipping based on quality and similarity is an essential step in the overlap
computation and assembly process and ensures validity and correctness. You can
control and fine-tune the clipping process through adjusting the parameters on the
Clipping tab.
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Assembly settings

Note: The clipping is irreversible and iterative within each project. When multiple
assemblies are made within a project, each round of clipping applies to the sequences
that had been clipped in the last round of assembly. This implies that a later attempt to
assemble may affect the existing assemblies. In such cases, ContigExpress generates a
warning message. If you choose to proceed, click on the Yes button. The affected
contigs will be dissolved. If you choose not to proceed, click on the No button and the
current assembly will be stopped.

¢ Use Automatic Clipping —Ends of sequencing reads are usually unreliable and
low in QV values. CAP3 comes with a mechanism to detect and clip these poor
end regions based on sequence similarities with or without QVs. Clipping is done
before the computation of overlaps. Note: trimming is available in ContigExpress,
in addition to CAP3 clipping, and can be carried out before loading input
sequences into assembly projects. Default ON.

* Match Score Factor — Also used in calculating Similarity Score for computing
overlaps, but only editable in the Clipping Tab. Match Score Factor is a positive
integer to award each match between two bases from the pair of sequences being
compared during the banded Smith-Waterman alignment. Default: 2.

¢ Mismatch Score Factor — Also used in calculating Similarity Score for computing
overlaps, but only editable in the Clipping Tab. Mismatch Score Factor is a
negative integer to penalize each mismatch between two bases from the pair of
sequences being compared during the banded Smith-Waterman alignment.
Default: -5.

* Gap Penalty Factor —Also used in the computation of overlaps, but only editable
in the Clipping Tab. Gap Penalty Factor is a positive integer to penalize each gap
extended during the banded Smith-Waterman alignment. Default: 6.

¢ Quality Cutoff for Clipping — Quality Cutoff for Clipping applies to the clipping
of a poor end region for each read when QVs are provided. It is not used when
QVs are not available. The specified value is used to find the low-quality ends of
reads, where the quality value of a base is considered low if it is less than this
value. Default: 12.

* C(Clipping Range — Clipping Range applies to the clipping of a poor end region for
each read regardless of whether QVs are available. The value is used to extend the
ranges for clipping further away from the ends based on the low-quality positions
at each end as determined with the Quality Cutoff for Clipping value. The larger
the value of Clipping Range, the more extensive the clipping for poor end regions.
Default: 250.

* Min Num Good Reads at Clip Position — This is the depth of good coverage at
the clip position. It applies to the clipping of a poor end region for each read
regardless of whether QVs are available. Depending on the actual depth of
coverage, the Minimum Number of Good Reads at Clip Position parameter
determines the exact clipping position within the clipping region. The larger this
value is, the more extensive the clipping becomes. Default: 3.

Overlap Tab

Overlaps between reads are computed immediately following sequence clipping. This
step serves as the basis for contig construction. In order to ensure the quality, each
overlap is evaluated with a few measures. You can change the rigor of overlap
computation. The parameters are explained below:

* Overlap Length Cutoff - Minimum length required for the length in base pair of
all the overlaps. Default: 40.
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* Overlap Percent Identity Cutoff — Minimum percent identity of the overlap.
Default: 0.80.

¢ Overlap Similarity Score Cutoff - Minimum similarity score for an overlap. The
score is computed as the sum of match, mismatch or gap scores for each pair of
bases weighted by QVs. Default: 900.

* Base Quality Cutoff for Difference — Determines the minimum overlap quality
by examining the differences of the overlap at bases of high quality values. This is
useful only when QVs are available. The Base Quality Cutoff for Difference value
defines “high quality” bases. Default: 20.

* Max QV Sum at Difference — Applies only when QVs are available. Each overlap
is given a “difference score” based on the QVs and the Base Quality Cutoff for
Difference. An overlap with a difference score over the Max QV Sum at Difference
value is excluded from contig construction. Default: 200.

* Max Clearance for Error Rate — Applies even and especially when QVs are not
available. If the error rate of the overlap is greater than the sum of those of the
overlapping fragments plus this value, the overlap is not used for assembly. The
smaller the value, the better the quality control of the overlaps. Default: 30.

* Band Expansion Size — This parameter specifies band expansion size. The
program automatically determines a minimum band of diagonals for an
overlapping alignment between two sequence reads. The band is then expanded,
in each direction, by a number of bases specified here. This affects the
computation of both potential overlaps and true overlaps. Default: 20.

* Max Gap Length — This is the maximum gap length allowed in an overlap.
Default: 20.

¢ Max Num Word Matches - This parameter controls the fast method for finding
potential overlaps between a pair of sequences. For each word in one read, at
most Max Num Word Matches occurrences of the word in the other read are
considered for non-gapped extension. A larger value forces the program to
consider more word matches at the expense of time and computer memory.
Default: 300.

* Max Overhang Percent Length — This parameter controls the different overhang
regions before or after the aligned region. It is defined as 100 times the total length
of the different overhang regions divided by the length of the overlap. Overlaps
with a value greater than the maximum cutoff are not used for assembly. Default:
20.

Contig Tab

Contig Tab includes parameters affecting construction of contig and multiple sequence
alignments, thus the consensus sequences. QVs are used extensively during this
process, if they are available. If unavailable, the program assigns a QV of 10 for each
base. Three of the parameters, Match Score Factor, Mismatch Score Factor and Gap
Penalty Factor, are editable only on Contig Tab.

* Match Score Factor -Match Score Factor is a positive integer to award each match
between the existing alignment and the sequence being added when calculating
the score of global alignments. Default: 2.

¢ Mismatch Score Factor -Mismatch Score Factor is a negative integer to penalize
each mismatch between the existing alignment and the sequence being added
when calculating the score of global alignments. Default: -5.
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Gap Penalty Factor —Also Gap Penalty Factor is a positive integer to penalize each
gap extended when calculating the score of global alignments between the
existing alignment and the sequence being added. Default: 6.

Min Num Constraints Correction — This is the minimum difference between the
numbers of constraints satisfied in the current assembly and in the alternative
assembly. A difference greater than this value, if the contig is also supported by an
alternative set of overlaps, results in the alternative join.

Min. Num Constraints Linking — This is the minimum number of constraints for
reporting a link between two contigs.

Lite Settings Tab

In ContigExpress, you can create two different types of contigs, Full Contigs or Lite
contigs. On the Lite Settings tab, you can specify the type of contigs you want to
assemble in the project.

In Full contigs mode, chromatogram data are retrievable and-sequence editing
performed in the Contig Viewer are reflected in the individual fragment files.

Lite contigs disregard fragment chromatogram data and there is no dynamic
association between a Lite Contigs and its component fragments. Editing done on
Lite Contigs is NOT reflected in the original fragment sequences (original
sequences remain unedited). Assembly in Lite Contig mode reduces memory
consumption and is, therefore, the preferred contig type for assembling large
projects.

Lite Settings Parameters

Discard chromatogram Check this box to discard sequence file chromatogram data
data on import when the sequences are imported. Check this box before you

import your sequence reads. Note: you can also discard
chromatograms for all fragments afferimport using Project >
Discard All Chromatograms command.

Full Contigs only Check this box to perform assembly in Full Contig mode. You

can retrieve chromatograms and maintain dynamic links
between the contigs and their component reads.

Lite Contigs only Check this box to perform assembly in Lite Contig mode. All

linkage between the contigs and sequence reads will be lost
and no chromatogram is retrievable in the Contig Viewer.

Lite contigs if selected Creates Lite Contigs during the assembly process only if the
more than <#> fragments | selected number of fragments is greater than the number

specified; otherwise creates full/ reqgular contigs.

Perform the assembly

164

After you have selected the trimming and assembly settings, select the fragments you
want to assemble in the Contig/Fragment Tree and click on Assemble.

Assembly may take some time, depending on how many fragments you selected.
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Save, delete, and rename contigs

When assembly is complete, the assembled contig(s) and any unassembled fragments
will be listed in the Contig/Fragment Tree (shown below) and displayed in the Contig
Viewer (see next page).

Name Len... Original Len... S'trimme... 3'trimmeg

=I-[] Contig1
D ONE10OF &EB 758 70 o
D ONE11R 717 755 38 o
D ONE13R 219 819 o o
D OME15F 567 784 7E 141
D OME1EF B29 767 o 78
=I-[] Centig2
[Jonesr 755 755 1} [
D OMEER 753 770 o 17
=I-[] Centig3
[Jonesr 756 756 1}
D ONEBR 718 764 44
=[] Fragmentz i
D OMNE17R 758 758 o o
D OME2R 747 747 o o
D ONESR 758 758 o o
[] mwo11r 765 0 0
£ >
[A:I:I From File ] [A:I:I From Database ] [ Delete ]
[ Azzemble ] [ Save Contig ]

Note: If a contig cannot be created from the fragments, an alert box will be displayed.

Note: Although Vector NTI® Express does not have an exact upper size limit for a
ContigExpress project, your project size may be limited by available computer
resources. If you do encounter an “out of memory” situation, you should consider
assembly in Lite Contig Mode (see “Lite Settings Tab” on page 164). Many a times the
“out of memory” problem occurs due to the presence of too many assemblies in the
ContigExpress Project. In this case, you are advised to delete some of these assemblies
as described below, save the project, and restart ContigExpress. Limiting the number
of assemblies in a project is always a good idea with large projects. If you decide to use
Lite Contig Mode but don’t want to lose the linkage between your contigs and
fragments, you can discard chromatogram data (see “Lite Settings Tab” on page 164)
and trade the ability to invoke chromatograms for a larger capacity.

Save, delete, and rename contigs

Save contig
assemblies

Delete a contig
assembly

Re-assemble
contigs

Most of these commands are located below the Contig/Fragment Tree.

¢ To save all the contig assemblies as separate DNA/RNA molecules in the
database, click on Save Contig below the Contig/Fragments List

¢ To save the contig assemblies as part of the project, click on Save Project at the top
of the Contig Project pane.

To delete a particular contig assembly, select the checkbox for the contig in the Contig/
Fragment List and click on Delete.

You can select fragments in contigs and re-assemble them. Select the checkboxes next
to the desired fragments in the Contig/Fragment List and click on Assemble.

The existing assemblies will be deleted and replaced with the new ones.
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View the assembly

To rename a contig, right-click on the contig name in the list and select Edit. Enter a

Rename a contig
new name in the dialog box.

View the assembly

Click on contig name in the Contig/Fragment List to display the assembly in the
Contig Viewer.

Contig Viewer Graph Pane

Click on contig name in tree

Contig Viewer Alignment pane

The Contig Viewer contains two panes:
* The Graph Pane displays a graphical representation of the contig assembly

¢ The Alignment Pane shows the assembled fragment sequences, chromatogram
data, and translated sequence.

Contig Viewer The Contig Viewer Graph Pane contains horizontal arrows representing the relative
Gra ph Pane positions of the fragments forming the contig. The arrowheads indicate whether the
respective fragment is in the direct or complementary strand, with the names of the
fragments displayed above the fragment lines.

Vector NTI® Express Software User Guide

166



Contig Viewer
Alignment pane

Scale

View the assembly

Contig coverage bar

The Contig Coverage bar spans the length of the contig and contains segments of
varying patterns/colors that represent the amount and type of fragment coverage in
that segment.

OMESR: 5

OMEGR.:45< <755

TWO11R:1<<5679

Contig Coverage Bar

The patterns and colors are:
¢ Single fragment — gray bar with slants
e Two fragments in the same direction — red cross-hatching
* Two fragments in different directions — blue checkerboard
* Multiple fragments in both directions - solid blue bar

The Contig Alignment Pane displays the nucleotide sequences of the fragments that
form the contig, with overlapping regions aligned appropriately and displayed
relative to their positions in the contig.

The consensus sequence is displayed below the fragments, and chromatograms for the
fragments are displayed. Translations can be identified and displayed. You can edit the
sequences here and see how your actions are reflected in the contig alignment and
consensus.

Use the horizontal and vertical scroll bars in the Alignment Pane to view the fragment
sequences, overlapping regions, and consensus sequence.

Fragment

780 0 750 750 800 810 820 830 240
i 1 ; : ! h I ! h

=]

ACTACCAATGTCCCATTTGCCAG-TAAGTGTCTGACTCCTTC

sequence

<< ONE11R

ACTACCAATGTCCCATTTGCCAEG TAAZGTGTCTGACTCCTTC

0l X000 s OO I N
ACTACCAATGGCCCATTTGCE

CT T GCTCCCHNCHAGACTTTAZAAANANNE CAGCTNAGNGTHNTGACTCCTTC
ATATHGCTCCCHCHAGACTTTAAAANA AATNQTACCAATGGCCCATTTGCCAGCTHAGHGTHTGACTCCTTC

Overlapping region

Chromatogram

= ONE1GF

>> ONESR.

data

Consensus
sequence

<< ONESR.

XY m.&..*m&tu\imi-.«m A‘)‘_/mm A e Dot ULk

GGCTTATCGCTCCCCCAAGACTTTAAALAAAAALARMAACTA TGTCCCATTTGCCAG-TAAGTGTCTGACTCCTTC
GCTTATCGCTCCCCCALAGACTT TAAAALALAALAACTA LCAATGTCCCATTTGCCAG TAAGTGTCTGACTCCTTC

it A4 A ol

TCAAGTAGATGAGT
TCALAGTAGATGAG

TCAAGTA
TCALGTA

e e

3

4
CONTIG  TCAAGTAGAT GAGGGGCTTATCGUTCCCCCAAGACTTTAAAAAAAAARAARAACTACCAATGTCCCATTTGCCAG-TAAGTGTCTGACTCCTTCA
* * % * %% = + + = * =

Positions with Ns Ambiguities or gaps
are flagged with * are flagged with +
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Translate the consensus sequence

Symbols in the sequence
¢ In the consensus sequence, asterisks (*) indicate positions containing Ns and plus
symbols (+) indicate ambiguity and/or gaps.
* In the fragment sequence, gaps are indicated by a hyphen (-) symbol.

Highlight a region

Drag your cursor over a region in the Graph Pane to highlight that region in the
Alignment Pane, and vice versa.

Find Next/Previous Ambiguous Symbol

To search the consensus sequence for ambiguous positions or symbols (“N” or “R”),
click on the Find Next Ambiguous or Find Previous Ambiguous buttons to the right
of the Graph Pane, or right-click on the consensus sequence and select the commands
from the right-click menu.

=L

g:/
G:

If an ambiguous position or symbol is found, its position is selected and displayed. If
there are no more ambiguous symbols in the specified direction, an alert pops up.

Hide or show chromatograms

Chromatograms are displayed for each fragment in the contig. The colored peaks in
the chromatogram correspond the colored bases below the editable sequence in the
Alignment Pane.

* To hide the chromatogram for a fragment in the Alignment Pane, right click on
the fragment sequence and select Hide <fragment name>.
¢ To re-display the chromatogram, right-click and select Show <fragment name>.

¢ To hide or show all chromatograms, right-click in the Alignment Pane and select
Hide all chromatograms or Show all chromatograms.

Translate the consensus sequence

168

To translate the consensus sequence, right-click on the sequence and select
Translation, or click on the Translation button on the toolbar to the right of the Graph
Pane.

The translated sequence appears below the consensus sequence in the Alignment
Pane.

Note: Ambiguous positions in the consensus are translated as a single, defined amino
acid if codon degeneracy permits (i.e. GGN = Gly). Gaps in the consensus are ignored
in the translations.
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Edit the contig sequence

Edit the contig sequence

Insertions

Deletions

Saving sequence
changes

You can edit the contig sequence in the Alignment Pane by clicking within the black
text sequence of a particular fragment (above the colored text) or clicking in the
consensus sequence and typing IUB characters or pressing the Delete or Backspace
keys.

All editing changes in the fragments cause an immediate recalculation and redisplay
of the consensus sequence. If necessary, editing changes in the contig consensus are
reflected immediately in the fragment sequences that comprise the contig.

Note: Since fragments in a contig can also be present in contigs from other assemblies
in the project, such edits are allowed only after you confirm that you are aware that
any other assemblies containing the fragment may be dismissed.

You can enter A, T, G, C, N and other acceptable ambiguous nucleotide designations
specified by IUB codes (refer to Appendix A, Symbols and Formats: IUB (IUPAC)
Ambiguity Codes and ASCII Format).

Insertions made in the consensus will be updated to all fragments that map to that
position in the consensus.

Note: Gaps will appear in the fragment chromatograms as you add symbols.

In the Alignment Pane, position the cursor immediately ahead of the desired position
in a fragment or the consensus and press the Delete button on the keyboard one or
more times. You can also select a continuous stretch of bases and use the keyboard
Delete button to remove them. Deletions in a fragment will update the consensus.
Deletions made in the consensus will be updated to all fragments that map to that
position in the consensus.

Since fragments in a contig can also be present in contigs from other assemblies in the
project, such edits are allowed only after you confirm that you are aware that any other
assemblies containing the fragment may be dismissed.

Sequence changes are saved with the project, or if you save the contig as a separate
molecule. They do not change the fragment molecule itself in the database.
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Edit the contig sequence
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A Symbols and Formats: IUB (IUPAC)

Ambiguity Codes and ASCIlI Format

Format for ASCIl Sequence Files

An ASCII sequence file must obey the following rules:

It must be a plain (ASCII) text file.

The file must contain the nucleotide (amino acid) sequence arranged in lines.
Each line may contain the following:

Nucleotide (amino acid) symbols and white space, or

A number followed by white space and nucleotide (amino acid) symbols
(therefore, similar to GenBank format), in which case the number will be ignored,
or

A number only, in which case the number will be interpreted as a block of
unknown nucleotides (amino acids) of the corresponding length.

IUB Formats recognized by Vector NTI® Express

The following characters, defined by the International Union of Biochemistry (IUB),
are used to represent nucleotides throughout Vector NTI® Express:

Symbol Meaning

>

adenine

thymine

cytosine

guanine

purine(A or G)

pyrimidine(C or T)
AorT
CorG
AorC
TorG

C,GorT
T, G, or A
C,AorT
C, G, orA

unknown nucleotide

ZI < I O w XXX 0 s < oo ol 4
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Symbols and Formats: IUB (IUPAC) Ambiguity Codes and ASCII Format
IUB Formats recognized by Vector NTI® Express

Amino acids are represented by standard 1- (or 3-) letter codes:

1-Letter Symbol 3-Letter Symbol Meaning
E Glu Glutamic acid
G Gly Glycine
H His Histidine
| Ile Isoleucine
L Leu ' Leucine
K Lys Lysine
M Met Methionine
F Phe Phenylalanine
P Pro ' Proline
S Ser Serine
T Thr Threonine
W Trp Tryptophan
Y Tyr ' Tyrosine
\ Val Valine
B Asx Asparagine or Aspartic acid
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Primer Tm Calculations

General Information

Vector NTI® Express calculates and reports two different melting temperatures for
DNA/RNA oligonucleotides, Thermodynamic Tm (Therm. Tm) and %GC Tm .

Usefulness of Thermodynamic Tm Versus %GC Tm

Vector NTI® Express reports both the Thermodynamic and %GC Tm values, regardless
of the length of the oligo. However, generally only one of the reported ™ values
should be considered useful, depending on the length of the oligo as follows:

¢ Therm. Tm — useful for oligos that are greater than about 7-10 residues and less
than about 35 residues long

*  %GC Tm — useful for oligos greater than about 35 residues long

Note: For oligos that are 7-10 residues or shorter (cutoff length depends on the base
content of the particular oligo being analyzed), Vector NTI® Express reports a Therm.
Tm value of zero.

Effects of Primer (Probe) and Salt Concentration on Tm
Calculations

Tm calculations are highly dependent on primer and salt concentrations; varying these
concentrations can greatly affect the Tm for any given primer. Therefore, it is
important that you adjust the primer and salt concentrations appropriately so that
accurate Tm values are generated.

Note: In Vector NTI® Express, the default parameters for primer and salt concentration
are 250 pM and 50 mM, respectively, for calculating Tm values. Other Tm calculators
commonly use a default probe concentration of 50 nM. Because of this, Vector NTI®
Express default parameter Tm values may not correspond to the default Tm values
calculated using other programs. Before comparing Vector NTI® Express Tm values
with those generated by other Tm calculators, make sure that the parameters are
adjusted appropriately.

%GC Tm Calculation

The %GC Tm calculation1 does not rely on the thermodynamic properties of the oligo
(i.e. dHo, dSo and dG°® values). The formula for %GC Tm is as follows:

Tm =81.5 + 16.6(log[Na+]) + 0.41(%GC) — 675/probe length
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Primer Tm Calculations
Thermodynamic Tm Calculation

Note: [Na+] is in molar units.

Example: For oligo GTGCGAGGCAGCTGCGGTAA at 50mM salt:
Tm =81.5 + 16.6(10og(0.05)) + 0.41(65) — 675/20
=81.5 +16.6(-1.30) + 26.65 — 33.75
=81.5-21.58 + 26.65 — 33.75
=52.82°C

Thermodynamic Tm Calculation

The Thermodynamic Tm calculation is based on the Nearest Neighbor theory of DNA/
RNA duplex stability. Briefly, this theory states that the overall duplex stability (and,
hence, the melting temperature) of an oligonucleotide can be predicted from the
primary sequence based on the relative stability and temperature-dependent behavior
of every dinucleotide pair in the oligo2. In practice, enthalpy (dH®) and free energy
(dG°®) values for each of the 10 possible Watson-Crick DNA pairwise interactions are
used to calculate pairwise entropy (dS°) values via the following standard equation:

dG°=dH° - TdS°®
Note: T is temperature in °K.
The pairwise dH® and dS° values are then summed to calculate overall values for the

oligo under consideration. The overall values are used in the following formula3 to
calculate the Thermodynamic Tm:

Therm. Tm = dH°- 273.15 + 16.6(log[Na+]) dS° + dSo° + R(In(c/4))

Notes: * dSo°is the entropy associated with helix initiation (-10.8 cal/mol per °K).
* Ris the Universal Gas Constant (1.987 cal/mol per °K).
¢ cis the concentration of the probe, in molar units.
* The factor —273.15 corrects for absolute temperature so that the final Tm is in °C.

The pairwise dH° and dS° values for DNA used in Vector NTI® Express are taken from
reference 2. Those values, along with the corresponding dG° values at 25°C, appear in

the following table:
Interaction | dH® kcal/mol | dS° cal/mol per °K dG® kcal/mol
AA/TT -9.1 -24.0 -1.9
AT/TA -8.6 -23.9 15
TA/AT -6.0 -16.9 -1.0
CA/GT -5.8 -12.9 2.0
GT/CA -6.5 -17.3 -1.3
CT/GA -7.8 -20.8 1.6
GA/CT 5.6 -135 -1.6

Table 1 DNA Nearest Neighbor thermodynamics
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Example

Thermodynamic Tm Calculation E

CG/GC -11.9 -27.8 -3.6
GC/CG -11.1 -26.7 -3.1
GG/CC -11.0 -26.6 -3.1
XX/XX -6.0 -16.9 -1.0

Table 1 DNA Nearest Neighbor thermodynamics /continued)

Notes: ¢ All values refer to the disruption of a duplex at 1 M NaCl, 25°C and pH 7.

e The units for dH° and dG° are kcal/mol of interaction, whereas those for dS° are
cal/°K per mol of interaction.

The oligo 5-GTGCGAGGCAGCTGCGGTAA-3' is parsed as follows:

dH™: &5 52 111 113 56 TE 110 14 5F T8 114 TE 58 I 118 110 &5 &0 84
ppppppp

dS*: 173 128 20T TR 135 08 288 26T 129 208 287 208 128 T TE 24 T3 165 M0
dGh 13 2o 3 34 14 16 31 31 20 16 30 16 24 30 3 X 13 18 13

e Total dH® =-164.7 kcal/mol

* The total dS° reported by Vector NTI® Express is the sum of the pairwise values
above and the entropy associated with helix initiation (dSo®). Thus, for the
example oligo above:

e Total dS°=-405.7 + (-10.8) = -416.5 cal/mol per °K

The total dG° is the sum of the pairwise dG° values for the oligo plus a helix initiation
free energy term (dGo°) that is added to better reflect experimentally determined free
energy values for tested oligos. The value of the helix initiation free energy term (dGo®)
depends on the base composition of the oligo2 as follows:

¢ +5.0 kcal/mol for oligos containing any G-C base pairs
* +6.0 kcal/mol for oligos composed exclusively of A-T base pairs

Therefore, for the example oligo:

Total dGo =-43.7 kcal/mol (sum of the pairwise dGo values) + 5 kcal/mol (free energy
term) = -38.7 kcal/mol

The 3" End dG° is calculated using the number of 3’ pairwise dG° values specified in
the 3" End Length (bp) box, and is not further adjusted.

Using Vector NTI® Express’s default probe and salt concentrations (250 pM and 50 mM,
respectively) and the values for dH® and dS° calculated above, Therm. Tm can be
calculated as follows:

ThermTm = dH® —273.15 + 16.6(Log(Na))
dSe +dSq° + R(ln@)
_164.7

.= —— - 27315+ 16.6(L0g(0.05))
250 x 10~

~0.4165 + (0.001987)0”((T)D
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Oligos Containing IUB Ambiguity Characters

_ ~164.7
"7 20.4165 + (0.001987)(-23.49)

—273.15 + 16.6(-1.301)

_ ~164.7
"7 (~0.4165) - 0.04667

+(~273.15) - 21.60

C= 21647 59475

—-4632

. = 355.57 -294.75

... = 60.82°C

Vector NTI® Express adjusts the %GC and Therm. Tm values accordingly, based on the
input formamide concentration.

Oligos Containing IUB Ambiguity Characters

RNA Oligos

176

Vector NTI® Express can analyze oligos that contain IUB nucleotide ambiguity
characters (i.e. R, Y, W, S, M, K, B, D, H, V and N). In the case of ambiguity characters,
Vector NTI® Express uses average pairwise dH® and dS° values for calculating the Tm.

For example, for the dinucleotide pair CB, Vector NTI® Express averages the CC, CG
and CT thermodynamic parameters (Table <Blue><Emphasis> 1) to obtain average
pairwise dH® and dS° values for CB. It then sums the average pairwise
thermodynamic parameters and calculates the Therm. Tm values according to the
equation described above (refer Thermodynamic Tm Calculation on page 174).

In the case of %GC Tm, Vector NTI® Express applies the appropriate %GC contribution
represented by each ambiguity symbol to the standard %GC Tm formula (see “%GC
Tm Calculation” on page 173). For example, a B ambiguity symbol contributes only
two-thirds the amount of a G or C residue to overall GC content.

RNA oligos use a different set of pairwise thermodynamic values than DNA oligos.
Pairwise thermodynamic values for RNA are summarized in the following table:

Interaction dH° kcal/mol dS® cal/mol/K dG° kcal/mol

AA/UU -6.6 -18.4 -11

Table 2 RNA Nearest Neighbor thermodynamics
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Primer/Probe Tm Values E

AU/UA -5.7 -15.5 -1.1
UA/AU -8.1 -22.6 -1.4
CA/GU -10.5 -27.8 -2.2
GU/CA -10.2 -26.2 -2.4
CU/GA -7.6 -19.2 -1.9
GA/CU -13.3 -35.5 -2.7
CG/GC -8.0 -19.4 -2.2
GC/CG -14.2 -34.9 -3.8
GG/CC -12.2 -29.7 -3.3
XX/XX -6.0 -16.9 -1.0

Table 2 RNA Nearest Neighbor thermodynamics /continued)

Notes: o All values refer to the disruption of a duplex at 1 M NaCl, 25°C, and pH 7.

e The units for dH° and dG° are kcal/mol of interaction, whereas those for dS° are
cal/°K per mol of interaction.

¢ The dS° value for RNA oligos is adjusted by —10.8 cal/°K per mol to reflect the
entropy associated with helix initiation, as it is for DNA oligos.

* The dG° value is adjusted by +3.4 kcal/mol to account for helix initiation. Note
that this adjustment is NOT dependent on the base composition of the RNA oligo
as it is for DNA oligos (refer Thermodynamic Tm Calculation on page 174).

Primer/Probe Tm, For oligos designed using Vector NTI® Express’s PCR Primers, Sequencing Primers and
Ta Opt and Similarity Hybridization Probes features, the oligo Tm, product Tag, and oligo percent binding

Calculations similarity are reported in the Text Pane of the Molecule Viewing window.

Primer/Probe Tm Values

Tms for designed primers/probes are reported is as follows in Vector NTI® Express:

* Therm. Tm is reported if the oligo is less than or equal to 35 residues
* %GC Tm is reported if the oligo is 36 residues or greater

For PCR products, Vector NTI® Express reports the %GC; the assumption being that
the majority of PCR products are larger than 35 residues.

Tagp; Values

The PCR product Tagy, (optimal annealing temperature for amplification of the
fragment) in °C is calculated using the following formula3:

TaOpt = ((0'3)Tmprimer + (0~7)Tmproduct -14.9) °C

Notes: * Tmyyimer is the Tm of the less stable primer of the pair
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Primer/Probe Similarity Values

* Tmyroduct is the Tm of the PCR product

Primer/Probe Similarity Values

References
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When designing PCR, sequencing or hybridization primers, Vector NTI® Express
reports the overall similarity in percent of an oligo to its binding site based on the
oligo’s nucleotide composition. For oligos containing IUB ambiguity symbols, three
similarity values are reported:

* Minimum Similarity
¢ Maximum Similarity

* Average Similarity

For Minimum Similarity, all ambiguities are classed as complete mismatches (i.e., they
are assigned values of 0 at each position). For example, a 20mer containing 2 Rs and 2
Ns has a Minimum Similarity of 80%.

For Maximum similarity, all ambiguities are considered identical to their cognate
nucleotides (i.e. they are assigned values of 1 at each position), so the Maximum
Similarity is always 100%.

For Average similarity, Vector NTI® Express weights each ambiguous nucleotide
depending on whether it represents 2, 3, or 4 possible nucleotides. For example, Ns
have a score of 0.25, Rs of 0.5, Bs of 0.33, etc. Therefore, for the 20mer described above,
the Average Similarity is 85%.
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